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IN SEPTEMBER 2005, a news item appeared on the
Net about a study conducted by Dr Bryan Rauden-
bush of the Wheeling Jesuit University in the US,
indicating that video games can be used effectively
to distract from pain, if not actually relieve it. Rau-
denbush’s study, called Effects of Video Game Play on
Pain Threshold and Tolerance, examined the psycho-
logical effect of games on pain sufferers. Six genres
of games—action, puzzle, arcade, fighting, sport, and
boxing—were used in the study, where participants
played games of each type for five minutes for prac-
tice, then a longer session for 10 minutes. Rauden-
bush concluded that playing games increased
players’ pulses, as well as their tolerance for pain.

Some of us might have read that news bit and rub-
bished it as yet another piece of quirky research—by,
possibly, a gaming evangelist—or even as an industry-
sponsored study determined to project the positive
effects of gaming. So much has been written about the
ill-effects—the negative psychological and physiolog-
ical impact of games — on kids, that we look with sus-
picion upon any positive news on this front.

But it turns out that a piece of news from Reuters
corroborates Dr Raudenbush’s study. It highlights the
use of video games to help sick children manage pain
and anxiety during hospital stays. Nine-year-old Ethan
Myers was declared brain dead as a result of a car acci-
dent in 2002. Doctors had said at the time that Ethan
would never again eat on his own, walk or talk.

Now, due to neuro-feedback training on the Cyber-
Learning Technology LLC system, often used to play car
racing video games, Myers has caught up with his peers
in school, and can even read out a speech to a large
group of students. He has also re-learnt to walk, and his
memory now allows him to remember peoples’ names.
More importantly, Myers can now also fully open his
right hand, which paralysis had curled closed. “In the
last year, we’ve seen the Ethan we knew before the acci-
dent,” says Howard Myers, the teenager’s happy father.

CyberLearning’s SMART BrainGames system,
which was used by Myers, targets symptoms arising
from brain injuries, attention-deficit hyperactivity
disorder (ADHD) and learning disabilities.

Neuro-feedback treatment has been around for
decades, but its use of video games is a new develop-
ment that tries to capitalise on the younger genera-
tion’s fascination with animation and electronics to
sweeten often frightening, lengthy and tedious med-
ical treatments. Some schools in the US are even using

video games to combat obesity and have made it part
of their curriculum.

All this research, I’m sure, has brought cheer to
gaming enthusiasts—and also the gaming industry.
Young gamers will now cite this research to their par-
ents and justify their never-ending gaming sessions and
the endless hours spent in front of the computer or
gaming consoles. Sceptics, however, still question the
efficacy and cost rationale behind this treatment.
Despite the demonstrated benefits of neuro-feedback,
paediatrics demand better-designed studies to help par-
ents of children with ADHD make informed decisions.

It all does seem intuitive, though. Laughter is the
best medicine because it’s a stress buster—it’s a momen-
tary burst of release, so to speak. The gaming experi-
ence is similar: it’s a brief period of escapism, of total
release from the shackles of the world; it’s “re-creation”
in the true sense. And that is, naturally, good for you.

editor@thinkdigit.com

Gaming Can Heal

Editorial

“A study highlights the use of video
games to help sick children manage

pain and anxiety during hospital stays”
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16
Turns out
everyone’s
favourite Khan
likes tech toys! 

17
Looks as
though soon,
nothing tech
will be secure—
it’s been
proved that
RFID tags can
get infected by
viruses

24
Google has
released their
much-awaited
OS! A brief look

Digital Passion

Contents Magazine

51 Fandom Of The Opera
Many of you have heard the following: “Opera is
the best browser out there.” Is that true? If so,
why and how? We get into how using Opera can
significantly enhance your browsing experience

74 New & Notable
Apart from a great ’n’ cheap MP3 player, the Video
iPod, and an MFD, this month’s New & Notable
sees an in-depth look at the O2 Xda Atom—one of
the most desirable PDA-phones out there—and at
Discreet Combustion 4, which, as we say, “can do
for video what Photoshop can do for images.”

71 Know More About
Did you know you can view a Web page
offline using Adobe Acrobat? Or that you
could create a radio button within a
document to link to another? Here’s about
some lesser-known pearls Acrobat offers

56 Flat Out!
Many of you are probably contemplating
(finally!) making the switch to LCD. There’s a
reasonably wide variety of models to choose

from, and price is always an
important factor.

Hence this
comparison test

Digital Tools

34 Tech Transcends Tongues
Machine Translation is more far from
perfect than you would imagine! Fun
with online translators apart, here’s a
look at why Machine Translation is hard,
and what the most promising approach
for the future is

40 …And You Call Yourself a Gamer? 
You’re looking to buy a console. You’re
hunting for must-have games for your PC.
Whatever it is, here’s a compilation of the
best games ever. IOHO, of course

29 Renovating The Office
Sure you’ve already guessed Office 12 (or
Office 2007) is going to be much prettier and
user-friendly and all. But here, we take an in-
depth look to discover whether and why you
should upgrade—when it’s out

...and
you call yourself

a 

134     135  136                                  
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Digital Leisure
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99 A Step in Time... 
Overclocking and recompiling kernels is tech for
tech’s sake. Here’s a look at one shopowner who’s
actually used tech to the max, with the highest
productivity returns per paisa spent—from a basic
calculator to full-fledged databases on Pentium 4s

102 Life In A USB Nutshell
We realised you don’t really need to wait for the
advent of widespread on-demand computing: you
already can carry everything you need—your data as
well as your programs—on a USB stick, and compute
the way you want, where you want! Here’s a guide on
how to go about setting up your “USB rig,” as it were

120 Life @ 24 FPS 
A career in animation is a much-hyped thing. Is it
for you? What is it actually like? Is it about
software expertise? We paint a realistic picture of
the scene in India

130 Game On
Win money with TrackMania Nations, blow
friends up in Crashday and cower in fear with
Call of Cthulhu: Dark Corners of the Earth

152 Tabloid tech
The iPod has found its way to the
Vatican. And you can now talk to
Penelope Cruz—and other celebrities—via
Skype, if a certain eBay auctioneer is
telling the truth

106 The Brightest Bulbs In Town
An LCD or DLP projector? And what make and
model? A projector is a serious investment,
and it’s important you make the right
purchase decision. Here’s a comparison test
that’s sure to help you

Digital Business

Three Incredibly Useful Sites ..........18
The Digital World ............................18
Beat That ........................................20
Gender Benders ..............................22
Buzzword Of The Month ..................22

Tips & Tricks ....................................81
Q&A ................................................90
Trend ..............................................118
Tech Quiz........................................128
Mediawise ......................................136

Whatever Happened To ..................138
Bluff Your Way Through ................140
Digit Diary ....................................140
Blogwatch ......................................141
Inbox..............................................150R

EG
U

LA
R

S 

123 Bridging The Gap
A kiosk-based information system for
villagers in Andhra Pradesh has seen
tremendous response

Escape

139
Did Konrad Zuse
“invent the
computer”?
Apparently

138
It’s probably
etched in your
mind that Macs
are safe, unlike
Wintels. Here’s
news that could
entirely dispute
that supposition

126 Is Piracy Good? 
No, we’re not telling you that cracking
WinZip is good! We’re taking a broad
view of the piracy phenomenon, and
who benefits from it

137
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Crashday Demo

Crashday puts you in the world of stunts,
dents and adrenaline: whether you prefer
to smash your vehicle into pieces with
breath-taking stunts or better still
compete with your enemies in highspeed
races on custom tracks

TrackMania Nations ESWC
Full Version

This special version features a brand
new environment, the Stadium, and a
revolutionary new gameplay designed
for Nadéo's own custom cars

GAME
Knights of the Temple II

LINUX
n Byzantine OS
n Gentoo 2006.0
n Puppy Linux 1.0.8r1
n Epiphany
n Evolution
n Galeon 2.0.1
n GNOME Baker
n XFCE4
n Ubuntu 5.10

MAC
n Audacity X 1.3.0b
n Christmas Super Frog 1.7
n JAlbum 6.2
n LimeWire 4.10.5
n LiveQuartz Image Editor 1.5
n Opera Browser 8.51
n Poisoned 0.519
n Transmit 3.2.1
n VLC Media Player 0.8.4a
n Data Rescue II 1.0.1
n Readerware 2.97

DEV TOOLS
n Aurora XAML Designer for WinFX 8.3

beta
n JDDM (Drop Down Menu) 2.1
n NetBeans IDE 5
n Navicat 7.1.12
n NetBeans IDE 5.0 + Application Server
n 8.2 Bundle Installer

DIGITAL PASSION DIGITAL TOOLS DIGITAL BUSINESS DIGITAL LEISURE

Adobe Audition 2.0

Record, mix, edit, and master digital
audio files with powerful tools that
bring flexibility and control to your
desktop studio. Easily create music,
produce radio spots, and restore
imperfect recordings

Corel DRAW Graphics Suite X3
With this comprehensive
graphics suite, you can
confidently tackle a wide
variety of projects - from
logo creation and Web
graphics, to multi-page
marketing brochures, or
eye-catching signs

Macromedia Fireworks 8
Fireworks 8 lets you
balance maximum
image quality with
minimum compression
size as you create, edit
and optimize images
for the web with
precise control

MULTIMEDIA
n ACID Music Studio 6.0
n Audio Cleaning Lab 10 
n Movie Edit Pro 10
n ULead DVD Movie
Factory

INTERNET

n AceFTP 3.72
n BitComet Acceleration Patch 3.5
n DSL Web Hosting 2.5
n Fastream NETFile FTP/Web Server 8.1.5
n ICQ 5.04
n MSN Messenger 7.5
n SmartFTP Client 2.0.995.10
n Yahoo! Messenger with Voice 7.5 (Beta)

PC-cillin Internet Security
2006
Trend Micro PC-cillin
Internet Security 2006
combines award-winning
antivirus security and a
personal firewall—for
comprehensive protection
against viruses, worms, Trojans,
and hackers

SYSTEM
n NVIDIA Forceware Drivers v81.98

(WinXP) (February 2006 release)
n ObjectDock 1.2
n Style XP 3.16
n Download Acronis Disk Director Suite

10.0
n Virtual CD 7.1
n WindowBlinds 5

ABBYY FineReader
Professional Edition 8

Ideal optical character recognition (OCR)
application for users who demand the
highest level of recognition accuracy and
format retention. FineReader allows you
to convert and edit a variety of paper
and electronic files, including magazines,
newspapers, faxes, and PDF files

PRODUCTIVITY TOOLS 
n Adobe Acrobat 3D

n 3i Asset Information Management 1
n ResiGo 4.1.2250
n Adobe Acrobat 7.0

Professional
n BillQuick Lite 6.0.124
n MDaemon 8.1.4
n Microsoft OneNote 2003

PORTABLE SOFTWARE
n Portable Firefox 1.5

n Crazy Browser
n Essential PIM 1.7
n Miranda v 0.4.0.3
n MPUI
n Portable AbiWord 2.4.2
n Portable Thunderbird 1.7 Beta

n PStart
n Portable OpenOffice.org 2.0.1

MOBILE APPS
n Calc98 (Windows CE) 5.3
n Nokia PC Suite Version 6.7 release 22
n Photogather for Palm 7.0.3
n Handy Tools

2005 for Sony
Ericsson 1

n MAGIX
Ringtone Maker

n PocketPC Sport
Games Pack 1.1

n Mobiledit Lite
1.99

SMALL GAMES

n Bejeweled 2 Deluxe

n Chuzzle Deluxe

n Iggle Pop
n Big Money
n Alchemy Deluxe

MOBILE GAMES

n PopCap Game Pack 1 - Palm, Pocket
PC and Windows Mobile

VIDEOS
n ATL

n Ice Age 2 - The Meltdown
n She's The Man

n Stay Alive

N
O

TE

A Test Build of the Digit Software Archive was accidentally included on the March CD in
Digital_Tools\Essentials. If you've installed it, please stop using it - the interface is far
from what it's intended to be, and the database included is an inaccurate collection of
junk we used when testing the archive. We apologise for this error. You will find the
newest version of the Digit Software Archive on this month's CD.

Digit Software Archive: If you’ve installed the Digit Software Archive 2006 Beta from our February 2006 CD, you can download
its update by clicking the Update button in the Digit Software Archive from the 1st of April.
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NetBeans Mobility Pack
The NetBeans Mobility
Pack can be used to
write, test, and debug
applications for the Java
Micro Edition platform
(Java ME platform)
technology-enabled
mobile devices

VistaDB Suite 2.1.4.4
VistaDB is a 500KB footprint embedded
SQL database for building robust, small

to midsize database applications under
.NET, .NET Compact Framework and
Win32. VistaDB is the #1 alternative to
Jet/Access, MSDE, and SQL Express 2005

DEVELOPER TOOLS
n Absolute Color Picker 3.0.2
n ActiveX Control Pad 1.0
n AIOCP (All In One Control Panel) 1.3.001
n Basic4ppc Desktop 2.05
n Blasm IDE 1.08.09 build 0032
n Blockstar Website Builder 2.3
n JXHTMLedit 4.0.005
n Klorofil Platform 0.2
n RSS Wizard 2.4
n Splash Screen Component 1
n SQL Packager 1.4
n Windows AMD64 Platform - J2SE(TM)
n Development Kit 5.0 Update 6

LINUX
Damn Small Linux

DSL has a nearly complete desktop, and
many command line tools. All
applications are chosen with the best
balance of functionality, size and speed.
Damn Small also has the ability to act
as an SSH/FTP/HTTPD server right off
of a live CD

Kplayer
KPlayer is a KDE media player based on
MPlayer. With KPlayer you can easily play
a wide variety of video and audio files
and streams using a rich and friendly
interface that follows KDE standards

n AmaroK
n Drupal 4.6.x
n Flubox
n GNOME Sensors Applet
n Icewm
n Kbear (Graphical FTP cliet)
n Kconfigure
n Kplayer
n MailScanner 4.51.4
n Musicman (music manager for KDE)
n Opera 8.52

DIGITAL PASSION DIGITAL TOOLS DIGITAL BUSINESS DIGITAL LEISURE

Contents Interactive

3B Browser 2.1.1

A wonderful new way for broadband
users to experience the Web, 3B is a
free, downloadable browser that
renders the Web as a 3D city of display
windows, each showing a different site

Macromedia Shockwave
Player 10.1.0.11
Flash lets designers and
developers integrate
video, text, audio, and
graphics into effective
experiences that deliver superior
results for interactive marketing and
presentations, e-learning, and rich
Internet applications

MULTIMEDIA
n AdvancedDVDPlayer 1.34
n AV MP3 Player-Morpher Basic 2.0.112
n Unreal Media Server 4
n QuickTime Alternative 1.68
n Zortam Mp3 Media Studio 5.95
n DivX Create 6.1

INTERNET

n Ares Galaxy 2
n BitMeter 3.5
n Crazaa 0.16
n CrazyTalk For Skype Video Lite 2
n Draze Toolbar with Anti Spyware 4.6
n DVD Cover Searcher Pro 3
n Limewire Pro 4.10.5
n Serence KlipFolio 3 beta C
n Turbo Internet Booster 1.1

SYSTEM
n DigiCat 1.03h
n ExamDiff 1.6n
n Intel Graphics Media Accelerator

Driver 14.4
n Partition Logic 0.61
n Realtek AC97 audio driver package

a3.84
n SendTo Commander 1.2
n SysJewel - 2.1
n TaskPatrol Personal 2
n TightVNC 1.2.9
n TweakNow RegCleaner 2.6.7
n SafeIT Desktop Security Suite 2006
n ZipRecovery 1.5

ESSENTIALS 
n .NET Framework 1.1
n Avast Home Edition 4.6
n Digit Software Archive
2006 Beta
n Irfan View 3.98
n Kazaa Lite Mega Codec Pack 1.40
n ZoneAlarm 6.1.737
n Opera 8.53
n Spybot Search & Destroy 1.4
n Winamp 5.2
n WinRAR 3.51
n Adobe Reader 7.0.7
n VLC Media Player 0.8.4

Trend Micro OfficeScan 7.3
Trend Micro OfficeScan is
normally used to protect
business computers from
viruses and spyware but
TRV Security offers its
unique TRVProtect managed service to
home and business customers

nPOP
nPOP is a small and fast
POP3 email client. When you
first connect using nPOP, only
the headers are downloaded.
From the header list, you can
select the emails you want to download
for viewing

Portable NVU
Nvu is a web authoring
system (like FrontPage or
DreamWeaver) that features
WYSIWYG editing of web pages,
integrated file management via FTP
and tabbed editing that makes working
on multiple pages a snap

PRODUCTIVITY TOOLS 
n AceMoney Lite 3.8.3
n ChoiceMail Free 3.1
n GeSWall 2.1.4
n In/Out Board Agent 2.0.2248
n Remote Queue Manager Personal 3.12
n 602PC Suite 4.2
n Trend Micro OfficeScan 7.3
n WinOrganizer 3.0

PORTABLE SOFTWARE
n μTorrent
n ClamWin Free
n Foxit PDF Reader
n GreatNews
n i.Ftp
n i.Scribe
n MyZippa
n nPOP
n Portable NVU

MOBILE APPS

n Microsoft ActiveSync 4.1
n Mobile PhotoPleasure 1.7
n ACDSee Mobile for Palm OS 1.2      
n Mobile Tangrams 1.0
n MiM Lite B (Eng) 1

SMALL GAMES
Gianas Return
Giana's Return is based on a game called
"The Great Giana Sisters. Try to solve
each level in time, collect diamonds to
get an extralife and try to gain extra
items such as the Stonecrusher, the
lightning or the pineapple

Putt Nutz DX Demo

Putt Nutz is a fast paced, over-the-top
3D Miniature Golf game for 1 to 4
players

Race Cars The Extreme Rally

Drive the super fast race cars and see if
you could have been or perhaps still
can become the world's best racer. This
fabulous 3D game will put you to a test
of speed and skill

VIDEOS

n Find Me Guilty
n Take The Lead
n Slither

CD

DIGIT APRIL 2006For any queries regarding the CD or DVD, e-mail help@jasubhai.com with “CD/DVD” as the subject.
If the subject is not mentioned, your mail might not reach the right person.
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You get to choose what goes in Digit
Interactive. This month, you chose:

Autodesk 3ds Max 8
ULead DVD Movie Factory

Online

Digit Patrons
It really does

pay to be loyal!

Find out more

on www.
thinkdigit.com

Digit Reader Poll

This Month’s Question

What do you most look
for in a cell phone?

Camera
Music Playback
Screen Size
Form Factor
Music Plyaback
PDA Capability
Battery Life

Log on to www.thinkdigit.com
and vote!

April 2006

There’s something for everyone on the Digit Forum www.thinkdigit.com/forum

Last Month’s Question:

What career would you like to pursue?

Total votes 5,869

taste technology at www.thinkdigit.com

Due to technical errors the February poll results published in March 2006 issue were illegible. Here are the results:
QQ.. Where do you primarly get your news from? Television 44% Newspapers 44% I don't follow the news 4% Visiting Websites 5%

Feeds and e-mail newsletters 3% Total votes 3,483

infographic Chaitanya Surpur

29.9%
49.1%

9.6%
6.7%

4.7%

Hardware
Software

2D/3D Animation
Graphic Designing
None of the above
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Shahrukh Khan
Actor

Self-confessed geek, The
Khan hardly needs

introduction. 

How much do you surf?
I’m not a “casual surfer”—I

don’t surf for the sake
of surfing. At the

point where it just
started out, when
we had telephone
lines and the

strange sounds—
that was the time I

was excited about
surfing. Now I just use it for
research.

What are your favourite
gadgets?
I always roam around with a
couple of laptops, and I always
have a digital camera—stuff
which I normally use. The
whole idea of gadgets, I think,
has been demystified by the
laptop—you just need to have
one and everything is at your
beck and call. 

Do you tinker with video
editing?
I do edit my home videos, but
very, very slowly. I won’t get a
job as an editor, but I do know
my way around Final Cut Pro
and use it quite often.

Do you think it’s time for
movies to be shot in the
Digital Video (DV) format?
No, I really don’t. I think we still
need the grainy quality that
film cameras give us. I’m not
questioning movies like The
Phantom Menace—I think it’s
outstanding—but as a film
viewer, I wouldn’t want to
watch something that’s so…
bland. 

Gaming? 
I play games with my kids,
hardly on my own. We have a
PS2 and an Xbox, and we are
waiting for the PS3 to release.

Gates Mocks $100 Laptop
Bill Gates has mocked Nicholas Negroponte’s $100 Linux-based,
wind-up powered laptop: “Geez, get a decent computer where
you can actually read the text, and you’re not sitting there
cranking the thing while you’re trying to type.” Gates says cell
phones are what will popularise computing in developing nations.

Wire-Free And Free
Skype is going wireless! Netgear plans to soon introduce a
Wi-Fi phone that can handle Skype calls from any wireless
hotspot. Developers for Skype are also working on new
versions of their software that can work on the OSes of
regular cell phones.

Chipmaker Intel will
soon pitch a very low-
cost PC at the

developing world. The
proposed machine will be
priced at “meaningfully
lower” than $300, and an
announcement should
follow in some weeks,
according to William Siu,
Vice President and General
Manager of the Channel
Platforms Group at Intel.

In an interview with
CRN (Channel REseller
News), Siu said the
proposed system would
provide full PC
functionality to “take
advantage of all the
software and content” on
the Internet. Past attempts
to develop a $100 PC
have “missed the
point,”
according to
Siu: he said
they’re too
limited and
that they can’t
be loaded with
extra software.
Siu claimed
they’re more like
PDAs than PCs.

Remember
AMD’s PIC—the
Personal Internet
Communicator? It
was launched
back in 2004,
and the specs
went AMD
Geode GX500
CPU, 128 MB
of memory, a
10 GB hard
disk and an
inbuilt
modem—
running

Windows CE. The idea was
to bring Internet access to
much of the third world.
There are suppliers in
several countries for the
PIC, but the PIC hasn’t been
too much in the news after
its launch.

Better known than the
PIC is, of course, Nicholas
Negroponte’s $100 laptop.
The One Laptop Per Child
(OLPC) organisation hopes
to have it out late this year
or early next year. It has had
more than its fair share of
criticism, and we’ll have to
wait to see if the project
does deliver even a laptop
per 10 children.

Then, of course, we have
our home-grown Simputer,

which has been

around for a long while
now—too long, actually: it’s
always waiting to take off.
Other flopped attempts
have been made in the past,
as well, to bring “low-cost
computing to the masses,”—
the much-bandied phrase.
But will Intel go where no
company has gone before?

“The purpose of owning
a PC is to be able to access
content and to utilise the
software available out
there,” said Siu. “So giving
me a product that is under-
served does not address the
reason why you want to
even own the product…
what I’ve described is a full-
function PC that can take
advantage of all the

software and
content.”

In the
rural Indian
context,
$100 (Rs

4,500) and,
say, $250 (Rs

11,000) are
significantly far

apart. We’re not
talking about a

direct
competition
between the $100
PC and Intel’s
proposed offering,
but it comes to
content, what
our villages
need is basic
connectivity,
not streaming

multimedia.
And when it

comes to
software, are

people who haven’t ever
seen a computer likely to

Enter
HOPPING ON THE BANDWAGON

Intel To Debut Ultra-Cheap PC

Illustrations Harsho Mohan Chattoraj



want much beyond what is
available on OLPC’s laptop,
which includes a browser, e-
mail client, word processor,
IM, image viewer, media
player, a programming tool,
…? Also, the fact that the
$100 laptop is hand-cranked
cannot be dismissed.

Intel must have a good
reason for getting into this
market; how do they see the
situation? What will
dominate—the need for
more software and content,
or the price point? And
most importantly, of all the
offerings on hand, will any
succeed in empowering the
last billion?

POTENTIAL FOR HAVOC

RFID Tags
Virus-Prone!

Agroup of Dutch
researchers has

discovered—and warned—
that RFID tags can indeed
be infected with viruses. A
group under the guidance
of Andrew Tanenbaum at
the Amsterdam Free
University made the world’s
first RFID malware publicly
available for analysis. In a
proof-of-concept paper
presented at the IEEE
Conference on Pervasive
Computing and
Communications on 15
March, the researchers
warned that infected
microchips could corrupt
RFID databases and cause
“major chaos” at airports
and supermarkets.

It was widely presumed
that RFID tags could not

become infected with a
virus, because they only
have a limited memory
capacity. The group of
researchers discovered that
if certain vulnerabilities
exist in RFID software, a tag
can be purposefully
infected with a virus by a
prankster or criminal,
which could infect the
backend database used by
the RFID software. From
there, it can easily spread to
other RFID tags.

In one scenario outlined
by the researchers in the
paper, the RFID-augmented
labels used to expedite
baggage handling can be
targeted by a malicious
person to cause chaos in
busy airports. 

“Consider a malicious
traveller who attaches a
tiny RFID tag, pre-initialised
with a virus, to a random
person’s suitcase before he
checks it in. When the
baggage-handling system’s
RFID reader scans the
suitcase at a Y-junction in
the conveyor-belt system to
determine where to route
it, the tag responds with
the RFID virus, which could
infect the airport’s baggage
database,” the researchers
explained.

“Then, all RFID tags
produced as new passengers
check in later in the day
may also be infected. If any
of these infected bags
transit a hub, they will be
rescanned there, thus
infecting a different
airport.”

And thus, within a day,
hundreds of airport
databases all over the world
could be infected! An RFID

virus could also carry a
payload that damages the
database and, for example,
helps drug smugglers or
terrorists hide their
baggage from airline and
government officials.

The findings mentioned
above are controversial
right now, and there might
not be reason to get
panicky. The trade
association for automatic
identification and mobility,
AIM Global, has attempted
to refute the key findings of
the Dutch researchers.

“Many of the basic
assumptions in the paper
overlook a number of
fundamental design
features necessary in
automatic data collection
systems and good database
design,” asserted Dan
Mullen, president of 
AIM Global.

Mullen suggested that

Shruti ParekhMadan Bangale

Centrino Duo 
Two cores are
better than one,
and the Centrino
Duo has, well, two
cores! The second

core results in a performance
increase of 30 per cent, and
the processor features very
efficient power-saving thanks
to the lower operating voltage

Centrino
Why would you
invest in
technology that
is three years old
and that has no deep sleep
state—as in Centrino Duo? The
old Centrino also consumes
more power for the same
workload compared to the
Duo edition CPUs

“Loads of jewellery”“A nice sports bike.” 
Tanvi Ambavi

“Three wishes?”

Raveena Uchil
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Security Watch

Flash And Shockwave
Vulnerabilities

The Problem
There is a security
vulnerability in older versions
of Adobe's (formerly
Macromedia's) Flash and
Shockwave players.

If you use Windows, you
are more or less sure to have
Flash on your system—
whether or not you recall
having installed it.

The program was
redistributed with XP Service
Packs 1 and 2, and with
Windows 98.

The problem affects Flash
Player versions 8.0.22.0 and
earlier. To see what version
you have installed, go to
www.macromedia.com/softw
are/flash/about/. 

Shockwave versions
10.1.0.11 and earlier also have
the problem. To check what
version you have, go to
www.macromedia.com/shock
wave/welcome/.

The Damages
This is a critical update. If you
have an older version
installed, and you click on
specially-crafted Flash or
Shockwave links, a malicious
attacker could hijack your
browser and even take
complete control over your
computer.

The Solution
Update Flash Player by visiting
http://www.macromedia.com/
go/getflashplayer8/. To
update your Shockwave
Player, visit www.
macromedia.com/shockwave/
download/.

“Definitely designer clothes” “Nothing short of the SonyEricsson w800i”
Asim Narsinh

“What would you exchange your computer for?”One Silly Question

17
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IM, Radio, Career Skills

wwwwww3355..mmeeeebboo..ccoomm
Meebo is where you should head for if
you don't have any popular messengers
installed on your system and still wish
to chat. Yahoo!, Hotmail, or AIM—this
site allows you to chat freely from
within your browser. You can chat even
if IM ports have been blocked!
Messages are transmitted from port 80,
which cannot be easily restricted.

wwwwww..mmiinnddttoooollss..ccoomm
“The Internet’s Most Visited Career Skills
Resource,” the site calls itself. Here, you
can learn the practical skills needed to
excel in your career. The site covers the
most common skills—from time and
stress management, information skills,
memory improvement, problem solving
and decision making to creativity and
more. All these sections are covered in-
depth, with practical examples.

wwwwww..lliivvee336655..ccoomm
If you’re a music buff with a broadband
connection, here’s a Web site you must
tune into! There are thousands of
Internet radio stations listed here with
different bitrates to suit your
connection. Tune into stations based on
genre, search for music, and listen to
Podcasts. Access costs $9.95 (Rs 440)
per month, but it could be worth it.

MindTools

LIVE365.COM

meebo 

the researchers built a
system with a weakness and
then proceeded to show
how the weakness could be
exploited. “(It’s not
surprising that) poor system
design, whether capturing
RFID tag information, bar
code information or
keyboard-entered data, will
create vulnerabilities,” 
he said.

We must stress that the
findings by the Dutch
researchers are under the
microscope. This may turn
out to be just another
research paper, and this
piece of news might just be
forgotten a few months
from now. But we’ll have to
wait and watch.

VERSUS MICROSOFT

Google Adds
Online Word
Processor

Apart from the fact that
Microsoft has revved up

its search engine, the latest
in the Google vs. Microsoft
saga is that the former has
added another tool to its

growing online-services
repertoire with the purchase
of Upstartle, a Silicon Valley
startup that makes an
application called Writely.

Writely is basically a
word processor embedded
into a Web browser. It’s
still in beta form. The
Writely application lets
users compose and edit
documents online.
Amongst the formats
supported by Writely are
Word, OpenOffice, HTML,
and plaintext. One can
view a document’s revision
history and roll back to
earlier iterations. In
addition to basic
document-creation
features, Writely gives
users the ability to
collaborate online—one can
grant access to a document
by adding people to the
document’s list of
contributors; one can also
publish to most of the
popular blogging sites.
Visit www.writely.com for
more details.

Writely beta was
launched in August 2005
and is “far from perfect,”
according to a blog posting
by Jen Mazzon, formerly of
Upstartle and now a

A Round-up Of Technology News From Across The GlobeThe Digital World

Three Incredibly Useful Sites

CHINA

US tech companies eyeing China face a
dilemma: while keen to tap a market that
could soon eclipse America's, they must
also worry about the perception that
they’re helping China harass dissidents:
US companies must satisfy a government
that fiercely polices Internet content

ISRAEL

National Internet Safety Day was
celebrated on March 9. The Day is
aimed at raising awareness about the
dangers of the Internet and how one
can avoid them. Thousands of parents
participated in the event, which
highlighted the dangers the Internet
posed to children

AUSTRALIA

Australian Internet users are crawling along
the Internet compared with other developed
nations. Per head of population, Australia's
broadband Internet speed was just over 1
Mbps. This compares to Britain (13 Mbps),
France (8.4 Mbps), Germany (6.85 Mbps)
Canada (6.8 Mbps) and the US (3.3 Mbps)

NIGERIA

Africa is turning into a
digital dump. Recycled
computers have the
potential to help bridge
the digital divide. African
countries are a robust
market for such
equipment. But experts
in Lagos say as much as
75 per cent are “junk,”
which is accumulated or
burnt in dump sites

JAPAN
Older customers have found the
Nintendo DS user-friendly. The
latest titles let players study
English, raise a virtual puppy, or
converse with animals in an
imaginary village

UNITED STATES

San Francisco hopes to have a city-
wide Wi-Fi system up and running
before September. Libraries, retail
stores and hotels throughout the
city provide Wi-Fi to patrons, but
cyber-cafés make up the majority
of the city's hotspots
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Photograph Deepak Ajwani

Last Month’s Winner!
Om Awasthy, Deeptinagar,
Bhagalpur, Bihar
“Gramophone XP”

E-mail your caption with the
subject ‘Beat That’, and your
postal address, to
beatthat@thinkdigit.com
and win 
Computer Security
by Ditter Gollmann
Published by

Each month, Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 15th of this month.

Digit Caption

“Microsoft download
centre?”

DIGIT APRIL 200620

spokeswoman for Google’s
Writely team.

As of now, Google plans
to offer individual access to
Writely for free, but the
company will probably roll
out extra features that
require a paid subscription.

Corporations will have to
pay a licensing fee to access
the service. 

“This is an interesting
addition to Google’s
collection of productivity
tools,” said Melissa Webster,
program director with the

Content
Technologies

research
group at
IDC, a
premier
global
provider of
market
intelligence.
“They already

offer e-mail,
calendar

options, and
photo services,
so it makes
sense for them
to add word
processing for
creating and
managing
Web content.”
The
drawback, of
course, is
that more

content has to
be stored on

Google’s servers.

Also, as Om Malik, well-
known blogger and the
analyst who first reported
on Google’s purchase of
Upstartle said, “Convincing
the masses that their
documents will be safe,
especially with all that has
been going on lately, may be
quite challenging, even if
it’s free.”

FLASH-BASED BOOTUPS

Intel
Confirms
“Robson”

Current hard disk access
times mean we often

have to sit staring at an
LED waiting for a game to
start up or for a system to
boot up. And when it
comes to notebooks,
spinning hard disks mean
power consumption. Both
these issues could be
resolved if, as Microsoft has
proposed, hard disks had
Flash memory inbuilt. But
that means increased disk
prices, of course. Intel’s
idea—of adding a Flash

memory cache to the
system itself—is
materialising.

The chipmaker is set to
launch an industry-wide
initiative to encourage the
use of NAND Flash in
computers in a bid to boost
boot times and enable
improved power savings.
There are several types of
Flash memory, but NAND
Flash forms the core of
removable USB drives.

Rumours of the Intel-
developed technology code-
named Robson have been in
the air for some time, but
Intel confirmed the
technology in mid-April.
Sean Maloney, Executive
Vice President and General
Manager of the Intel
Mobility Group, has
described Robson as a
“NAND Flash-based
platform accelerator.” 

Robson provides a
standard module ready to
slot onto a motherboard. The
OS startup data is loaded
onto the on-board Flash
chips to reduce boot times:
after the first boot, the only
time the system would start
up from the hard drive is
when the startup code or

We Came
across this
amusing 
pointer at the

recently held

CeBIT 2006 in

Hannover,
Germany
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procedure has changed. In
such a case, an updated copy
of the code would be written
to Flash for the next time.

In a separate
development, Intel is
putting in place the
Open NAND Flash
Interface (ONFI) initiative,
which will aim at
developing a standard
method of using and

implementing a Robson-
like system in PCs. ONFI is
supposed to take care of
most of the details,
allowing notebook
manufacturers to easily
implement the technique
in a cost-effective manner.

Windows Vista is
expected to support a very
similar approach to
chopping time off the 

boot-up process. And by 
the way, Intel happens to
be a player in the NAND
Flash market.

THE ULTRAMOBILE PC

Microsoft’s
Origami:
Still-Born?

Much hype surrounded
the word “Origami”

early March, and it was
shrouded in much mystery.
In fact, “origami” was the
most-searched-for term on
blog search engine
Technorati for a while in
March. Speculative
photographs of Microsoft’s
latest device sprouted on
several gadget sites. And
finally, it was revealed that
Origami is an ultramobile PC
(UMPC). Most of the details
are now in, and though it
was expected to retail at
between $600 (Rs 27,000) and
$1,000 (Rs 45,000), Samsung
is scheduled to ship the first
pieces in April, with a model
called the Q1. It will be
priced much higher than
initially reported, at $1,200
(Rs 54,000). This will be
followed by one from Asus in
June. Others will be released
in Asian markets later.

So what is a UMPC? It’s
something like a shrunken
Tablet PC, offering most of
the functionality of a full-
fledged PC on a small
package. Microsoft claims it
can be carried around
easily, but at 2 pounds and
7 inches, it’s too large for a
pocket: perhaps in the side
pocket of a backpack.

Specs-wise, the Origami
concept sounds OK:
Samsung’s Q1 will come

with a 900 MHz Celeron M
processor, 512 MB of RAM,
and a 40 GB hard drive. The
touch screen has a
resolution of 800 x 480. It
also has a CF card slot, two
USB ports, a single Ethernet
port and stereo speakers.
There’s also Bluetooth 2.0
and Wi-Fi b+g. The bells and
whistles you’re likely to see
on UMPCs include digital
TV-Tuners, Web cams, SD
card readers, fingerprint
readers and GPS capabilities.
All this in something in the
range of eight inches. And
for input, one can use the
touch-screen or the stylus, or
connect a keyboard via USB
or Bluetooth.

As for the OS, UMPCs
will feature new software
called the Windows Touch
Pack, which allows you to
customise the interface and
makes applications more
touch-screen-friendly. What
about Vista? According to a
Microsoft FAQ, “UMPCs that
meet the Vista hardware
requirements will be
compatible with the new
operating system.”

Essentially, the device
sounds like a cross between
a Pocket PC and a Tablet PC.
Battery life is only 2.5 to 3
hours. If the price is, say,
$800, folks are likely to find
it too high—because it’s not
as small as a PDA, and it’s
not big enough to be, for
example, a “proper” gaming
device. Who needs this
when you can have a PSP?
What kind of market would
it find? Perhaps as a
wireless Web surfing device.
Perhaps as a portable movie
player, like the Video iPod,
only larger. But why not a
laptop if laptop
functionality is what you
want? Well, there’s a ton of
opinions out there. For

GENDER 

BENDERS

After we’d explained the logic of Minesweeper to Vidya, she
was game for the challenge, all eager and everything. As we’d
expected, she began by clicking a box at random, and
proceeded to guess them from around that box. After landing
on a mine at every second click attempt (ouch!)—and realising
she’d been doing something wrong—she attempted a sweep.
Lady luck made up for Vidya’s initial loss of time, and apart
from the logic she’d seemed to have applied, a couple of
random clicks took her safely home.

Vidya  vs.  Ashwat 

Minesweeper: How fast can you
sweep 30 mines?

“Why not?” said Ashwat when we asked if he would play
Minesweeper while being timed against Vidya. We set a target
of 30 mines, and Ashwat started with a random sweep of
clicks. His first two clicks opened up only a couple of boxes, but
with his third click, his field was one-third cleared. He then
turned cautious, and we could see he was going about the task
logically! Ashwat reached a stalemate with 16 squares to go,
but a lucky random click proved a saviour. A blink later, he 
was through.  

Socket AM2 is an upcoming platform that supports
new 940-pin Athlons, the highlight being support

for DDR2 running at 667 MHz and 800 MHz. This
platform breaks the limitations that socket 754/939
had, and supports more than 4 GB DDR DIMMS. 

AM2 promises to increase working memory
frequency and bandwidth, which in turn will enhance
overall system performance. Though the socket AM2

platform supports 940 pins, it is incompatible with
older 940-pin Opterons. AMD is expected to launch two
dual-core CPUs for Socket AM2 on June 6, 2006: the
Athlon 64 X2 5000+ and Athlon 64 FX-62. AM2
technology with the supported processors is expected
to reduce power consumption and also heat
dissipation, which AMD has been aiming to achieve for
some time now.

2 min
36 sec

2 min

AM2
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example, if a corporate IT
buyer needs their workers
connected, a BlackBerry is
probably a better option.

BlackBerry, cell phone,
iPod, laptop, all rolled into
one—and then shrunk. Is
this a different kind of
MFD? Unfortunately, no. It
doesn’t do any of those
functions properly—it’s not
small enough, not large
enough, not specialised
enough. We’re hard pressed
to think of what kind of
individual would want 
a UMPC. 

“SPREADING CULTURE”

File-sharing
Embedded In
Swedish
Mindset

The Pirate Bay
(thepiratebay.org) is the

world’s best-known source
for (illegally) traded movies,
games, music, software,
TV broadcasts, and
anything else you
might care to add
to that list. A
BitTorrent client
is all one needs to
tap into the grid,
and much of the
world’s broadband
community is
doing it. As an aside,
we reported some
time ago in this
space that
Australians prefer
to get their dose
of American TV
shows on time
using BitTorrent,
instead of
waiting for
them to be
released
on TV.

Sweden is file-
sharing paradise, and the
country is spreading the
joy. According to an
analysis on Wired.com, “All
of us who run The Pirate
Bay are against the
copyright laws and want
them to change,” said
“Brokep,” a Pirate Bay
operator. “We see it as our

duty to spread culture and
media. Technology is just a
means to doing that.”
That’s so radical, we don’t
know if they really mean it,
but The Pirate Bay
repeatedly insists that that
is their agenda.

The site today claims 1
million unique visitors a
day. The Pirate Bay’s legal
adviser, law student Mikael
Viborg, said the site
receives 1,000 to 2,000
HTTP requests per second
on each of its four servers.

In Sweden, The Pirate
Bay is the flagship of a
national file-sharing
movement that is
generating an intense
national debate. The Bay’s
apparent immunity to
threats by content
providers and the MPAA is
attributed to the structure
of the BitTorrent protocol.
The site’s servers provide
only “torrent files,” which
by themselves contain no
copyright data, but only
pointers to sources of the

content. Naturally, then,
The Pirate Bay’s activities
are perfectly legal under
Swedish law. “Until the law
is changed so that it is
clear that the trackers are
illegal, or until the Swedish
Supreme Court rules that
current Swedish copyright

law actually outlaws
trackers, we’ll continue our
activities. Relentlessly,”
Viborg is reported to 
have proclaimed.

The legality of the
trackers is a topic of debate
in Sweden. Polls indicate
that more than 10 per cent
of the population shared
files in the last quarter 
of 2005.

The group that founded
the Bay—Piratbyrån—is
taking to grass-roots
activism and political
legitimacy. Piratbyrån today
has 57,000 registered
members committed to its
belief that file trading is a
means of sharing culture
and making new art.

Now here’s something
way out: the Pirate Party has
1,500 members, and has
gathered enough signatures
to participate in the
Swedish general election in
September. The government
estimates there are 1.2
million file sharers over the
age of 18 in Sweden, and the
Pirate Party needs only four

per cent to get seats in
the parliament. If
elected, the Pirate
Party promises to
strengthen
Swedish privacy
protections,
weaken copyright
laws, and 
roll back

government
surveillance

legislation.
Will Sweden

become a precedent
for other countries?
When will the file-
sharing-being-legal
debate be resolved?
Will the MPAA and
other such groups
formulate new

strategies in the war
against illegal file-

sharing? And what
about the current
generation—10 years from
now, will the broadband-
enabled world think of file-
sharing as essentially a good
thing? Or is all this limited
to Sweden with a population
of only 10 million? The
debates continue, and
probably will for a long,
long time. 
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GHOST
What is GHOST?
GHOST is the new OS from
Google. It has been released to
select Gmail users in the United
States by special invitation,
since the ‘Rest Of The World’ is
not important to Google. (Just
kidding. Google wants to take
over the world, even the part of
the world outside the United
States.)

When will GHOST be available?
It’s already available in the US.
As for when it will be available
in India, how are we supposed
to know? We suppose it depends
on when real “broadband”
comes to India. 

Why the silly name? 
You can pronounce it as either
“gee-host,” or just “ghost.” It’s
not a silly name, anyway: the
word “GHOST” is an acronym for
“Google Has an Operating
System, Ta-daa!”.

How does GHOST work? 
Like everything Google, GHOST
is very easy to use. It’s
something like grid computing.
All you need is a ridiculously fast
(by Indian standards)
broadband connection. All your
files, details of all your
interactions with the system,
and so on, will be stored on
Google’s servers. You just start a
GHOST session and compute
what you like, when you like.
Google even has plans to host
free pornography on its servers.

Where will GHOST be used? 
Dumb question. It will,
obviously, be used all over the
world, including in the
Democratic Republic of Congo,
which, for the geographically
challenged, is in South America.

Who is reading this?
If you’ve read thus far and
gotten excited, you’re obviously
the butt of many practical jokes!
Going by guesses on the Web, a
Google OS is not expected
anytime this year. It could be
next year, though. Stay tuned to
this space, and you might see
something interesting next year.
To ensure that you are the first
to know, we suggest that you
get yourself a Digit subscription.
Oh and by the way, “Nyaaah nya
nyaaaaaaah nyaaa nyaaaaaahh,
April Fool!”
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For one week every year,
this small town in

Germany becomes Mecca
for everyone who has any
reason to care about tech-

nology - business or
pleasure.

W e took a walk through
the twenty-seven ridicu-
lously massive halls to
bring you some of our
favourites from CeBIT

2006

Nostalgia And
RFID

D o you still look fondly at that
watch you got for your birthday

so many years ago? In their
Resonantware display, NEC show-
cased a few visionary technologies
for the future, including this neat
concept called SALA. The idea
revolves around the fact that the

many trinkets we own are associat-
ed with fond images from the past.
So what did NEC do? 

By embedding RFID tags in the
said trinkets, each of them will be
associated with its own set of
images and videos, and by placing
the object in a tray with an inbuilt
display device will now bring up
those memories. So if you were to
bring in the old watch we mentioned
you’d see pictures of the birthday

Crap-tastic Product Of The Year
Award

The Charming way of Communication", they called it. If
you can’t get enough for the good old phone

headsets (the kind you only see in phone booths these
days), and love your cell phone too, this one’s perfect for
you. 
Retrostar’s classic headset plugs into your cell phone’s
hands-free to give you the feeling that you’re back in
the 80s while still using twenty-first century technology.

You also get a version which plugs into your PC
for VoIP calls. 

Sensible people dismiss the
idea with a cruel laugh, but for
all its uselessness, we still
want one!

Enter The
Cell

Apart from the very cool product
name, IBM’s Cell promises to leave

current processors coughing dust in the
near future. They’ve crammed about
234 million transistors in the teeny
space of 221 square millimetres,
clocked it at 4 GHz, and taken it to a
peak performance of 256 Gigaflops.
Compare that to the AMD X2, which can
only manage 25 Gigaflops, and you’ll
understand what the fuss is about!

How does it do this? The Cell has -
hold your breath - nine processor cores!
One 64-bit PowerPC, helped along by
eight Synergistic Processing Elements
(SPEs), makes The Cell the ultimate
processor for intensive gaming and mul-

timedia applications.
Just to show off its capabilities, IBM

had it render a realistic human heart
that visitors could view with 3D glasses
and rotate it interactively. They could
even make cross-sections of the heart
as they pleased. All this ~without even
using a graphics card~!

Bet Apple’s feeling pretty silly for
ditching IBM now! Welcome back ~Big
Blue~, we’ve missed you!

Digit Special l CeBIT



Beyond The Ultimate

Think you’re sitting pretty with
that all-new SLI motherboard

and all of 4 GB of RAM? Your rig
is a mere calculator when pitted
against Tyan’s ultimate gaming
PC. Sadly, they don’t say much
about this, preferring to bill their
baby a "Server" - ugh.

The FT48 (for that is what it’s
called) can hold four dual-core
Opterons and has sixteen DIMM
slots, four 8x or two 16x PCIe slots and comes SLI ready. It guzzles power from
four power supplies that supply it with a respectable 1350W. With the 4 GB memo-
ry modules that you can obtain today, this machine can hold up to 64GB of RAM!

W onder what it would take to push this one to its limit - how do you test a
machine that can make Doom3 look like PacMan?

After countless sci-fi movies about
them, thought-controlled devices

are now more of a reality than ever.
The brains at the Fraunhofer Institute
for Computer Architecture and
Software Technology have come up
with the Brain Computer Interface -
the name is suggestive enough. The
device uses 128 scalp electrodes to
analyse brainwaves and translate
them into cursor movements on a
screen. In its current stage, it will still
take you about ten minutes to think
out a sentence,

but at least the promise is there. 
The researchers hope that this

device will eventually help the dis-
abled - even the completely paralysed
- communicate with the world around
them. And after this noble cause has
been accomplished, the device will
facilitate the descent of the lazy into a
self-induced paralysis.

Think it Type it

Return To The Lost
Art
C learly disappointed with this age of anarchy

and blasphemy where people don’t even
remember what their own
handwriting looks like,
NEC decided to bring
back this ancient art with
the Plume - a feather-
shaped quill that com-
bines the joys of hand-
writing with the security
of digital storage.

NEC says "We used
digital technology to
design this tool to enjoy
the beauty of writing and
to rediscover the impor-
tance and wonder of tak-
ing time for contempla-
tion."

After you have writ-
ten to your fill and
inserted the Plume into its main body, your information
magically appears on its transparent display and gets
stored in the digital format.

Snug And A Bug
James Bond wannabes will kindly assemble at the doors

of Interactive Wear AG for their "Know Where Jacket"
that can be tracked via GPS to any corner of the world -
even inside buildings! 

This surprisingly fashionable item of clothing comes
with a cell phone, MP3 Player, headphones, a microphone
and Bluetooth, and you can control everything from the
keypad on the sleeve. The shoulder contains a GPS anten-
na which broadcasts your location in real-time, and will
ensure that your boss always knows where you are.

Obviously not something you’ll want to take with you
on a stolen vacation.

Origami
The idea that folded and

Bill Gates’ vision of an ultra-mobile
device that costs less than $500

runs multimedia and games and
lasts a whole day on a single battery
charge is finally here!

Microsoft partnered with
Samsung to present the Q1 Ultra-
Mobile PC (UMPC) at CeBIT this
year. This very attractive device
runs Windows XP tablet edition on
a 7-inch LCD touchscreen and
does everything it’s supposed to -
music, video, you name it. There’s
also an on-screen keyboard,
designed to be used with your

thumbs.
There’s one slight catch - price

estimates for the Q1 place it at
1000 Euros (that’s about Rs
54,000, which pokes Bill’s vision in
the eye), and instead of a battery
that lasts the whole day, you’ll be
treated to this personal digital
extravaganza for a whole three
hours. It would still be forgivable if it
did cool stuff like prepare your
meals, but when it comes down to
it, there’s nothing in the Q1 that
today’s cheaper devices don’t
already have.
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NVIDIAs SLI
Notebook -

The next step
in mobile gam-

ing

W ith big, obvious buttons, this mobile
phone is perfect for the elderly

Is it a mouse? Is it an aquarium?

Finally! Hama Electronics launched
this much-anticipated virtual key-
board

The new Freedom Mini
Keyboard latches on to any
device

Samsung s humungous 82-inch LCD -
the largest in the world

NEC s Flask - the
Fuel-cell cell phone
(tongue-twisting, isn t
it?)

Cool Products that made
their debut at CeBIT 2006



29APRIL 2006 DIGIT

Digital Passion l Lead Feature

Fuelling the pursuit of technology knowledgeMust-have
Games

Nokia E61 

Passion
Digital

Tech Transcends
Tongues34 46

In Sight

Renovating The Office
Microsoft Office 12 Beta explored...

in a clean and intelligent manner. Here, we
take a look at what the solution entails and
whether it is a step in the right direction. Note
that this article is based on Beta software; as
such, things are likely to change.

Working In Tasks
Over the past few years, Microsoft has been
experimenting with task-based interfaces.
These are most visible under Windows XP’s
Explorer: browsing the My Pictures folder, for
example, will allow you to do Picture Tasks and
File and Folder Tasks. You can do tasks pertain-
ing to an image—such as printing, e-mailing, or
setting a photo as a desktop background. Such
an approach allows you to print a photograph
without the need to know which application

Ahmed Shaikh

How many of us have used Microsoft
Word beyond the most basic of its fea-
tures? Mail Merge, Citations,

Watermarks, Themes, Cross-references,
Hyperlinks, and Cover Pages—do you know
what your favourite Word processor can do?
The first version of Microsoft’s seminal Word
processor shipped with 100 features;
Microsoft Office Word 2003 has a total of
1,500. One thousand and five hundred com-
mands hidden behind a jungle of
menus—it is very easy to miss the
leaves for the forest. Indeed, by
Microsoft’s own admission, users
consistently ask the software compa-
ny to add features that are already pres-
ent in the suite—just invisible to us
common folks.

If there ever was a product that was
guilty of feature overload to the detriment
of productivity, it would be the current ver-
sion of Microsoft Office. A look at the
screenshot on next page—The current ver-
sion of Word with all toolbars enabled—high-
lights this in a striking manner. And this is
just the toolbars; let’s not forget the layers
upon layers of menus. 

The solution isn’t a pruning of features,
but rather a smarter presentation of every-
thing that Office can already do.  Microsoft is
aware of this, and has implemented, in 
Office 12, what it hopes is something that
will  expose the capabilities of its Office suite

Illustration Chaitanya Surpur

Renovating The Office
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to use in order to do the printing. A task-based
approach highlights a task rather than a process. 

Such an approach was also attempted with
the introduction of the Task Pane in the 2003
iteration of Microsoft Office. The new interface
of Office 2007 (or Office 12) builds upon this task-
based groundwork. Let’s say you’re working with
Microsoft Word. Over time, you will use certain
elements of the software—you will work with
fonts, play around with paragraphs, use the clip-
board, or maybe the search feature, and so on.
You might wish to insert a chart from Excel, or
even a normal table. Finally, you might want to
proof the document for spelling or grammar and
then send it across to a colleague via e-mail. 

Microsoft Word 2007 recognises that such a
workflow consists of atomic tasks. It breaks up
these tasks into tabs, such that each tab
contains elements that define the task. For
example, the task of actual word processing
falls under a tab called Write, which groups the
ability to change fonts, paragraphs, styles, etc.
Wish to add a table or a sheet? Look to the tab
labelled Insert, which will let you insert a chart,
WordArt, equations, symbols, and more. A
Review tab lists tasks pertaining to changing
the dictionary language, adding comments,
tracking changes, and so on. 

Menus have been largely eliminated: the
Ribbon is now the replacement for menus as well
as toolbars. The Ribbon is also what contains the
tabs we talked about. Although the tabs are a
very logical way of presenting options, you could
very well spend some time hunting for a feature
under tabs, rather than hunting under menus.
However, a tab is infinitely easier to navigate

than a menu. A new “Office button” has taken
the place of the File menu; what this adds is
primarily collaboration tools.

In our experience, working with this tab-
based, task-oriented user interface has certainly
made the process of discovering features much
easier than under the menu-driven regime. It
also reduces the number of clicks and mouse
movements needed to work a certain feature,
which is indicative of friendly interface design.

It’s A-Live
Apart from fighting menus, previous versions of
the Office suite have been guilty of throwing
arcane bits of information at us users. What

exactly is a gutter, and why does my page need
one? How does Mail Merge work? Don’t throw a
histogram at me, please; all I wish to do is reduce
the contrast of this inserted image. You then
have to wrestle with relics such as the Apply
button. Not being able to see what an option
does to your precious document’s formatting
without clicking on Apply is an exercise in frus-
tration, and invariably involves hitting Undo at
least once. You then have to dive back into the
menus for yet another go at the fine science of
word processing.

Office 2007 introduces a slew of features
which go a long, long way in reducing some of
this frustration. The most visible of them,
pardon the pun, is the ability to see changes live.
Office Word 2007, for example, allows you to
view different paragraph styles by just hovering
over the Quick Formatting stub under the Write
tab. Selecting fonts is also a more pleasurable
experience thanks to immediate visual feedback.
An inserted image can similarly be tweaked for

The new interface loses the brushed metal look of the
beta for a blue reminiscent of MSN Messenger

Word 2007
recognises that a
workflow
consists of
atomic tasks. It
then breaks up
these tasks into
tabs, such that
each tab contains
elements that
define the task

Office 12 offers immediate visual feedback. Seen here, drawing a table in real-time

The current version of Word with all toolbars enabled

Task-based panes under Windows Explorer
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brightness or contrast, with the changes imme-
diately visible on mouse hover.

Office 2007 also introduces the element of
Contextual tabs. Insert a picture and then click
on it to reveal a Picture Tools tab in the Ribbon,
which allows you to add a shadow or 3D effects
to the inserted picture. Insert a table to trigger a
Table Tools tab—in the Ribbon, of course—which
offers live formatting options. Notably, each of
these Contextual tabs comes in its own identifi-
able colours, which is a great touch.

Another great touch is the Mini Toolbar. This
is a context-sensitive menu triggered in any of
three instances—you double-click a word, or make
a selection, or you right-click inside an Office 2007
program. Double-clicking triggers a translucent
Mini Toolbar that allows for quick format changes
to fonts, bullets or alignment. The translucent
window goes opaque when you bring your mouse
cursor to it, and goes back to its ghost when the
mouse moves away… it’s an elegant and unob-
structed path to frequently-used tools.

Right-clicking triggers an opaque Mini Tool-
bar attached to the regular right-click menu.
Unfortunately, scrolling your list of fonts from
within the Mini Toolbar does not reflect the
choice live, thus diluting this feature. Perhaps
the final version will incorporate this.

A problem with Mini Toolbars is that they are
a bit intrusive. This is because it is triggered at
random places within text, and we found

MARCH 2006 DIGIT

ourselves accidentally clicking it,
especially while triggering it by
making a selection. This can be
solved by triggering the element a fixed
distance away from the mouse cursor.

Another element that goes into making the
suite’s features more useful is enhanced Screen-
Tips. A ScreenTip appears when you move your
pointer over an item in the Ribbon. Most often,
we rely on hovering over a button to understand
what it might do, rather than delve into the
labyrinthine Help system. Recognising this,
ScreenTips in Office 2007 are quite verbose, often
detailing how a feature works; sometimes
suggesting why it doesn’t, while simultaneously
displaying relevant shortcut keys, and a direct
link to associated articles in the Help.

Yes, But… What’s New?
Interface tweaks are nice, but does the beta offer
a taste of any new features? Feature additions are
minimal, at least those immediately visible.
Behind-the-scene changes aim to make the suite
more appealing to today’s connected workplace.
The most important implementation, with this in
view, is a new Office document format. Yes, Office
2007 adds another bevy of document formats to a
world that has surely had enough. The new kids on
the block are called the Microsoft Office Open XML
Formats and are open, not as in open source, but
open as in “use these or else…”

At least, they are royalty-free. Moreover,
being based on the XML markup language, they
do offer some neat treats. Data interoperability,
for example: any third-party application can, in
theory, create an Office XML document without
the need to use Microsoft Office. The formats
will add an X to the usual .doc and the .xls files
of today, giving way to .docx, .xlsx, and so on.
Such an XML document will practically be a ZIP
container holding the actual document, along-
side XML files and folders that define the
content of the document, its formatting, embed-
ded images, etc. It is a very modular approach to

A view of the Ribbon with the tabs. A new Tab called View seems to
have been added

Office 12 offers detailed ScreenTips. This entry is
practically a help file for Mail Merge

Contextual tabs such as Picture Tools in purply-pink
here, are of great benefit to your current task

A Mini Toolbar triggered via a selection. Note the font
tools offered
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storing data and brings with it flexibility, data
robustness, and of course, file compression,
thanks to the ZIP format.

Data recovery is also improved under such a
scheme: say an embedded image gets corrupted
while the file is transferred over wires—you
would still be able to recover the remaining data.
The modular approach also offers an organisa-
tion flexibility, since elements can be added or
dropped according to requirements. Finally, XML
is data-driven. A workplace can thus leverage this
document structure to enable content gathering
from disparate sources, create documents based
on the varied content, put up the document for
data mining, and also reuse content.

Apart from this overarching change in Office
2007, there are minor additions made to each
element of the suite. Outlook, for example, adds
a To-Do Bar, which lists pending tasks and adds
a calendar view. Creating tasks from an e-mail is
now a right-click away: a created task is auto-
matically added to the To-Do Bar. Also present is
an improved Calendar view, RSS feed integration,
and a better search tool.

Most of the feature additions are meant for
large businesses. The Microsoft Enterprise
Content Management offering in Microsoft Office
SharePoint Server 2007, for example, offers Web
content management, record management and
document management. It also includes search

and workflow features to leverage all the data.
Outlook can now mail calendars as HTML files
such that non-Exchange users can be kept in the
loop. The new OneNote 12 applies OCR to
collected data such as images, thus enhancing the
ability to scan for and collate data. The new suite
also brings in tighter integration—among the
constituent programs (such as Outlook, OneNote
and InfoPath) as also between the PC and
connected devices, such as cell phones and PDAs. 

Old Wine In A New Bottle?
On the whole, what we took away from the Office
12 Beta was that it offers a new chassis on what is
essentially the same engine. The new interface is
very good, and will be a huge boon to those of us
not very familiar with the inner plumbing of the

current Office suite. To a power user, however,
Office 12 offers little more than a prettier

way to do things.
While on this point, the new interface

leverages new hardware, particularly
graphics accelerators. The interface worked

almost flawlessly on an integrated nVidia
platform, powered by a GeForce 6150
onboard chip. Almost, because it did
display the occasional graphical glitch…
Notably, while Word, Excel and PowerPoint
ran nice and stable, Outlook was a bit

jittery and was prone to crashing.
But it’s beta software; stability is bound to

improve, system requirements apt to fall. As for
feature additions, we don’t think anything more
will be added to the Office gene pool, and quite
frankly, little needs to be. As it stands, Office
2003 is a very comprehensive package in terms of
features. So would you be willing to invest the
money and the relearning required to upgrade
from the 2003 suite to the 2007 version? Should
you even consider such an upgrade? We will
answer these questions when we review the
retail version of Microsoft Office 2007. For now,
we can only report that the new interface is
indeed an elegant solution, which ably exposes
the expansive capabilities of the Office suite. Our
congratulations to the Office team at Microsoft
for delivering that. 

readersletters@thinkdigit.comOutlook 12’s interface adds a new To-Do bar, support for RSS subscriptions, and search

Office 12 offers 3D effects and rotation for several ele-
ments. This is a diagram tool for creating Venn diagrams
and such

You pick and click from Galleries to format your document

On the whole,
what we took
away from the
Office 12 Beta
was that it offers
a new chassis on
what is
essentially the
same engine
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Ram Mohan Rao

“Data-oriented translation,” “Example-
based and context-based process-
ing,” “Syntactic parsing,” “Japanese

morphological analysis,” and such is the stuff
of machine translation (MT) research. But
that’s exactly not what we’re going to talk
about here, or even translate for you into
English! Here, we take a gentle look at the
potential of MT, and what we expect from it in
the near future. Will you be able to shoot off an
e-mail to a Spanish friend with it being trans-
lated in transit?

Your first brush with translation has proba-
bly been in the context of reverse translation
using online translators such as Google’s and
AltaVista’s. We’re talking about the forwards
that go round saying something like “Translate
the following to Spanish on Google and then
translate it back into English! Have fun!”
Reverse translation may be fun, but it’s unfair.
Unfair, because it’s stressing the system too
much, as it were.

But what about simple, one-way translation?
We have the all-time classic of hilarious MT in
the apocryphal story of a 1950s system that
translated “The spirit is willing, but the flesh is
weak” into Russian as “The vodka is strong, but
the meat is rotten.” Now that might be a joke, or
what, we don’t know, but let’s take a look at the
state of the art: at www.systransoft.com, when
you translate the German “Du Strahlenreiche”
(You radiant one) into English, out comes “You
jet realms.” And “Gleichnis” (likeness, or reflec-
tion) becomes “equalsneeze”!

Rays To Riches
That’s a sad state of affairs, but a good starting
point for an analysis. “Strahlen” means rays or
beams—hence “jet.” And “reich” means “rich,”
but “Reich” can also mean “rule,” or “domain” —
hence “realm.” Now, “Du Strahlenreiche,” for us,
is a combination of “rays” and “rich,” making for
a literal translation of “You who are rich in rays,”
which we understand as “You radiant one.” But
how is the poor software to understand that we

meant “rich” and not “realm”? More impor-
tantly, we gather from the context, and from our
world knowledge, that “rich in rays” can mean
“radiant.” How on earth would the software
know that there is even any such thing as radi-
ance in the world, given only the words “realm,”
“rich,” and “rays”?

An analysis of some ambiguous text shows
just how much a program needs to know in
order to be able to faithfully render a piece.
Consider three sentences - 

“I like the cat, I can drink milk.”
“I, like the cat, can drink milk.”
“I, cat-like, can drink milk.”
“I can drink milk like the cat.”
Even supplied with all three meanings of

“like,” a machine would find it really hard to
translate all four sentences properly! Then take
the example of “The shirt is in the trunk.” The
storage trunk? An elephant’s trunk? A tree-
trunk? We know that it’s the first one; why?
Because an elephant’s trunk is too small to
shove a shirt into, and because a tree-trunk is a
highly unlikely place to stash away a shirt in!
And who is to take on the job of feeding all
world-knowledge into a translating machine?
Then there’s idioms: “Woe is me” will, in all
likeness, get translated as “I am sadness” into
other languages.

We’re Tough Customers
As things around us develop at the proverbial
mind-numbing pace, we’ve become impatient.
We want IMs that translate, so you can type in
English and your friend somewhere reads your
text in Hebrew. We want a button on Web pages
where we choose the language to view the page
in. We want automatic speech translators, so we
can speak in Hindi with our speech coming out
in English through a mouthpiece.

Turns out something like that has already
been developed, but more on that later. For now,
have you realised how fortunate you are to be
able to read this copy of Digit? You have access to
more Web pages than most other people! Figures
vary from source to source, but apart from the
fact that Chinese is competing fast and hard,
English is still by and far the most prevalent

Illustration Shrikrishna Pakar

Machine
Translation
remains a tough
problem for
Artificial
Intelligence. Can
we expect more
accurate
systems in the
future?

Tech Transcends Tongues



language on the WWW. Why, and for how long,
need this imbalance exist? And remember, with
all the attention to multimedia, one is apt to
forget that text is still the mainstay of commu-
nication! The world needs automated transla-
tion—and soon.

Artificial Imbeciles
The MT problem is, of course, within the domain
of AI (Artificial Intelligence)), amongst other
disciplines. MT is very closely related to Natural
Language Understanding (NLU)—where a
computer attempts to understand what a spoken
or written sentence means. Now “understand-
ing” is something that’s been subjected to much
philosophical, scientific and pseudo-scientific
debate, so we won’t debate it here. But then,
stated one way, the goal of AI—as far as the input
side is concerned—is indeed to understand. In
that light, we can say that MT will advance hand
in hand with AI.

But when? MT hasn’t really seen any major
breakthroughs since its beginnings in the 50s.
In AI, promises have all too often been made and
not delivered upon; MT is no exception. Some
people say, “It’s all there: the hardware (fast
machines), the software (neural networks and
fuzzy logic), and it’s just a matter of time before
we get good automated translations…” Problem
is, it’s turning out to be a really long time. 

Some people have noted, though, that other
industries that do AI research—robotics, for
example—could come up with insights and
methods that would further the field. Then,
there’s the possibility that since one of the
biggest problems in AI is infusing common sense
into systems, MT would benefit as bodies of
common sense become bigger and better and
can be easily “plugged in” to existing systems.

Common sense apart, there’s the problem of
knowledge, as noted before. Unlike systems such
as chat-bots that require a little knowledge and
a lot of common sense, and unlike systems such
as chess-playing programs that work on lots of
knowledge and heuristics and not too much
common sense, MT requires both lots of knowl-
edge and lots of common sense!

Why knowledge? We mentioned earlier that
a system needs to know that an elephant’s trunk
is an unlikely place to shove a shirt into. Such
things straddle the border between common
sense and knowledge. But there’s pure knowl-
edge to be considered, too: certain words do not
occur in certain contexts, such as “glycogen” in

the context of reportage (something on this
later). “You” can be “tum,” “aap,” “aap log,” or “tum
log” in Hindi, depending on context. Cultural
and regional differences—both in terms of world
reality and word usage—exist between regions
and languages respectively.

The problem we’re pointing at is to decide
how much knowledge needs to be put in the
system, and how to encode it all so the machine
translator can put it to good use. And that is
going beyond even AI. It involves a collabora-
tion between cognitive scientists, linguists,
language and cultural experts, computer scien-
tists, and more.

Methods To The Madness
But talking about understanding, we’re led to
one obvious way to try and translate documents,
comprising the following steps:
l Understand the source document
l Put it in an intermediate format
l Generate the output in the target language

This is a step ahead from the “direct” method
of translation, which just takes a language pair,
inputs dictionaries of both, and tries to generate
translations without paying attention to context
and other nuances. The intermediate-represen-
tation approach also has the advantage that once
the intermediate “understanding” is generated,
you could translate that into any language, not
just one.

A third approach is called the “transfer
approach,” consisting again of three steps. Here,
the first stage converts the source language to
an abstract representation; the second maps
these representations to representations in the
target language; and the third stage generates
the translation. Note that the system doesn’t
exactly try and “understand” what’s going on in
the source language; there are abstract repre-
sentations involved for both languages, which
incorporate such things as context and real-
world knowledge.

But what seems really promising now is the
statistical approach, which we’ll soon talk about.

Google Everywhere!
In August 2005, in a US government-run test,
Google’s translation application beat technology
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from IBM and from various universities. In the
test, Google scored the highest amongst all
competing software in Arabic-to-English and
Chinese-to-English translation tests; these were
conducted by the NIST (National Institute of
Science and Technology). Each test comprised the
task of translating a hundred articles from Agence
France Presse and the Chinese Xinhua News
Agency from December 2004 to January 2005.

How?
The answer lies in statistical analysis. It now

seems increasingly likely that rather than have
a system try to understand a piece of text, or
formulate abstract representations taking
context and other things into account, the most
promising method of translation involves look-
ing at ready translations. How this works is, the
system would look at existing translations, and
be trained on those. For example, if the German
“reich” is often seen as being translated as
“rich” in the context of money, the system would
pick it up. And “Reich” gets translated as
“realm” or “rule” in the appropriate context—as
in “Die dritte Reich” (remember “The Rise and
Fall of the Third Reich”?)—and the distinction
would be made.

This means that the more the number of
documents in the source and target languages
available, the better the system would get at
translating. And, of course, Google has a very
large store of documents in various languages.

Humans To The Rescue
Chess is an example of an AI endeavour that has
succeeded remarkably well. Most others don’t.
Translation, like we said, is a hard AI endeavour,
and it’s unlikely we’ll see a good automated
translator soon. But there are three things to
consider here. First off, to aid a machine in its
job, the source text may have to be pre-edited, or
“normalised,” to make it suitable for translation,
as in the following:

I know I’m wrong.
I know, I’m wrong.
The two in English are similar, but the trans-

lations into German by free online translators
result in two very different things! Someone who
(a) knows the idiosyncrasies of the translation
system, and (b) has a good knowledge of both

languages, could “format” text for the best
results. Pre-editing is increasingly being seen as
an important step. One can come up with several
examples where pre-editing would be required
—slang would need to be toned down, casual
utterances would need to be formalised, missing
words such as “that” (as in “I know that I’m
wrong”) would be inserted, and so on.

Experts In Their Field
The second thing we need to look at in the
context of not ever getting good machine trans-
lators is that of domain-specific translation.
“Domain,” here, refers to fields such as weather
forecasting, physics, and so on. Why we mention
weather in particular is that in Canada, the
Météo system has been used to translate weather
reports from English to French. It has worked
well for decades now, and is still being used
without anyone even noticing or complaining!
How come? Simply because the system has been
tailor-made for the field, and because the
terminology rarely changes. There’s no slang;
the words always have a fixed meaning—for
example, a “cold front” is always in the weather
sense of the phrase.

Thus, instead of aiming at general-purpose
translation systems, we could set our sights
lower and think of developing several domain-
specific systems. Thankfully, a lot of the mate-
rial on the Internet that needs to be translated is
domain-specific.

Helping Hands
As a third point, we gather that in the face of the
problem being hard for AI, the future might well
see the machine translator working as an aid in
the translation process. In the case of the latter,
we can envisage someone with less-than-perfect
knowledge of the target language being able to
translate reasonably well with the help of a
machine: the machine would do a lot of the
dictionary searching and basic grammar construc-
tion, while the human would do the dirty work of
supplying context, and re-consulting the machine
in the case of an ambiguity. However, it all boils
down to money: critics of this approach say it
would be just as expensive as human translation,
but proponents say it would be less expensive on
account of the number of man-hours spent.

One other approach being seen as the future of
translation is that human translators would proof-
read machine translations. This, as in the former
case, has the advantage of reducing the man-hours
spent in the translation process. It has the added
advantage of the final output having been read
and verified by a human.

Is This The Future?
We’ve painted a somewhat anaemic picture so
far—that of MT not being up to speed, and fully
automated translation not being possible in the
near future. But here’s an excerpt from post-
gazette.com, dated 28 October 2005:

“Stan Jou’s lips were moving, but no sound was
coming out. Mr Jou, a graduate student in language
technologies at Carnegie Mellon University, was simply
mouthing words in his native Mandarin Chinese. But
11 electrodes attached to his face and neck detected his

Translation is a
hard AI endeav-
our, and it’s
unlikely we’ll see
a good
automated
translator soon

Site
www.systransoft.com

www.google.com/language_tools
http://babelfish.altavista.com/tr

http://trans.voila.fr/voila

www.linguatec.net/online/ptwebt
ext/index_en.shtml

http://translation2.paralink.com/

www.reverso.net/text_translation.
asp

Comments
Reasonably good; one of the oldest
existing tools
Probably the best one out there
Quirky. Sometimes OK, sometimes
pathetic
Site is in French; works better for
French translations
Has an excellent feature: subject area
selection for more accurate translation.
Works better for German translations
Poor, even at German translation,
which is the site’s speciality
Very bad, even though the site seems
to have won several awards

Some Online Translation Sites
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muscle movements, enabling a computer program to
figure out what he was trying to say and then trans-
late his Mandarin into English. The result boomed out
of a loudspeaker a few seconds later:

“Let me introduce our new prototype,” a synthe-
sised voice announced. “You can speak in Mandarin
and it translates into English or Spanish.”

This might sound like we’ve reached what’s
needed in MT, but the fact is that electrodes, and
the fact that speech is directly being translated
into speech on the fly, do not make for a better
translator! The article in the Post-Gazette goes
on to say that when (he) announced he would
take questions from reporters in Germany and
America, the computer heard it as “so we glyco-
gen it alternating questions between Germany
and America.” And, of course, things such as
humour would be entirely lost in translation, to
use the old phrase.

What’s interesting about this system—of
which several versions are being developed, by
the way—is that it uses the statistical approach
we mentioned earlier: a system learning from a
body of texts in both languages, and how the
translation was done between those texts. We
can’t stress enough that the statistical approach
seems to us the most likely way to go for the
future. And not just for the academic reason, but
also for the fact that the mass of information (in
all languages) on the Internet will increase with
time, so machine translators will have that much
more wisdom to draw from.

MT In India
It’s probably in the EU and in India that the need
for MT most exists. We came across two Indian
projects of note—the Tamil-Hindi Machine Aided
Translation System, at www.au-
kbc.org/research_areas/nlp/demo/mat/ , and “An
English to Hindi Machine Aided Translation
System: an ongoing project at IIT Kanpur,” at
http://anglahindi.iitk.ac.in/ . 

According to a document on the Anglabharti
project—which aims at translating English into
all major Indian languages, and of which
Anglahindi is a subset—the system uses some-
thing like an interlingua approach (the one that
converts sentences from the source language
into an intermediate system). It analyses English
sentences to create an intermediate structure
with most of the disambiguation performed in
this step. The intermediate language structure
has the word and word-group order according to
the structure of the group of target (Indian)
languages. Note that word order is an important
consideration, since English usually strictly
follows the subject-verb-object structure,
whereas Indian languages follow a relatively free
structure. As an example, consider

I am going to the shop.

This sentence, like most simple English
sentences, has the subject (“I”) first, then the
verb (“going”), then the object (“the shop”). Now
consider that it can be translated into Hindi as

Main dukaan ja raha hoon.
Dukaan ja raha hoon main.

Ja raha hoon main dukaan.
Main ja raha hoon dukaan.

Although one or two of these variants are
more likely to be used, the fact is they’re all
grammatically correct. In contrast, there’s no
way of rephrasing the English sentence.

Therefore, converting the intermediate
structure to each Indian language through a
process of text generation is a relatively simple
process. In fact, the authors of the paper say that
the effort involved in analysing the English is
about 70 per cent of all the work, while the text
generation accounts for only 30 per cent. Part of
the reason for this is the word order situation
we’ve described.

If you speak Tamil and/or Hindi, try these
out, and do remember to write in—we’re espe-
cially interested in the bloopers!

We Hate To Tell You, But…
MT is still in its infancy. Worse, it’s been in
its infancy since the 50s. Each researcher
proposes a different scheme for “the MT
system of the future,” based on one or the
other of the basic approaches. Some say we
will never have completely automated MT, and
sadly, that just could be true. In the foresee-
able future, MT seems best focused at aiding
human translators.

The most promising thing we can tell you is
that the statistical approach based on large
bodies of existing translation can only get better
as the information on the WWW increases: we’re
putting our bets on Google, by the way! Which,
reverse translated to and from German—even if
that’s unfair—becomes “We set our bets on
Google, by the way!” And that’s amazing… there
might still be hope! 

ram_mohan@thinkdigit.com

It’s probably in
the EU and in
India that the
need for Machine
Translation most
exists

Apossible future direction for MT would be to
take advantage of a linguistics theory called

“Universal Grammar” (UG). From Wikipedia, UG
postulates principles of grammar shared by all
languages, thought to be innate to humans. It
attempts to explain language acquisition in
general, not describe specific languages. UG
proposes a set of rules that would explain how
children acquire their language.

According to UG, there is only one method of
“diagramming” sentences; this method applies
to all the languages of the world, and is
universal because it is genetically encoded into
the brain of every human child. This is a bold
thesis, and a large number of linguists are
working within this approach.

MT would benefit from a well-developed UG
theory because the intermediate-language
approach could easily be used to generate a
representation of the meaning of the sentence,
since there is only one way of diagramming it.
Problems such as those of ambiguity resolution
would remain, but the problems of syntactic and
semantic parsing would be solved.

A Universal Grammar?
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There are two ways to hide drive letters
that appear in My Computer: via the
Registry Editor and via the Group Policy
Editor.

Method 1: Via The Registry Editor
Open the Registry Editor. Navigate to the
string
HKEY_CURRENT_USER\Software\Microsof
t\Windows\
CurrentVersion\Policies\Explorer

Create a new DWORD value and name it
NoDrives. All drives will be visible as long
as this value’s data is set to 0. Set the value
for NoDrives according to the following list:
enter the decimal number corresponding to
the drive(s) you want to hide as the
NoDrives value data. When you right-click
on NoDrives and choose Modify, make sure
you select Decimal, not Hexadecimal.

To hide multiple
drives, just add the
drives’ values. For
example, if you
want to hide both
drives A: and D:, the
NoDrives value
should be 1 + 8 = 9.

Using the same
decimal values, you

can arrange for a different behaviour that
will leave a drive visible, while making it
impossible for a user to view the contents
of the drive. It will also prevent him from
using the commands Run, Map Network
Drive, or Dir to view the contents of folders
on the drives. To do this, create a new
DWORD value called NoViewOnDrive and
use the same values as above.

Method 2: Using The Group 
Policy Editor
This method can be used only on Windows
XP Professional Edition. Open the Group

Policy Editor (Start > Run, type in
“gpedit.msc” and press [Enter]). Go to User
Configuration > Administrative Templates
> Windows Components > Windows
Explorer. Here, you’ll find “Hide these
specified drives in My Computer” and
“Prevent access to drives from My
Computer”.

The difference between the two settings
is that “Prevent access” will allow the user to
see the drive icon, but will give an error
message when he tries to access it. “Hide”
will remove the icon so the user won’t see it,
but the drive can still be accessed by using
Start > Run and keying in the drive letter.

Under this setting, after you click the
radio button next to “Enable”, you’ll see
several options. Choose the one you want to
apply, for example, “Restrict A and B drives
only”. You’ll notice that the options here
are restricted; you cannot, for example,
choose to restrict drives A, B and D. 

Display a logo on
the XP logon and
shutdown screens

THIS MONTH’S CHALLENGE

LAST MONTH’S CHALLENGE

Win!

Debangshu Sen
P.O. Burnpur,
Dist. Burdwan
West Bengal

LAST MONTH’S WINNER

Without using a third-party
tool, how would you
display your company’s
logo on the Windows XP
logon and shutdown
screens?

Write in with the subject
‘Take a crack’, and your
postal address, to
takeacrack@thinkdigit.com
with your solution
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How would you hide one or more drives of your computer
from appearing in your Windows Explorer?

Editing the appropriate Group Policy Editor settings

Drive Value
A: 1
B: 2
C: 4
D: 8
E: 16
… … …
Z: 33554432
All drives 67108863



Ahmed Shaikh

A true gamer doesn’t need an introduction
to a gaming article. After years of stalk-
ing its love across message boards, the

true gamer will tear off its beloved’s shrink-
wrap, throw away its manual, ignore its EULA
pleas, download its no-CD crack, skip its cut-
scenes, and proceed to have an ultimately-
doomed carpal relationship, with veins
a-throbbing! Does such a mortal need an intro-

duction? Perish the thought!
Suffice to say, we shall reveal

games worthy of such deli-
cious hyperbole that even

grammar will fail us! Nurse!
More exclamation points! Stat!

SONY PLAYSTATION 2
We begin with Sony’s answer to

organised religion—the
PlayStation 2, aka the PS2. The con-

sole has sold more than 100 million
units worldwide. Not owning one

will bring shame to your family. Buy
one, play these:

Devil May Cry 3:
Dante’s Awakening—Special Edition

Who is Dante you ask? He is our very own
Rajnikanth as imagined by the Japanese and

molded in the image of an overzealous
Amrikaan. He thus transcends boundaries
and culture, and is like a god; except he is the
son of a demon, and has to suffer through
over-the-top action, an-independent-and-yet-

beautiful-woman-armed-to-the-teeth-with-
guns, and one sibling rivalry straight from
Bollywood. Much ass-kicking follows, with
various firearms and melée weapons. Dante’s
Awakening also throws in some wild fighting
styles to the mix. As a Gunslinger, for exam-
ple, you can use two sawed-off shotguns as
nunchuks, air-juggle a hellspawn, teleport to
the other side of the room, use a downed
baddie as a surfboard, and do nasty things to
demon biology with oversized swords. The
combat unleashed by this game is relentless
and requires split-second timing to avoid
counterattacks, and to chain deadly combos.
This game will destroy your fingers, and its
boss battles, your soul. But play it you must. 

God Of War
If Quentin Tarantino were a game designer,
Kratos would be his Samuel L Jackson, except
with blades of chaos chained to his arms; so
much more effective than a purple lightsaber

Not unless your
eyes have bled
in joy, and your
fingers callused
under the
exuberant toil of
playing these
gems. PC or
console, we call
out the greatest
titles ever to
have graced
gaming. Ever!

...and
you call yourself a 
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anyway. In God of War, you play god-killer
Kratos as he slices and dices his way through
the entire Greek pantheon. The game unrav-
els a rich tapestry of Greek mythology for you
to spill blood on. Butt heads with every
monster imagined therein, from a hydra to
winged harpies. It’s very satisfying to meet all
this rich culture with a bloodied weapon. The
combat is not very deep, though. Combos are
simple to execute, and are unlocked by
collecting red orbs to power up your
weapons. Joining the blades of chaos are a
bunch of spells and one obligatory oversized
sword. God of War, however, balances good
combat with a great production value and
some challenging puzzles. It also uses mini-
games to great effect: successfully hit a combi-
nation of keys shown on-screen, and you will
shove your weapon down a Minotaur’s throat,
or tear off a Medusa’s head. It’s all very touch-
ing. How can you say no?

Shadow Of The Colossus
Battle and fell mighty colossi in this epic
action-adventure to save the love of your life.
Journey on horseback through a vast empty
world in which you have no enemies to destroy,
no dungeons to pillage, nothing much to do
but fight the game’s sixteen colossi. You race

across silence and a barren landscape until you
encounter these wonderfully-designed beasts.
You then need to kill what is most alive in this
strange, dead world. Each colossus is a behe-
moth—huge and threatening, with unique
weaknesses and attack patterns.

The game explains little of motive or back-
story, and you can’t help feel a little depraved
for the killing. Shadow of the Colossus is truly
a unique experience.

Guitar Hero
This game is a gift from rock-n-roll. It is an axe
from heaven to cleave asunder the mediocrity
that passes for music today. Ahem! With
Guitar Hero, you can play tracks from Black
Sabbath, Red Hot Chili Peppers, Queen,

Pantera, Megadeth, Judas Priest, Ozzy
Osbourne, White Zombie, The Ramones,
David Bowie, Jimi Hendrix, ZZ Top and more—
for a total of 47 playable covers and indie
tracks! The rocking is done to a custom game
controller in the shape of a mini Gibson SG.
The designers of this gem have clearly learned
their rock and roll well: Guitar Hero takes you
across six venues—from your basement to
sold-out arenas, as you play using one of eight
characters with unique looks and playing
styles, and pick up from among 10 guitars
that you can customise with 28 unlockable
skins. Guitar Hero also lets you battle it out
with one more player for the attention of a
crowd, with only Rock and Roll as your
weapon. You too can be a guitar god. Are You
Ready To Roccccccccccccck?

Katamari Damacy
Imagine yourself as a tiny green thing with
an unfortunate head. Now imagine yourself
holding a small ball that resembles a reject
set-piece from Johnny Sokko and the Giant
Robot. Imagine rolling that ball over a paper
clip, then over an eraser, then a pencil, then a
ruler, then a book, then a kitten, and so on,
until you’re rolling over the table, then the
house, then the trees, the cars, some unfortu-
nate onlookers—and you keep rolling and
rolling and rolling… like a dung-beetle
making an unfortunate statement on
consumerism! You roll your Damacy over
everyday objects in order to create balls of
certain diameters, which can then be used to
order to restore the stars and galaxies. Yeah.
The game works because it is fun and has
plenty of charm and personality. With an
excellent presentation, a funky soundtrack,
simple play mechanics, and challenging
levels—Katamari Damacy is the hallmark of a
good, fun game. It is also an ideal vehicle to
bring that girl you fancy to your gaming frat
house—chicks dig Katamari.

Metal Gear Solid 3: 
Subsistence
Metal Gear Solid 3 is difficult to pin down in
200 words or less. It is a stealth game, yes. It
has you playing as a super-secret spy called
Snake; stalking baddies through jungles, to
stop suitably diabolical plans. Fairly typical
fare on the surface, but the game is a master-

Digital Passion l Lead Feature



piece of complex stealth mechanics, and uses
a cinematic presentation to tell a surprisingly
atypical tale. It is at times self-depreciating,
sometimes tongue-in-cheek, but always
absorbing, peppered with intense boss battles
against characters such as The Pain, The Fear,
and The End. The game is set in a jungle and
emphasises camouflage. To which end, MGS3
allows you to apply face paint and slip into
various garbs. But even here, the game can’t
help poking fun at itself: it allows you to wear
a fake crocodile head and even a Naked, err…
skin, for Rambo-style gaming. The best bit is
perhaps the Snake vs. Monkey mini-game,
which pits the lead character against monkeys
from the game Ape Escape—with an objective
to capture all the monkeys using a stun gun.

MICROSOFT XBOX
It is difficult to recommend a game for the
Xbox. Except for Ninja Gaiden, which is reason
enough to own the console. The Xbox has few
exclusive games, and fewer worth playing.
Today, all the good titles on the Xbox are also
available on the PC. So here’s the deal: if you
don’t have a computer worthy of running
current-generation games, buy an Xbox. Most of
the multi-platform titles also look best on this
console. Plus you can enjoy the few exclusives…

Ninja Gaiden Black
This game lets you play as a Ninja! Nay, as The
Ninja—Ryu Hayabusa, who kicks derrières
and takes names, and may or may not chew
bubblegum while doing it. Ninja Gaiden Black
is a game of such epic coolness that your
fingers will numb to its manic button-dance,
your tongue will wallow limply as you
execute its savory combos, your eyes will pop

out with fear as yet another boss battle
ensues, and you will dance in visceral joy at
your victories. With a deep, satisfying, and
varied combat system, an unforgiving range
of battles and plenty of replay elements,
Ninja Gaiden Black is the reason to own an
Xbox. Yes, it is that good. Why are you still
here, you ninja dog! Go scurry forth and buy
this game, and then the console. Hyaaaaayah!

FarCry Instincts
FarCry Instincts takes the much-loved PC
game over to the Xbox, and does so with
style. With a completely revamped engine,
the game is a tour-de-force on the Xbox: it is
certainly one of, if not the best looking, game
on the console. If you haven’t played the
game on the PC due to hardware limitations,
do pick up this version. For those not in the
know, FarCry puts you into a lush tropical
jungle, and is a first-person shooter. The

pacing of the action is impeccable—its tempo
rises and falls: one moment you are all
stealth, the next you are Rambo let loose. The
game also mixes guns, jungle traps, special
animal traits, and vehicles. You can control
jet skis, hovercrafts, hand gliders and
Humvees, for some drive-by shooting and for
traversing the enormous levels that the game
throws at you. Great levels, dual-wielding of
weapons, varied enemies, vehicles, beautiful
graphics, well-paced action—Instinct delivers!

Forza Motorsport
Forza is Microsoft’s answer to the Gran
Turismo series on the PS2. These are not the
arcade driving games aimed at wimps, but
are simulators of everything on four wheels.
Forza, for instance, lets you drive more than
200 cars from 60 manufacturers. The game
throws in a varied mix of tracks as well—from
real-world racing tracks to tight street races
to fictional courses. Though it’s a simulator,
the game balances skill well, and is accessi-
ble to both newcomers as well as veterans of
car mechanics. Perhaps the best feature of
the game is the level of customisation it
allows on your ride through paint jobs, vinyls
and decals. The game also features visible car
damage, reflected in the performance of the
vehicle. Finally, not only does the game look
good, as any Xbox exclusive does, but also
sounds great: the roar of your opponent’s
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engine to the backbeat of ZZ Top’s La Grange
or your own custom soundtrack—ripped to
the Xbox’s hard disk. The game is a stickler
for detail for those who demand it, while
being accessible for those just looking to
burn rubber—a well-balanced addition to an
Xbox owner’s library.

Fable
Fable used to be an Xbox exclusive, but is now
also available on the PC as Fable: Lost Chapters,
with extra content thrown in. Being a Lionhead
creation, the game is obsessed with virtue and
good, and the shadows an
ego can cast, which passes
for evil. The game marches
to this good/evil beat, track-
ing every deed you do, no
matter how small or seem-
ingly insignificant, and
logging it within its
memory banks like some
digital god. (It even tracks
how far you can kick chick-
ens. Yes, you can kick chick-
ens in Fable.)

Unlike real life, Fable reflects your charac-
ters deeds visually—a bad avatar will grow
horns, a good one will be beatific to behold. It’s
an interesting reflection on how our culture
associates appearance with morality. The game
is also laced with typical British humour; inter-
acting with the world’s inhabitants is also a joy.
Women will fall in love with you, you will age
and scar as time passes, you can tattoo your
body and face, change your hairstyle, wear
ridiculous or cool armour, walk around in your
undies, go Conan with muscles if you use
swords much, or bald if you cast too many
spells… our most memorable experience was
when one evening, our avatar got stinking
drunk in the local tavern and then proceeded
to get others just as drunk—while watching
women throw up all over the place was nice,
better was when the kids mimicked your
drunken swagger and formed giggly beelines
behind you. Oh yeah, the game also has a good
story, a great combat and spell system, inter-
esting quests and a unique style of presenta-
tion. Another must-have!

THE PC
Consoles have certainly carved off a healthy
chunk from our PC habit. With the release of
the Xbox, every game went multiplatform
overnight, sometimes to the detriment of our
beloved computer. While console gaming has

its uses, some genres are still best experienced
on the Pee Cee:

Civilization IV
One more turn. Just one more turn. One more.
Just another. Right through the night and on to
dawn. It’s the evil black magic
of a Sid Meier game—Civiliza-
tion IV (Civ IV) retains the
addictive quality that is
the hallmark of this
series. If you on
unfamiliar terri-
tory here, Civ IV is
a turn-based strat-
egy title that puts
you in charge of
the major civiliza-
tions of the world,
with a view to
dominate and
emerge victorious.
Victory is possible through a range of tactics—
from war, to cultural hegemony, to scientific
domination; even religion is factored into this
particular outing. Role-play a variety of leaders,
from Gandhiji to Genghis Khan, alone or with
friends—over the Internet, or on a LAN, or even
via e-mail. The game can be a bit overwhelming
at its onset but once you get familiar with its
key concepts, prepare to feed yourself intra-
venously as you stay glued to your monitor for
hours at end. As a bonus incentive to buy this
insta-classic—it’s voiced by Leonard Nimoy of
Mr. Spock fame. Civ long and prosper!

F.E.A.R.
A game from Monolith is seldom wrong and
F.E.A.R. just reaffirms the development studio’s
knack for creating games of the highest caliber.
It is just as rare for a first-person shooter to

communicate the
visceral horror that
must ebb through a
gun fight. This game
talks the talk. You
can feel the weight of
each bullet as it
leaves the muzzle of
your gun, you can
taste the fear as
wood and brick
inches away, turn up
clouds of dust and
dirt to enemy fire;
bodies slump and
tear, glass shards the
air, one moment
there is the rat-tat-tat
and the thoom-
thoom of guns blaz-
ing and the next
instant it’s all over.
Silence, bodies, dust,

you live. The name of the game also points to a
supernatural plot that adds a psychological
weight to the F.E.A.R. motif. Let’s just say
bullets and bombs won’t be the only thing you
would be afraid of while playing this game.
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The Chronicles of Riddick:
Escape From Butcher Bay—Developer’s Cut
This was one of the must-have titles for the
Xbox prior to its recent release on the PC. The
PC edition features a few extras though, includ-
ing commentary from the game designers on
the game’s levels and scenarios. Escape from
Butcher Bay is one of the few games that imme-
diately connect you to your on-screen persona:
the beautiful graphics and a first-person view
help here, but so does Vin Diesel’s wonderful
voice-acting, a great combat system and some
truly memorable action sequences, excellent

dialogue deliveries and
Riddickisms (like Sid-
huisms, but much cooler).
The combat is truly note-
worthy, especially the bits
where your character
relies on old-fashioned
fists-fights and neck-
breaks to communicate

his point  of view. The game is a perfect blend
of stealth, action and black humour which you
must play, either on the Xbox or on the PC.
After you have, watch Pitch Black, then The
Chronicles of Riddick, and finally the
animated short The Chronicles of Riddick:
Dark Fury—from the same people who gave us
MTV’s Aeon Flux. Then, build a Riddick shrine,
and pray for a sequel.

Galactic Civilizations II: 
Dread Lords
eXplore, eXpand, eXploit, and eXterminate:
the 4X genre is back with a big bang in this
epic space-strategy. Galactic Civilizations II
has everything that makes a 4X game a joy to
play: the ability to customise a play session to
your liking, a deep research and technology
tree, and of course a variety of ways in which
to skin the proverbial cat. You begin as one of
ten available races, each with its own
strengths, or you can create your own mixed-
breed, customised to your liking. You then
pick a galaxy, small or big—the size of the
map determines whether the gaming session
is a quickie or a long-drawn space trilogy
with prequels. Gameplay can span genres-you
will build, you will research, and you will try
diplomacy, or guile, treats to appease, and
every dirty trick that you can conjure up to
get an upper hand over competing races. The
AI is very challenging as well, and will always
keep you on your toes. If, like us, you have
been clamouring for some good old-fash-
ioned 4X action, give this game a go.

Star Wars:
Knights of the Old Republic
If you have never played a Bioware game
before, you owe yourself this experience. If
you are a Star Wars fan, but haven’t played
this game, correct that oversight right away.
This is it, the quintessential Star Wars game.
Beautiful graphics, great character models,
excellent animations, amazing party charac-
ters, the best story in a PC game, (outside of
Planescape Torment), and possibly the only

game which lets you live the Star Wars expe-
rience. Saber fights, force powers, battle
droids, princesses, Millennium Falcon, and
all. You can choose to follow either the Light
Side or the Dark Side of the force, and are
awarded force powers accordingly. You can
also choose from a variety of body armour
and light sabers—which can be dual-bladed or
single, and can be dual-wielded; furthermore,
special crystals can be used to change their
damage properties and colour. This epic
adventure takes you across the Star Wars
worlds—from Dantooine, to Kashyyyk—and
will leave you wanting more. Fortunately,
there is more in the form of Star Wars
Knights of the Old Republic II: The Sith Lords.
The Force is strong with them both.

SONY PLAYSTATION PORTABLE
At first an object of desire, then a portable
movie machine (wink, wink), and now the
Sony PSP finally got game(s):

Mega Man Powered Up
Enjoy a well-balanced side-scrolling mayhem
in this update of the first Mega Man game.
Beautiful graphics, fast-paced action, cool
enemies, plenty of weapons and that Capcom

touch.

Street Fighter Alpha 3 MAX
Street Fighter to go! Faithfully ported to
the handheld, you have to own this semi-
nal 2D fighting game which is packed
with 40 fighters, and comes with ad-hoc
multiplayer. Tournaments on the go!

Burnout Legends
You can never play enough Burnout—fast,

frantic racing, and fast, fitting crashing, two
of our favourite things. This version packs in

elements from the first three console outings to
offer crunchy, juicy delight in each yummy bite.
Mmm, now we are hungry. For Burnout Legends!
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l DOOM 3
l Half-Life 2
l Quake 4
l Black & White 2
l The Movies

ALSO ON The PC



SOCOM:
U.S. Navy SEALs Fireteam Bravo
SOCOM delivers intense online and offline
shooter action. With impressive map sizes,
and a good control system, this outing on the
PSP is a must-have for fans of SOCOM and
strategic shooters alike.

Lumines
For many months,
Lumines was PSP—the
sole reason to own the
Sony portable. The title
is an ingenious,
fiendish, mesmerizing
puzzle game which
blends falling blocks,
with good visuals and
perhaps the funkiest,
grooviest music on a
handheld. Puzzle fans,
look no further.

Grand Theft Auto:
Liberty City Stories
The same great GTA experience, now on the
pot or at the bus stop. Liberty City Stories
offers the same freedom, wanton des-truction
and mayhem that makes for a GTA experi-
ence. This game is so good, in fact, that Rock-
star is porting it to the PlayStation 2.

X-Men Legends II:
Rise Of Apocalypse
A must-own, role-playing game for a fan of the
X-Men series. In Rise of Apocalypse, you can
recruit not only from the band of Xavier
Xealots, but also from the evil forces of the
Brotherhood. Muwahahaha. Cyclops, Wolver-
ine and Juggernaut in the same team, you
know you want this! 

Wipeout Pure
Perhaps the best racer on the Sony PSP. Not
just because it is good to look at but because
it has tight controls, great tracks, awesome
music and is regularly updated with 
extra content. If you have a PSP, you need
Wipeout Pure.

NINTENDO DS
With two screens, one of which is a touch
screen, Wi-Fi, and a mic, the DS seemed to be
the product of the kind of insanity that only
the genius possess. It is now the fastest-sell-
ing gaming console in Japan, and has sold
more than 13 million units worldwide in just
over two years.

Phoenix Wright: Ace Attorney
Ace Attorney is part adventure game,
part detecting (think Police Quest of
old), part whacky Japanese characteri-
sation, and all funny and fun! How can you
resist a game which encourages you to
shout “OBJECTION!” at the DS? You can’t,
and you shouldn’t. Unless you wish to miss
out on one of the best gaming experiences
of the past year.

Castlevania:
Dawn of Sorrow
This Castlevania experience is arguably the best
yet. As a 2D exploration, action and adventure
game, nothing beats this title. With a rudimen-
tary role-playing element, the game offers a
range of weapons, the ability to customise and
upgrade them, a vast castle to explore, huge
bosses to defeat, and excellent replay value
thanks to an unlockable mode and a level editor.

Mario Kart DS
Single-player grand prix races across 32 tracks
and three engine classes, eight characters to

choose from, each with multiple karts. You
can also race against seven of your friends

with only a single copy of the game.
Or head online. With zany items

such as lightning bolts to shrink
your opponents, ink-squirting

squids to obscure their vision and
mushrooms for boost, the game is a blast

offline or on.

Tony Hawk’s American Sk8land
A Tony Hawk’s Pro skating game that goes
back to its roots to deliver the goodness
which recent titles have floundered with.
With a great cell-shaded 3D world, slick pres-
entation, an excellent soundtrack, online
multiplayer, and great skate mechanics, the
game is just gr8!

Age of Empires:
The Age Of Kings
The PC game we all love spawns a turn-based
avatar on the Nintendo DS. Although turn-based,
the game retains everything that made the PC
version great. With five playable factions and
more than 20 hours of gameplay, Age of Empires
will satiate your portable strategy needs.

Sonic Rush
Once upon a time, Sonic was loved. Then Sega
did such vile, dreadful things to our favourite
hedgehog and broke our heart. We would
sulk some more but in Sonic Rush, Sega’s
penance is at hand. This DS outing brings
back everything that made Sonic so much
fun—speeeeeeeed and crazy looping, jumping
levels. The game makes great use of the DS’
two screens to maximise the verticals and
enhance the sense of speed. If you’re a
Sonic fan, you must not miss this game!

readersletters@thinkdigit.com
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l Advance Wars: Dual Strike
l Nintendogs: Dachshund and Friends
l Kirby: Canvas Curse
l Meteos
l Super Mario 64 DS
l Electroplankton
l Resident Evil: Deadly Silence
l Viewtiful Joe: Double Trouble!
l Ultimate Spider-Man
l Mario & Luigi: Partners in Time
l Star Wars Episode III: Revenge of the Sith

ALSO ON The Nintendo DS:



A business smart-
phone this may be,
but it’s cool enough
for any of us to drool
over

Imaging Sivalal S

Nokia E61 

Digital Passion | Geek Dreams
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The E61 is the first QWERTY business
smartphone from Nokia, and has been

touted as the Blackberry killer. It’s optimised
for e-mail, and has special features for e-mail
such as an Inbox shortcut key, an indicator
for incoming mail, and so on. With the E61,
Nokia has departed from their notebook
designs to an elegant, executive one.

The brilliant 320 x 240 active matrix
display lends the phone a Palm-ish feel. Its
screen supports 16 million colours. There is
the 75 MB of onboard memory, which can be
expanded via the miniSD card slot. Expect
Nokia to bundle at least a 64 MB card with
the phone—that’s a goodish bit of memory
for a business phone!

The phone not only supports quad-band,
but is also WCDMA-enabled—and so can be
used anywhere in the world.

The Nokia E61 comes with attachment
viewers and editors for features of MS Word,
Excel and PowerPoint. Then there’s MS
Outlook contacts and calendar. It also
supports Adobe Reader and Zip manager, as
well as several third-party e-mail clients
including Blackberry Connect.

The phone plays MP3 and AAC, and can
stream 3GPP and RealMedia content. The
connectivity spectrum spans Bluetooth, Pop-
Port and IR.
There’s no
camera inbuilt,
but this can be
a virtue since
many corporate
offices ban the
use of camera
phones.
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Day 1
Accustomed to my Nokia 6630, the Motorola A768i feelsforeign. Motorola phones in general are notorious for theirclumsy interface and this played on my mind, but it wasnot to deter me from using the phone. The A768i looks brilliant in its sedate silver grey outfit,and is so executive’s phone. The clamshell design and thebuild quality are great.

The phone can be worked on without a SIM card—when switched on, it says “No SIM card found,” but onceyou click OK, you can proceed to use other features on thephone—a must for a PDA phone. I spent some precioushours understanding the interface sans the SIM.
Day 2
You cannot potter around with a phone for long without aSIM card and in it went, the next day. The interface ismiles ahead of the earlier Motorola phones, and the menustructure is neatly arranged. The stylus was testing mypatience as I tried to enter notes and fiddled around withother features. However, it allows single-handedoperation without the use of the stylus too. 

Day 4
None of the three themes on the phone wereinteresting, so I decided to customise them.Adding a home screen was quite easy. Thephone offers customisation of text size,message alerts, and more. I didn’t likethe camera, though; the pictures aregrainy. 

Day 6
My enthusiasm is increasingwith experience. Came across thePicsel browser on the phone.
This excellent utility, apart

from browsing the Net,
allows opening and
reading of .doc and PDF
files. The interface is
sleek and permits

zooming and panning.

Day 9
I did not expect any hiccups when transferring data fromthe PC to the phone, and I was right! The CD bundled withthe phone contains many more ringtones and multimedia.

Day 15
Decided to use the audio recorder on the A768i for aninterview. but I realised that I might pay dearly for usinga feature I was unsure of, but the results were quitesatisfactory. The volume level was low, though.

Day 18:
Issues have begun cropping up. The SIM card—which I’vehad for three years—created a problem when sendingmessages, and I had to get a new SIM. And then there wasthe episode with the settings: features within the messageand voice settings are difficult to locate. Charging takesunusually long, and the battery indicator is unreliable.

Day 22
Tired of using the default Web browser, I decided to installthe Opera mini. It has a much better interface, and the siterendering is an out-of-the-world experience.

Day 27
My initial concerns of a quirky Motorola OS are quicklydisappearing. I’m fast at the stylus now, can browse the phone with one hand, and can easily get to any hiddenmenu. Using the stylus is addictive, and I almost despisemy Nokia 6630 for not having one!

Day 30
Most people, loyal to one brand of phone or the other,easily take a dislike for alternatives. All it takes is a littlegetting used to. I’ve had a relatively good experience, butthe Motorola A768i needs improvement to match up to the

likes of the PDAs by
Sony Ericsson and 

Nokia.
sanket_naik@thinkdigit.com 

Sanket Naik

It feels like an eternity since I’ve been using my Nokia smartphone, and was lately itching for a new experience. I’d

been toying with the idea of attempting to use a phone with a stylus and a touch-screen. With the Motorola A768i, I

got my chance. What follows is 30 days of leaving behind the old and embracing the novel.

A PDA-Phone

Digital Passion l 30 Days With...
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Ahmed Shaikh

Over the past year or so, the online com-
munity has hit the reload button on The
Browser Wars. 2005 witnessed the rise of

Mozilla Firefox after years of sulking in
Netscape’s shadow. Today, the open source
Firefox is a force to be reckoned
with, drawing in a healthy
sum of money for the
Mozilla Founda-
tion. For a free
browser, that’s
quite a feat. It
has also cap-
tured a good
chunk of
the market
s h a r e ,
forc ing
Microsoft
to rev up
its Internet
Explorer
team and

launch a preliminary counterattack in the form
of a beta release. 

Hurrah for Firefox and all that, but amidst the
din of Mozilla vs. Microsoft, the world seemed to
have forgotten—or worse, ignored—a little gem
from Norway called Opera. Historically, this was
because Opera wasn’t free as in beer. The unreg-
istered version was marred by text and banner

ads, and if there is one ill the open source
movement has fanned, it is our expecta-

tion that any software—no matter how
complex—be completely free.

Thank you!
Late last year, after cele-

brating Opera’s 10th
anniversary, the

We take our opera glasses to the coolest Web browser out there and come away with a treasure
trove of tips, tricks and a sneak peek at its future

Fandom of the Opera
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in Opera using a single keyword. To do this, go to
Bookmarks > Manage Bookmarks, right-click on
the Math folder, click on Properties, and then type
in an appropriate nickname—we choose “maths”
here, and typing in “maths” in the address bar
will launch the three bookmarked Web sites.

Opera offers spatial browsing, which in
essence enables traversing a Web site solely via
the keyboard. For example, hitting the arrow
keys while keeping [Shift] pressed will ask Opera
to cycle through all the links on a page, and any
form elements:
Navigate links [Shift] + [Arrow keys]
and form elements
Cycle through headers [S] and [W]
Cycle through elements [D] and [E]
Cycle through frames [3] and [Shift] + [3]

Opera lets you search for text or links within
a page, displaying results live as you type. Trigger
a text search via the full-stop key—[.]. Similarly,
you can search for any links in a Web page via the
comma [,]. 

One of the most useful features of Opera is its
integration with the Answers.com online service.
No longer do you have to wonder about the
meaning of a word—whether it’s pertaining to
simple usage or something technical, the service
tells you everything you’d need to know, and
even suggests correct pronunciation via audio.
To trigger this, just double-click on the word in
question and click on Dictionary. Opera will take
you to the relevant Answers.com page, which col-
lates information from a variety of sources
including dictionaries, thesaurus, encyclopae-
dias, translations, and real-time data such as
weather reports, currency converters and stock
tickers. The selection need not be limited to just
a word—phrases, too, can be selected in this
manner. A very useful feature, especially if you
are a researcher or student.

While using this feature, you might have
noticed the Translate option on the right-click
menu. As the name suggests, the feature uses dif-
ferent engines to translate a block of text in a
variety of language pairs including French to Eng-
lish, German to English, Italian to English and
Japanese to English. It beats having to separately
visit Babelfish or the Google online translator.

Another nifty feature for the data collectors

Norway-based Opera Software decided to remove
the hurdles of banner ads, waived the licensing
fee, and thus freed the browser. Which is where
this article comes in: there is little reason for you
not to be using this browser. Opera is as compre-
hensive a package as you’d want to take you
online. Much more than just a Web browser,
Opera comes with an e-mail client, a contacts
manager, an IRC chat client, an RSS feed reader, a
download manager, and a pop-up blocker; it offers
tabbed browsing, visual themes, mouse gestures,
keyboard navigation, smooth zooming of both
fonts and images, a trash can that holds all the
pages you’ve closed, a session feature that lets you
resume browsing from where you left off in the
event of a crash and much, much more. All in a
free, 4 MB package.

The upcoming release (which you can down-
load as a technology preview) adds BitTorrent
support, widgets, a content blocker, thumbnail
preview of tabs, and follows only Konqueror to
pass the Acid2 Web compatibility test—which
essentially tells a Web designer whether the
browser is compatible with W3C standards.

So let’s take a look at what this Web platform
can do for you, starting with some good old-fash-
ioned browsing.

Web Browsing 2.0
Each time you fire up Opera, you start what is
called a session. You can launch a separate session
by pressing [Ctrl] + [Alt] + [N]. Since Opera supports
tabbed browsing, each session can have multiple
tabs. Two features emerge from the concept of ses-
sions: you can save a session and launch it with
Opera, and you can resume a session in the event
of a system crash. Saving a session is a great way
around having to bookmark all the sites you’re

browsing. To do this, open up the sites in new
tabs—[Ctrl] + [N] opens a new tab—then go to File >
Session > Save this session. Note that you can
choose to auto-launch your selection of sites when
Opera launches. On a related note, to change the
launch behaviour, go to Tools > Preferences and
choose an option from the Startup drop-down list.

You can also launch a group of bookmarks
from the address bar for similar functionality. In
our example, we have a bookmark folder called
Math, which contains three Web sites pertaining
to mathematics. Say we want to launch the three

You can load a saved session when Opera loads or you can
ask Opera to auto-load the session every time it starts

You can launch a bunch of bookmarks by typing one
nickname in the address bar

The upcoming
release of Opera
adds BitTorrent
support, widg-
ets, a content
blocker, thumb-
nail preview of
tabs, and follows
only Konqueror
to pass the Acid2
Web compatibil-
ity test
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is Notes: Opera can collect any selected text and
store it as a note. Collected notes are searchable
in their entirety via the Notes panel, triggered
by pressing [Ctrl] + [6] or via the left panel. You
can copy selected text to a note by [Ctrl] + [Shift]
+ [C], or you can copy the contents of the clip-
board to a note via [Ctrl] + [Shift] + [V]. You can e-
mail a note via a right-click; Opera will use either
its inbuilt e-mail client or an external program,
depending upon your configuration.

Opera can read out a page for you. To enable
voice, double-click on some text and select Speak.
Unfortunately this requires an additional 10.5
MB download. After the download, you can select

any text and then hit [V] (or select Speak) to ask
Opera to read the selection out to you.

Voice commands, too, are supported in
Opera. To enable voice control, go to Tools > Pref-
erences, click on the Advanced tab, and select
Voice from the left-hand pane. You can com-
mand the software by pressing the [Scroll Lock]
key and prefixing a command with “Opera”—
thus pressing [Scroll Lock] and saying “Opera
Exit” will exit the application.

Opera’s Start Bar is one of those elements
which at first might seem frivolous in an inter-
face, but once you use it, you’ll wonder how
you ever did without it. To access the Start Bar,
click anywhere in the address field, or press
[F8]. The most important element here is the
“Top 10” button, which lists the 10 Web sites
you frequent most. Also notable is the
Amazon.com search engine, but less so,
because you can trigger a search in nine search
engines right from the address bar. For
example, press [F8] to highlight the address bar,
then type in “g thinkdigit” to trigger a Google
search on “thinkdigit.” Here are some other
search engines you can use:
TO USE THIS SEARCH ENGINE PRESS THIS KEY
Google groups [R]
Google News [N]
Download.com [W]
Amazon.com [Z]
eBay.com [E]

Opera has perhaps the best implementation

Concept Mapping

Opera’s integration with Answers.com is excellent for research purposes. Here,
we search for “Supercomputer.” Note the speaker icon denoting spoken

pronunciation under the dictionary entry

Translating selected text into various languages is just
a click away

Notes are a great way to collate varied bits of information
from the WWW, like the Blackadder quotes here

Triggering an Answers.com search based on
the word “Supercomputer”

The entry for “Supercomputer” under
Answers.com, here the dictionary entry

The word “Supercomputer” translated into
various languages, also on the same page

The Wikipedia entry for supercomputer, on
the same page as the dictionary

Opera's Start Bar lists the Top 10 Web sites you visit
most frequently
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of tabs amongst current browsers. You can open
a new tab by middle-clicking your mouse on any
empty area of the Page Bar, or via [Ctrl] + [N]. You
can also close an open tab by middle-clicking
directly on the tab. Middle-clicking on a link will
open the link in a background tab. To close a tab,
press [Ctrl] + [W]; to close all tabs, press [Ctrl] +
[Alt] + [W]; to close all tabs but the one you’re in,
press [Ctrl] + [Alt] + [Shift] + [W]. This might seem
like an awful lot to remember, but you’ll get used
to it once you start using it regularly!

You can cycle forward through open tabs by
pressing [Ctrl] + [Tab]; this can also be done by
keeping the right mouse button pressed and
rolling the scroll wheel. Incidentally, using the
scroll wheel while keeping the left mouse button
pressed will zoom in and out of the page—note
that this zooms both the fonts and the images.
You can maximise a tab by pressing [F11];
pressing [Ctrl] + [F11] will fit all text to the hori-
zontal size of the window, thus eliminating the
dreaded horizontal scroll in a Web page.

Mouse gestures are a novel way to navigate
Opera. Those of you using Firefox might be
familiar with mouse gestures if you have the
extension that enables it. When you first use a
gesture—perhaps accidentally—Opera will ask if
you wish to enable the feature; click on [Yes].
For example, you can hold the right mouse
button and draw an “L” onto a Web page to tell
Opera to close it. Here are some other gestures
you can use (with right mouse button):
MOUSE GESTURE ACTION
Move down Open new window
Move up and down Reload
Move up, then right Restore or maximise window
Move down, then left Minimise window
Move down, then up Duplicate window
Move down, then right Close window

Communication 2.0
Opera comes with a very capable e-mail engine
called M2 that allows for quick searches both on
the subject and the content of an e-mail message.
Moreover, the engine is flexible enough to be
used as an RSS feed reader. To enable the mail
client, go to Tools > Mail And Chat Accounts.
Opera will then take you through the setup
process. You can now open the e-mail panel by
pressing [Ctrl] + [3]. The M2 mail client auto-

matically filters your e-mails into preset cate-
gories. For example, all incoming mails with
attachments will be found under the Attach-
ments heading in the Mail panel. Moreover,
there is further filtering into documents,
image, music, video, and archive attachments.
You can use this feature to quickly track down
a particular mail.

Also note the Label field here. As you can
guess, you can label each message with a par-
ticular tag—say Important, Mail back, Funny,
or whatever. This helps in managing your mail,
and is a feature similar to the Star feature in
Gmail. Speaking of which, much like Gmail,
Opera can send a quick reply to a mail. This is
done simply by typing in some text in the
Quick Reply field that accompanies each mail
and then hitting the button. A quick reply
quotes the original mail and appends your
entered text to the beginning.

You can change the default signature while
sending mails: go to Tools > Mail And Chat
Accounts, select your e-mail account, and click
on Edit. Now head to the last tab, titled Out-
going—you can use a custom signature by typing
it in here. If you have a back-and-forth commu-
nication ongoing, the M2 mail client will track
the conversation under the Active Threads
heading. Moreover, M2 can track the contacts
you converse with. Such contacts will be listed
under the Active Contacts heading. You can also
manually add a contact by right-clicking on an
e-mail ID and choosing “Add to contacts.”

The mail engine is also capable of fetching
your RSS feeds and mailing lists. Subscription to
an RSS feed works much the same way that it
does under Firefox—if a Web page has Atom or
RSS feed subscription, a feed icon will appear in
Opera’s address bar. To subscribe, click on the
icon. RSS feeds are listed in the Mail panel under
Newsfeeds. Once again, the best thing about M2
is that it is searchable in its entirety—you can
therefore search the contents of an e-mail and of

all your RSS feeds using the same Start Search
window in the e-mail panel. Note that you can
also search for a contact using [Ctrl] + [4] and
search through your notes using [Ctrl] + [6].

The M2 mail client has a spam filter that
functions on a whitelist. This means that it will
tag suspicious messages as spam unless you
manually tell it not to. You can also create fil-

Opera’s e-mail client; note that the two mails with
attachments are automatically filtered under Archives in
the left Mail panel

Reading RSS feeds under Opera

Mouse gestures
are a novel way
to navigate
Opera. For exam-
ple, you can hold
the right mouse
button and draw
an “L” onto a
Web page to tell
Opera to close it
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ters based on To, From, Subject, and other fields.
To do so, right-click on the Mail panel and click
on New Filter; name the filter, click on the Rules
tab, and then on New Rule to add rules based on
the listed criteria. For the highest efficacy, select
the “Learn from messages added…” checkbox.

Finally, Opera can also serve as your IRC chat
client. You can surf your favourite DALnet and
Undernet channels using Opera. Each chat
window is treated as a separate tab, and down-
loads are handled via the same Transfers
window that is used by the rest of the browser.
To enable this client, go to Tools > Mail And
Chat Accounts, then New, and then Chat (IRC). 

With a comprehensive e-mail client, an
RSS/Atom reader, a contacts manager and an
IRC chat client, Opera ably offers a compre-
hensive package for staying connected to the
WWW. Notably, the new version of Opera—ver-
sion 9.0—is also set to introduce BitTorrent sup-
port and introduce widgets to the
browser—applets that brings in information
snippets from the Net. These could be news,
RSS feeds, stock prices, and so on.

Issues 2.0
Opera’s Web rendering engine is second to none.
It’s fast and accurate, and is especially great in
a low-memory, dial-up setup. It’s not all rosy in
the Opera camp though. Although the browser
strives to be 100 per cent W3C compliant, Web
developers are far from getting there. Every now

The upcoming version of Opera adds desktop widgets to
the mix

This widget lets you view the latest Slashdot posts. Note
that the widget is visible even if the browser is
minimised

and again you will stumble upon a site that
doesn’t render quite right under Opera. For
example, the Gmail/Google Talk integration
does not work. You can report a problematic site
with a few simple clicks, though: to do so, go to
Help > Report A Site Problem.

The so-called Web 2.0 era is fast approaching.
AJAX Web sites already offer desktop-quality
software online, as is evident when using sites
such as Writely, Gmail, and Flickr. The Web
browser, then, is poised to become an even more
important element in our software repertoire.
Little wonder then that Microsoft is scrambling
to blur the lines between its desktop and online
offerings, via both its upcoming Windows Vista
as well as online services such as Live.com. The
Mozilla Foundation also has great plans for
Firefox, as does the Konqueror team which has
risen to prominence thanks to Safari’s use of the
KHTML rendering engine. 

The team behind Opera has done wonders
with this little package. The browser is winning
market share in the mobile market—it can be
found on Symbian and Windows-powered cell
phones, PDAs, and the Nokia Internet Tablet,
and will soon be available on the Nintendo DS
handheld gaming console. There is competition
in the air, and that’s a Good Thing. 

readersletters@thinkdigit.com
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Take your pick! We’ve
tested 33 LCDs—from
compact 15-inchers to
19-inch monsters
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Jayesh Limaye and Anup Nair

W
ith their sleek
lines, thin profile,
light weight and
flat screens, LCD

monitors have always caught
one’s fancy. Their high costs lim-
ited them to niche segments,
though, but due to several fac-
tors, prices of LCD screens are
plummeting. The smaller ones
have now come within the reach
of home users, and LCDs seem
poised to replace CRTs for good.

There is a variant in the LCD
space which must be talked
about here. Regular CRT moni-
tors and LCD panels come in
what is termed the 4:3 aspect
ratio. Your television set, for
example, has a 4:3 display
screen. Some displays, however,
come in a 16:9 screen ratio,
which means the width of the
screen is significantly more
than its height. Such a display is
called a “widescreen,” and
makes for a better movie-
watching experience. 

While the widescreen aspect
is another positive on the LCD’s
side, viewing angles have been a
problem: an LCD tends to
appear darker and discoloured
when viewed beyond a certain
angle. This is undesirable when
the screen is being viewed by
number of people seated at dif-
ferent positions—as would be
the case if they were watching a
movie. Some displays today
apply a special coat to their LCD
panels, which goes a long way in
increasing the viewing angle
and the image contrast ratio
(more on contrast ratio later).

Before you pick an LCD mon-
itor, we must point out another

potential roadblock to its enjoy-
ment. It might have a slow
response time, which can lead
to the appearance of trails, or
what is known as “ghosting” of
images. Ghosting is generally
visible as trails behind fast-
moving objects. It is a some-
what subjective effect—some
people can see it, others cannot.
It is thus a good idea to try out
a movie or a game on an LCD
panel before purchasing it.

We must tell you that LCD
monitors aren’t yet perfect for
movies or games. Thankfully, at
least one issue seems to be
resolved: buyers were often told
to beware of dead pixels before
picking an LCD screen. (A dead
pixel is one that is either always
on or off, and is thus useless in
general, everyday use.) With
better quality control, however,
dead pixels are rarely seen on
LCD panels today.

Here, we compare a range of
available LCD monitors. We
received a total of 33 monitors
for this test. Of these, the
15-inch category consisted of
seven units from seven brands,
the 17-inchers consisted of 15
from 12 brands, while there
were 11 19-inch monitors from
nine brands. NEC sent in the
highest number of LCDs at
seven. Our effort here has been
not to help you make a well-
informed purchase decision.

A Look At Features
Let us first take a look at 
some of the key features to 
look at before you zero in on 
an LCD. These are by no means
the only features there are, 
but are certainly the most
important aspects of such a 
display unit. 

Pixel Pitch
The distance between two white
pixels or two sub-pixels of the
same colour is known as the
pixel pitch of the monitor. A
white pixel is made up of three
sub-pixels—one red, one green
and one blue. All the categories
saw pixel pitches of 0.29mm and
0.26mm. Pixel pitch varies with
monitor size, and is generally
fixed across a size category.
Needless to say, the individual
size of each sub-pixel is smaller
than the pixel pitch.

Native Resolution And
Screen Aspect Ratio
LCD monitors have what is
called a “native resolution,” and
cannot display crisp images at a
resolution other than this reso-
lution—unlike CRT monitors. If
you change an LCD’s native res-
olution, you will see a badly
focused image, and hard-to-read
fonts with blurred edges.

The 15-inch and 17-inch
models we received had native
resolutions of 1024 x 768 and
1280 x 1024 respectively. The
19-inch monitors had a native
resolution of 1280 x 1024 when
the aspect ratio was 4:3,
whereas it was 1440 x 900 when
the aspect ratio was widescreen,
at 16:9.

The widescreen aspect ratio
was only seen in the 19-inch cat-
egory. The monitors with a wide
aspect ratio were the Acer
AL1916W, Asus PW191 and the
CMV CT-937A. A wide screen is
especially good when you’re
viewing wide-screen movies.

Luminance
Luminance and contrast ratio
are very important factors in any
monitor, and they are even more
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important for an LCD. Unlike
CRTs, in which these depend on
the phosphor screen, LCDs have a
fluorescent lamp built into the
LCD monitor’s casing. The brighter
the lamp, the higher the lumi-
nance, and the better the monitor.
The lamp rating is what deter-
mines the brightness level the
monitor can achieve. A higher
luminance means the LCD is
easier to view in a bright room and
from a distance.

In the 15-inch category, the NU
L511E had the highest luminance
rating at 300 cd/m2 (candelas per
square metre). The rest of the 15-
inch category had a luminance of
250 cd/m2. Under the 17-inch cate-
gory, the Asus PM17TU had a lumi-
nance rating of 500 cd/m2—the
highest we’ve seen amongst all the
LCDs featured in this test. Note
that this is a vendor-specified
rating, and a rating of 500 means
that the LCD can look bright even
in a fully-lit room. The CMV CT-
712A, with a luminance of 400
cd/m2, had the second-highest
luminance rating. We were sur-
prised to see that the highest lumi-
nance in the 19-inch category was
330 cd/m2 of the CMV CT-937A,

while most of the LCDs in this cat-
egory had luminance ratings of
300 or less. The lowest luminance
rating was seen in the 19-inch
Philips 190V—240 cd/m2.

Contrast Ratio
The ratio of the brightness of pure
white versus pitch black that the
monitor is capable of displaying is
known as its contrast ratio. Moni-
tors with a higher contrast ratio
display images with better visual
depth. A monitor with a higher

contrast ratio also allows you to
fine-tune its contrast settings to
suit different lighting conditions.

As a rule of thumb, a contrast
ratio of 120:1 is enough to display
most colours. When the contrast
ratio is even higher, the LCD is
able to display more levels of grey.
What this means is that with an
LCD with a high contrast ratio,
you will be able to see more
shades of colour.

The NU L511E and the Sam-
sung SyncMaster 540N claimed
the highest contrast ratio of 500:1
amongst the 15-inchers. The
others had contrast ratios of 450:1
and 400:1. In the 17-inch LCDs, the
BenQ FP71E+ boasted of a very
high contrast ratio of 1000:1—the
highest of all LCDs in the test. This
means the user has a wide range
of contrast and brightness to play
with. Most others in this category
had a contrast ratio of 600:1 or
500:1. The ViewSonic VA712 had
the lowest contrast ratio of 350:1,
leaving little room for tweaking.

In the 19-inch models, the
highest contrast ratio—800:1—was
seen on the NEC MultiSync
LCD1920NXp, followed by the Acer
AL1916W with 700:1.

The monitors were tested keeping in mind performance, features,
and value for money. Before running the tests, the monitors

were placed perfectly vertically in order to eliminate any uniformity
issues, and were auto-calibrated. All the monitors were set to their
native resolutions, and the drivers were loaded for best
performance.

The Test Bed: Both the reference and the test systems were
running on an Intel Pentium 4 3.0 GHz with 1 GB of DDR SDRAM,
and were powered by an nVidia 5950 Ultra graphics card. The test
rigs had a 120 GB 7200 rpm SATA hard drive. Windows XP
Professional SP1 was loaded, along with the latest version of
DirectX and other device drivers.

Features: In the Features tests, we looked for value-additions and
other aspects that increased the user-friendliness of a display. The
features noted varied in significance—some were simple, like the
user-friendliness of the OSD (On-Screen Display); some were
important, such as power consumption, depth and weight. One
important thing we looked at was the monitor base, which decides
the tilt the monitor is capable of—the more the better. Some LCDs
can be rotated vertically for both landscape and portrait
orientations. A portrait orientation is especially useful while
reading a long Word file or a PDF document, as it reduces the need
to scroll off a screen. We also rated additional features such as Web
camera, additional inputs such as DVD-D, USB, etc.

Performance: We used the DisplayMate benchmarking software to
gauge the LCD monitors’ performance. This software uses images
to test a monitor for criteria such as Point Shape and Visibility. For
example, this test can be used to determine how accurately the LCD

can display a fine point, and whether or not it is able to retain the
round shape of a dot. 

In the colour and greyscale set of tests, we checked for colour
reproduction, the level-shift problem, and the streaking or ghosting
effect. We ran the 16-intensities and 64-level primary and
secondary colour intensities tests to see how well the monitors
could display shades. 

In the miscellaneous tests within DisplayMate, we checked for
screen uniformity. We also tested the Reverse Video Contrast. The
Pixel Persistence Test was run to check for jerks or image blurring. 

We used the Passmark Monitor Test to check for image
persistence at the edges. This is a measure of the LCD’s
response time.

For the viewable text angle test, we used a protractor placed
in-line with the LCD panel, and the screen was viewed from either
side. A document containing different fonts was viewed from
various angles, letting us determine the angles at which the text
still looked sharp. Similarly, for the viewable movie angle test, we
viewed a movie from various angles and determined the angle at
which discolouration of image began.

Price: We took the price of each monitor into account before
assigning it a final score.

How We Awarded
The features, performance and price scores were given
relevant weightages, and an overall score out of 100 was
calculated.

The product that scored the highest was adjudged
the winner of the Digit Best Buy Gold award for its category,
while the second highest got the Digit Best Buy Silver award.

How We Tested

Samsung
SyncMaster 540N
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Response Times
The response time is the time it
takes for a pixel to change its state
from on to off or from off to on.
These times for LCD monitors have
traditionally been slower than
those of CRTs. The effect of this
can be seen in the form of trails fol-
lowing bright, fast moving objects,
and also leads to blurry images.
This spoils the movie-watching or
gaming experience.

Newer LCDs have a lower
response time, so their pixels
switch much faster—allowing you
to view movies and play games
without the problems that were
previously associated with LCDs.

At 12 ms, the BenQ FP51G had
the fastest response time amongst
the 15-inch LCDs. The ViewSonic
VX922, which is touted as the
world’s “fastest” LCD monitor,
boasted of an incredibly low 6 ms
response time which, using pro-
prietary techniques, they claim to
boost to 2 ms, making it good
enough for any purpose, gaming
included. Similarly, the Asus
PM17TU in the 17-inch category
also claims to achieve a low
response time of 3 ms using a pro-
prietary technique. 8 ms was the
lowest response time in the
remainder of the 17- and 19-inch
monitors. A response time of 8 ms
is fine for watching movies, but
may not be good enough for fast-
paced games.

Dimensions
When you talk about an LCD  mon-
itor, you instantly think of a com-
pact device with sleek
dimensions—so much more attrac-
tive than a bulky CRT monitor!

In the 15-inch category, the
BenQ FP51G had the smallest
dimensions: 330 x 337 x 134.6 mm.
In the 17-inch category, the LG FLA-
TRON L1730S had the smallest
dimensions. The NU L921G had the
lowest dimensions and foo print in
the 19-inch category, making it the
sleekest19-inch panel.

Weight
It’s not often that you change the
physical placement of your mon-
itor. The weight is therefore not
that important as far as a monitor
is concerned. But it is always nice
to have a lighter monitor, isn’t it?
Interestingly though, heavy moni-
tors tend to be steadier on their
feet—more stable on a table.

Of the 15-inch monitors, the
Acer AL1515sm was the lightest at
3 kg, whereas the Samsung Sync-

Master 540N was the heaviest at
4.5 kg. The CMV CT-712A was the
lightest at 3.4kg, while the BenQ
FP72V was the heaviest at 7.5 kg
in the 17-inch category. Amongst
the 19-inch LCDs, the CMV CT-
937A weighed in at just 4.7 kg
which is quite light for a 19-inch
monitor, while the NEC Multi-

Sync LCD1980FXi was the heaviest
of the lot.

Flexibility
Height adjustment allows you to
set the monitor at a level that 
is most comfortable for viewing.
This feature is very useful as 
far as ergonomics and comfort 
is concerned. If the monitor 
does not allow for this, you might
need to adjust the height of your
chair, which is not always possible.

Height adjustment was
entirely absent in the 15-inch cat-
egory. Amongst the 17-inchers, the
BenQ FP72V and the NEC Multi-
Sync monitors supported height
adjustment. In the 19-inch cate-
gory, the Asus PW191 and NEC
MultiSync had this feature.

A few LCDs also have the 
horizontal and vertical swivel
feature, which is an added
bonus. This lets you adjust the
monitor’s angle to suit your com-
fort levels.

All the monitors supported
vertical tilt, a feature missing in
many monitors in our last LCD
test. There were quite a few mon-
itors that also featured hori-
zontal swivel adjustment;
prominent amongst them were
the Asus PW191, the LG 1950SQ
and the NEC MultiSync
LCD1970NXp in the 19-inch cate-
gory. Amongst the 17-inchers, the
NEC MultiSync LCD1770NX and
the NEC MultiSync LCD1770NXm
featured swivel.

Other Features
Most graphics cards today, even
entry-level ones, feature a DVI

interface. DVI provides a pure
digital video signal, and if your

monitor supports the input, then
the necessity of conversion
between analog and digital sig-
nals is eliminated. The result is a
lossless transfer of the video
signal, and the overall image
quality being  better than with
the D-sub interface.

This interface was not found in
any of the 15-inch monitors, but
was featured on a few 17-inchers
and on most of the 19-inch models.

The 17-inch BenQ FP72V also
featured two side-panel speakers
and a USB Web cam on top,
making it a good integrated solu-
tion. The 19-inch Asus PW191 was
the only LCD monitor with
feather-touch controls, but as we
found out, it was difficult to use—
the controls were unresponsive
most of the time. Also, it was dif-
ficult to view the controls in a
moderately lit room with the
monitor turned off.

The NEC AccuSync LCD
1770NXM was the only monitor
that sported a USB hub, providing
a convenient way to connect mul-
tiple input devices to your PC.

Power Consumption
One of the better known pluses
of LCDs is their low power con-
sumption. However, it is also
true that their power require-
ments are often not substan-
tially lower than those of CRTs.
15-inch LCDs need anything
between 25 W and 36 W. 17-

inchers need between 40 W
and 60 W of power, and the

power requirements of 19-inch
LCDs are similar to 17-inch
units. You should check the

BenQ FP51G

NU L511E
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power rating of the LCD you plan
to purchase, and note whether
there is a substantial power
saving to be had with a different
model. This might not make
much of a difference to a home
user, but in an office where a lot
of monitors are deployed, the
power costs will add up and most
certainly make a difference.

In the 15-inch category, the
NEC, NU and Samsung had a
power consumption rating of
25 W each—the lowest in this
group. The Philips 170S had the
lowest power consumption in the
17-inch category. Even amongst
the 19-inchers, the Philips 190V
boasted of the lowest power con-
sumption—34W—closely followed
by the ViewSonic VX922, at 35W.

A Look At Performance
The monitors were tested using
display benchmark utilities—Dis-
playMate Video Edition and the
Passmark monitor test utility,
along with several real-world tests.
These included the viewing angle
test and looking for the ghosting
effect under movies.

Sharpness And 
Resolution
We checked for the sharpness of
images using the Point Shape and
Visibility screen in DisplayMate.
This test displays fine white dots
against a black background. We
observed the screen for pixel
bleeding, and found that most
monitors had some amount of
bleeding at the edge. Bleeding
results in a red, green or blue

tinge at the edge of a pixel dot. We
found the Samsung SyncMaster
740N in the 17-inch category the
best in this test. 

In the video bandwidth test, a
fine white line is drawn on a black
background. This test is used to see
how accurately the lines are
drawn, and whether there are any
discrepancies in their geometry or
characteristics.

In the 15-inch category, the
Gigabyte GD-1503B displayed blue
tinges running across the length
of the line at the edge. This was
also the case with the NEC Accu-
Sync LCD72V under the 17-inch
category and the NU L921G and
the NEC MultiSync LCD1970NXp
in the 19-inch category. This test is
important for people who use
imaging software, where accurate
reproduction of finer elements is
of prime importance.

The Samsung SyncMaster 540N
in the 15-inch category, the Sam-
sung SyncMaster 740N in the 17-
inch category and the BenQ FP91V
in the 19-inch category were found
to be the best in their class. We
must stress that we did not find

BenQ FP72V

This year we have seen remarkable
improvements in the design of TFT-LCD

monitors. Dual-toned, double-hinged,
adjustable heights, pivots and touch
sensors, were some of the features we
encountered in this comparison test. 

Along with performance and features
it is important to consider appearance and
build quality. Since beauty lies in the eye
of the beholder, you can get an idea about
the “looks” of every monitor we tested
from the thumbnails placed under our
comparison table. As for their build
quality, you have to actually see one to
best judge it. Some models paid attention
to such design aspects and some of them
were just plain, and there is thus nothing
better than touching and feeling a unit
personally. Let’s take a look at the striking
models in each category.

15-inch
There was very little variance in
appearance under the 15-inch banner.
Most of the models were the generic single
hinge type, meant for tilting the monitor
screen about the horizontal axis, with a
simple black-silver colour combination.
The LG Flatron L1520B stood out as the
better-looking 15-inch monitor with its
aesthetic design. The heavy, steel circular
base assured that the monitor stayed put
on the desk. The NEC AccuSync LCD52V

was the only single-tone (dark grey) LCD
monitor in the lot.

17-inch and 19-inch
This is where all the masala was to be
found. Many of the design features, such
as double-hinge and pivot, were common
to both 17- and 19-inch displays; as such,
we have clubbed these together.

BenQ, with its FP72V 17-inch unit,
steals the limelight in its category. Its
combination of ivory-white and grey
exteriors along with speakers, a double-
hinge mechanism and an integrated Web
cam make it the most stylish monitor in
its class. 

None of the other 17-inch monitors
had a double-hinge like the BenQ FP72V,
but they differed in styling. For example,
the New Universe (NU) monitors had a thin
metal border as the frame to its screen,
and others such as Acer, Gigabyte and LG
retained the slim, bezel appearance. The
Asus PM17TU sported a glossy or mirror-
finish on its front face.

At first glance, you can easily pick
apart the Asus PW191 from its 19-inch
brethren. Its black piano-finish casing,
enclosing the touch sensor panel, and its
WXGA widescreen was very striking
indeed. Its heavy base and stand made
up of aluminium exemplifies superb
build quality. Thanks to a pivot head

located at the back of its screen, you can
rotate it by 90-degrees to portrait mode.
If you are impressed by the description
so far, we advice you to read our full
review as appearance is only the first
impression.

The Acer AL1916W and the CMV CT-
937A were other 19-inch widescreen
monitors. The latter has a design that
resembles the Nokia 7610 mobile phone
with one sharp corner and the other
rounded. We also liked the ViewSonic
VX922 for its simple yet classy design.

Usually, the stand is made up of
double-hinge (such as the one found in
the Asus PW191 and the BenQ FP72V) by
which the screen of the monitor can be
moved up and down as a height
adjustment feature. But NEC engineers
have intelligently managed space by
employing adjustable height without the
use of second hinge. Two concentric
rectangular box form the stand of the
screen. The outer box moves up and
down while the inner one is fixed to the
base of the stand. A click is heard when
the maximum height is reached. A user
can choose any height between the
maximum and minimum, and the screen
will rest in that position until forcefully
moved. Apart from this unique feature,
the NEC monitors were plain-looking,
with a dark-grey exterior.

Looks Matter



too much difference between the
monitors in this test.

Ghosting
Ghosting, or streaking, is a major
drawback of LCD monitors. It typ-
ically occurs during fast-moving
scenes in movies, or while playing
fast-paced games. This puts a
strain on the eyes. 

To check for ghosting, we ran
four different ghosting screens in
DisplayMate, and found that most
monitors returned good results,
with the exception of the Gigabyte 
GD-1503B, the NU L511E and 
the Samsung SyncMaster 540N in
the 15-inch category, as  also the
NU QL-711V in the 17-inch cate-
gory, which displayed a higher
amount of streaking in the colour
streaking test. 

We also ran an additional test
that involved watching a movie
clip that showed fast-moving
objects, in order to confirm our
observations.

Level Shift
In this test, we looked for white
and black level shifts, which
happen when two adjacent areas
differ greatly in contrast. This
results in the spillage of the dark
colour into the adjacent white
area. In this test, most of the LCDs
fared well with very little shift vis-
ible. Level shift was not noticeable
in any of the LCDs at any kind of
alarming levels. Level shift, if
high, can be a big problem in Pho-
toshop-like applications, where
there are often light and dark
areas adjacent to each other.

Text-Colour Combination
Here, we checked for how the
monitors reproduced coloured
fonts on backgrounds of different
colours. LCDs have red, green and

blue sub-pixels that make up a
pixel. When coloured text, say
magenta, is displayed on a grey
background, you can easily iden-
tify the black space between two
magenta dots, making the font
look serrated. We checked for the
readability of the text and also if
the surrounding colour spills off
the text.

Of the 15-inchers, the Gigabyte
GD-1503B returned the worst
results—it showed colour spillage
problems with fonts of almost
every colour. The NEC AccuSync
LCD52V returned the best scores
in this category. In the 17-inch cat-
egory, the CMV and Intex moni-
tors were the worst performers,
whereas others that performed
better were almost on par. There
were not many variations in the
LCDs in the 19-inch category—they
all did well.

Intensity Levels
In this set of tests, we looked for
how well the LCD monitors could
display 16, 64 and 256 shades of
grey. Most LCD monitors cannot
display more than 64 shades cor-
rectly; as such, the 64-intensities
test with secondary colours and
the 256-intensities tests are espe-
cially important. 

In this, contrast and bright-
ness play an important role—an
overly bright screen will not dis-
play shades of grey in the light
region, and a dark screen will
merge shades on the darker side.
We found that in the 15-inch cate-
gory, the BenQ, Gigabyte and the
LG fared better than the others. In

the 17-inch category, both
the BenQs, the LG, the Philips

and all the NEC monitors were
found to excel under this test,
indicating that these had a
better contrast ratio.
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Scoreboard                             15-Inch LCD Monitors

Low price
Low viewing angles

Good performance
None in particular

Low price
Below-average 
performance

APRIL 2006

Good viewing 
angles
Average 
performer

Good build quality
Expensive

Low price
Below-average 
build quality

APRIL 2006

BRAND
MODEL
Features
Pixel Size (mm)
Luminance (cd/m2)
Contrast Ratio
Maximum Resolution (H. Pixels x V. Pixels)
Screen Aspect Ratio (Normal/Wide)
Response Time (ms)
W x H x D (mm)
Weight (kg)
USB Hub (Y/N) / Number Of Ports
Inbuilt Speakers (Y/N) / Watts
VESA Wall Mount
Swivel Base Vertical / Horizontal Axis (Y/N)
Height Adjustment (Y/N)
Portrait Mode (Y/N)
Power Consumption (Watts)
Input Interfaces
Extra Features If Any (Web Cam Etc.)
Performance
Displaymate Video Edition  (So5)
Sharpness And Resolution
Point Shape And Visibility
Video Bandwidth Test
Colour And Greyscale
Streaking And Ghosting
Bar Streaking
Colour Streaking
Mid-Range Streaking
White-Level Shift
Black-Level Shift
RGB Purity
Text Colour Combination
16-Intensities Levels
64-Intensity For Primary Colours
64-Intensity For Secondary Colours
256-Intensities Level
Colour Scales
Miscellaneous Tests
Reverse Video Contrast
Screen Uniformity
Passmark Monitor Test
Pixel Persistance Test (So5)
Miscellaneous Tests
Viewable Angle Test (Text) (Degrees)
Viewable Angle Test (Movie) (Degrees)
OSD Usability Test (So5)
Price Index
Price (Rs)
Overall Score

Acer
AL1515 sm
15.65
0.297
250
450:1
1024 x 768
Normal
16
345 x 353 x 160
3
6

4

4

4/6
6

6

30
D-Sub
None
45.09

3.75
3.5

3.75
3.75
3.75
4
4
3.5
4
3.25
4.5
3.5
3.5
3.5
3.5

3.5
3.5

2

150
115
4
13.35
9,999
74.09

BenQ
FP51G
15.71
0.297
250
450:1
1024 x 768
Normal
12
330 x 337 x 134.6
3.8
6

4

4

4/6
6

6

30
D-Sub
None
47.00

4
3.5

3.75
3.5
3.5
3.5
3.5
3.75
4.25
3.5
5
3.5
3.75
4.5
4.5

4
4

2

155
125
4
13.48
9,900
76.20

Gigabyte
GD-1503BP
15.06
0.297
250
450:1
1024 x 768
Normal
16
408 x 400 x 140
3.3
6

4

4

4/6
6

6

36
D-Sub
None
44.09

3.75
3

3.5
3
3
3.25
3.25
3.75
4.25
2.5
5
3.25
3.5
4.5
4.5

4
4

1.5

155
120
3.5
15.00
8,900
74.15

LG
FLATRON L1520B
14.60
0.3
250
400:1
1024 x 768
Normal
25
363.8 x 330.7 x 220
3.2
6

6

4

4/6
6

6

28
D-Sub
None
44.74

3.5
4

3
3
3
3.5
3.5
3.5
4.5
3
5
3.5
4
3.75
3.5

4
4.5

2

160
130
4
12.71
10,500
72.05

NEC
AccuSync LCD52V
15.24
0.297
250
400:1
1024 x 768
Normal
25
344.6 x 352.7 x 165
3.3
6

4

4

4/6
6

6

25
D-Sub
None
46.22

3.75
3.75

4
4
3.75
4
3.75
3.75
4.5
4
3.5
3.5
3.25
3.75
3.5

3.75
4

2

155
125
4
10.60
12,600
72.06

NU
L511E
16.28
0.297
300
500:1
1024 x 768
Normal
25
366 x 357 x 163
3.2
6

6

4

4/6
6

6

25
D-Sub
None
45.89

3.5
4

3.75
3.75
3.75
3.75
3.75
3.75
4.25
3.5
4.5
3.5
3.75
3.75
3.75

3.75
4

1.5

155
120
4
13.35
9,999
75.52
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Almost all the 19-inch moni-
tors performed very well in this
test. If a monitor performs below
satisfaction in this test, the user
will need to manually calibrate
the monitor for contrast and
brightness rather than relying on
the auto setting.

Screen Uniformity And
Reverse Video Contrast
In the Screen Uniformity test, a
grey screen was used to check for
odd colour patches, if any. In the
Reverse Video Contrast test,
coloured text on white and two
different shades of grey was used.
Most of the monitors in all the cat-
egories did just fine in this test.
The exception was the NEC Accu-
Sync LCD72V, which had many
bad patches.

Passmark Monitor Test
We used the LCD pixel persistence
test in the Passmark monitor test
to check for the pixel persistence
problem with the panels. In this
test, a bright white block moves at
various speeds across the monitor,
ranging from 100 pixels/second to
800 pixels/second. The entire set
of monitors in both categories
failed to display even the slowest
moving block without persist-
ence—all of them therefore scored
very low.

Our test results lead us to
believe that none of the LCDs are
at a stage where they could be con-
sidered good for games or movies.
If you’re into gaming, you’re
better off with a CRT. If you want
to watch movies on an LCD panel,
don’t expect an exceptional
viewing experience. For this
reason, we also watched a movie
clip with fast moving scenes to
better judge the pixel persistence.

Viewable Angle Test
Here, we used a text screen in Dis-
playMate, and a movie scene, to
find the maximum viewing angle
of each monitor. In the movie test,
we looked for the point at which
the centre of the screen just begins
to get discoloured whereas in the
text angle, we looked for the angle
at which the text is just readable. 

The LG FLATRON L1520B (15-
inch), CMV CT-712A and LG FLA-
TRON L1730S (17-inch) and BenQ
FP91V, CMV CT-937A, LG FLATRON
L1950SQ and NEC MultiSync
LCD1980FXi (19-inch) returned the
highest results in this test. 

Of these, the NEC MultiSync
LCD1980FXi was seen to have the
highest movie viewing angle of
150 degrees, which is the highest
we have seen—significantly more
than its closest competitor at 135
degrees. We could not find any
discolouration of the
screen at all, even past
this angle. Most panels
returned a higher viewing
angle in text mode—this
was because of the bright

background. They suffered in the
movie test because the movie was
a mix of bright outdoors and
dimly-lit indoors scenes.

And The Winner Is…..
Thus far, we have compared the
features and performance of LCD
monitors. But there is one more
criterion that decides the win-
ners—price. And so, here’s our
final tally!

15-INCH LCD MONITORS
The BenQ FP51G had a good con-
trast ratio and brightness and was
also the fastest LCD in this class
with a rated response time of just
12ms. It was also the second-best
performer in the category. It retails
at just Rs 9,900, second only to the
Gigabyte GD-1503B. Its lower price
and overall good performance and
features made the BenQ FP51G the
Digit Best Buy Gold winner.

The NU L511E topped the fea-
tures score because of better fea-
tures such as its high contrast ratio
and brightness. It was one of the
lighter LCDs, weighing just 3.2kg.
Though an average performer, its
low price of Rs 9,999 makes it the
Digit Best Buy Silver winner in the
15-inch category.

17-INCH LCD MONITORS
The BenQ FP72V scored the highest
in Features, but it was also priced
much higher, at Rs 23,900.

The NU QL-711V had low power
consumption, a good contrast
ratio, and a good brightness rating.
But it scored average in Features
and Performance. However, with a

rock-bottom price of just
Rs 11,970, the NU QL-

711V secured the Digit
Best Buy Gold.

The Philips 170S scored
high in Performance

APRIL 2006

APRIL 2006

NU L921G

Asus PW191

Sharp images
Expensive

Samsung
SyncMaster 540N
16.11
0.297
250
500:1
1024 x 768
Normal
16
337.5 x 264.5 x 160.2
3.65
6

6

4

4/6
6

6

25
D-Sub
None
47.14

4
4

4
3.75
3.75
3.75
3.75
3.75
4.5
3.75
4.5
3.75
3.75
4
4.25

3.5
3.75

1.5

155
130
4.5
12.14
11,000
75.38
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Scoreboard                             17-Inch LCD Monitors

Low price
None in particular

High luminance, 
contrast ratio 
Expensive

Above average 
image quality and 
performance
None in particular

Good performance, 
features and looks
Expensive

Low price
Higher power con
sumption

BRAND
MODEL
Features
Pixel Size (mm)
Luminance (cd/m2)
Contrast Ratio
Maximum  Resolution (H. Pixels x V. Pixels)
Screen Aspect Ratio (Normal/Wide)
Response Time (ms)
W x H x D (mm)
Weight (kg)
USB Hub (Y/N) / Number Of Ports
Built-in Speakers (Y/N) / Watts
VESA Wall Mount
Swivel Base Vertical / Horizontal Axis (Y/N)
Height Adjustment (Y/N)
Portrait Mode (Y/N)
Power Consumption (Watts)
Input Interfaces
Extra Features If Any (Web Cam Etc.)
Performance
Displaymate Video Edition (So5)
Sharpness And Resolution
Point Shape And Visibility
Video Bandwidth Test
Colour And Greyscale
Streaking And Ghosting
Bar Streaking
Colour Streaking
Mid-Range Streaking
White-Level Shift
Black-Level Shift
RGB Purity
Text Colour Combination
16-Intensities Levels
64-Intensity For Primary Colours
64-Intensity For Secondary Colours
256-Intensities Level
Colour Scales
Miscellaneous Tests
Reverse Video Contrast
Screen Uniformity
Passmark Monitor Test
Pixel Persistance Test (So5)
Miscellaneous Tests
Viewable Angle Test (Text) (Degrees)
Viewable Angle Test (Movie) (Degrees)
OSD Usability Test (So5)
Price Index
Price (Rs)
Overall Score

Acer
AL1717
14.21
0.264
300
500:1
1280 x 1024
Normal
12
377 x 393 x 182
4.6
6

4

4

4/6
6

6

40
D-Sub
None
46.22

3.75
4

4
3.75
3.5
3.75
4
3.75
4.5
3.75
4.25
3.5
3.5
3.25
3.5

3.75
4

2

155
115
4
13.81
12,999
74.25

Asus
PM17TU
15.71
0.264
500
600:1
1280 x 1024
Normal
8
390 x 416 x 180
4.5
6

4

4

4/6
6

6

48
D-Sub, DVI-D
None
45.72

4
3.75

3.75
3.75
4
4
4
3.75
4.5
3.5
4
3.5
3.5
3
4

3.75
4

2

155
135
3.5
8.76
20,500
70.19

BenQ
FP71E+
14.22
0.264
300
500:1
1280 x 1024
Normal
8
385.8x375.4x201.2
4.69
6

4

4

4/6
6

6

50
D-Sub, DVI-D
None
46.61

3.75
4

4
3.75
3.5
3.75
4
3.75
4.5
3.25
5
3.5
3.75
3.25
3.75

3.75
4.25

2.25

155
125
3.5
12.38
14,500
73.22

BenQ
FP72V
15.27
0.264
280
1000:1
1280 x 1024
Normal
25
502 x 452.1 x 230
7.5
6

4

4

4/6
4

6

60
D-Sub, DVI-D
Web Cam
47.37

4
3.75

3.75
3.75
4
3.75
4
4
4.5
3.75
5
3.75
4
3.25
4.5

3.75
4

2.25

160
145
4
7.51
23,900
70.16

CMV
CT-712A
14.66
0.264
400
500:1
1280 x 1024
Normal
8
395 x 414 x 208
3.4
6

4

4

4/6
6

6

51
D-Sub
None
44.61

4.25
3.5

3.5
3
3.25
4
3.5
3.75
4.5
2.75
4
3
3
3.5
3.75

4.25
3.75

2.25

150
125
4.25
13.81
13,000
73.08
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None in particular
Below average build 
quality, above average 
price

Low power 
consumption
Expensivequality, 
above average price

Good performance
Slow response time

Low power 
consumption
Above average price

Good performance
Expensive

Good performance
Expensive

Gigabyte
GD-1703BP
13.93
0.264
280
500:1
1280 x 1024
Normal
10
445 x 455 x 135
4.8
6

4

4

4/6
6

6

48
D-Sub
None
45.17

4.25
3.75

4
3.5
3.25
4
4
3.75
4.5
3.25
3.5
3.5
3.5
3.5
3.25

4
4

2

155
125
3.5
11.23
15,990
70.34

iNTEX
IT-1703
14.43
0.264
300
500:1
1280 x 1024
Normal
12
400 x 410 x 200
4.2
6

4

4

4/6
6

6

35
D-Sub
None
44.64

4.25
4

4
3.75
4
3.5
3.75
3.5
4.5
2.5
4
3.25
3.25
3.25
3.75

3.75
3.75

2

155
135
3.75
8.55
21,000
67.62

LG
FLATRON L1730S
12.81
0.264
250
400:1
1280 x 1024
Normal
25
356 x 360 x 152
4
6

6

4

4/6
6

6

40
D-Sub
None
47.40

4
4

4
3.75
4
4
4
4
4.5
3.25
5
3.5
3.5
3.5
3.5

3.75
4.5

2.25

160
135
3.75
12.83
14,000
73.03

NEC
AccuSync LCD72V
14.78
0.264
250
450:1
1280 x 1024
Normal
8
375.4 x 389 x 180
4.6
6

4

4

4/6
6

6

34
D-Sub, USB
None
43.88

3.5
4

3.75
3.75
3.75
4
3.75
3.75
2
3.25
5
3.75
3.75
3.75
4

4
2

2

155
120
4
11.60
15,480
70.26

NEC
MultiSync LCD1770NX
15.70
0.264
250
500:1
1280 x 1024
Normal
8
365.7 x 363.2 x 198.2
6
4/2
6

4

4/4
4

6

48
D-Sub, DVI-D
None
47.61

4.25
4.25

4
4
4
4
4
4
4.5
3.5
5
3.5
3.75
3.75
4

3.75
3.75

2.25

150
125
4.5
9.07
19,800
72.38

NEC
MultiSync LCD1770NXM
14.66
0.264
250
500:1
1280 x 1024
Normal
8
365.7 x 363.2 x 198.2
6.5
6

6

4

4/4
4

6

55
D-Sub, DVI-D
USB Hub
48.45

4
4.25

4
3.75
3.75
4
4
4
4.5
3.75
5
3.25
3.25
3.5
3.75

4
4

2.25

150
120
4.5
8.31
21,600
71.42
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Scoreboard                             17-Inch LCD Monitors

Very low price
Below-average build
quality

Good performance, 
low power consumption
None in particular

Sharp image quality
None in particular

APRIL 2006

Good performance 
Pricey

APRIL 2006

BRAND
MODEL
Features
Pixel Size (mm)
Luminance (cd/m2)
Contrast Ratio
Maximum  Resolution (H. Pixels x V. Pixels)
Screen Aspect Ratio (Normal/Wide)
Response Time (ms)
W x H x D (mm)
Weight (kg)
USB Hub (Y/N) / Number Of Ports
Inbuilt Speakers (Y/N)/Watts
VESA Wall Mount
Swivel Base Vertical / Horizontal Axis (Y/N)
Height Adjustment (Y/N)
Portrait Mode (Y/N)
Power Consumption (Watts)
Input Interfaces
Extra Features If Any (Web Cam Etc.)
Performance
Displaymate Video Edition (So5)
Sharpness And Resolution
Point Shape And Visibility
Video Bandwidth Test
Colour And Greyscale
Streaking And Ghosting
Bar Streaking
Colour Streaking
Mid-Range Streaking
White-Level Shift
Black-Level Shift
RGB Purity
Text Colour Combination
16-Intensities Levels
64-Intensity For Primary Colours
64-Intensity For Secondary Colours
256-Intensities Level
Colour Scales
Miscellaneous Tests
Reverse Video Contrast
Screen Uniformity
Passmark Monitor Test
Pixel Persistance Test (So5)
Miscellaneous Tests
Viewable Angle Test (Text) (Degrees)
Viewable Angle Test (Movie) (Degrees)
OSD Usability Test (So5)
Price Index
Price (Rs)
Overall Score

NU
QL-711V
14.52
0.264
320
500:1
1280 x 1024
Normal
16
398.8 x 403.8 x 190.5
4
6

4

4

4/6
6

6

35
D-Sub
None
46.56

4.25
3.75

4
3.75
4
3.75
3.5
3.5
4.5
3.25
4.25
3.5
3.75
3.5
4

3.75
4

1.5

150
115
3.75
15.00
11,970
76.08

Philips
170S
13.70
0.264
250
500:1
1280 x 1024
Normal
12
375 x 390 x 200
4
6

6

4

4/6
6

6

30
D-Sub
None
48.24

4
4

4
3.75
4
4
4
3.75
4.5
3.75
5
3.5
3.75
3.5
4

4
4

2.25

150
120
3.75
12.83
14,000
74.76

Samsung
SyncMaster 740N
13.71
0.264
300
600:1
1280 x 1024
Normal
8
366 x 391.2 x 200
4.7
6

6

4

4/6
6

6

34
D-Sub
None
46.97

4.5
3.75

4
3.75
3.5
3.75
4
3.75
4.5
3.25
4.5
3.75
3.75
3.5
3.75

3.75
4

2

155
120
4.5
12.64
14,200
73.32

ViewSonic
VA712
14.64
0.264
350
350:1
1280 x 1024
Normal
8
386 x 411 x 177
4.3
6

4

4

4/6
6

6

42
D-Sub, DVI-D
None
47.12

3.75
4.25

4
3.5
3.75
4
4
3.5
4.5
3.5
4
3.25
3.25
3.5
3.75

4.25
4

2

155
120
4.25
11.22
15,999
72.98
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Scoreboard                             19-Inch LCD Monitors

Sharp image quality
Expensive

Wide-screen 
Below-average build 
quality

Good performance 
None in particular

APRIL 2006

BRAND
MODEL
Features
Pixel Size (mm)
Luminance (cd/m2)
Contrast Ratio
Maximum  Resolution (H. Pixels x V. Pixels)
Screen Aspect Ratio (Normal/Wide)
Response Time (ms)
W x H x D (mm)
Weight (kg)
USB Hub (Y/N) / Number Of Ports
Inbuilt Speakers (Y/N) / Watts
VESA Wall Mount
Swivel Base Vertical / Horizontal Axis (Y/N)
Height Adjustment (Y/N)
Portrait Mode (Y/N)
Power Consumption (Watts)
Input Interfaces
Extra Features If Any (Web Cam Etc.)
Performance
Displaymate Video Edition (So5)
Sharpness And Resolution
Point Shape And Visibility
Video Bandwidth Test
Colour And Greyscale
Streaking And Ghosting
Bar Streaking
Colour Streaking
Mid-Range Streaking
White-Level Shift
Black-Level Shift
RGB Purity
Text Colour Combination
16-Intensities Levels
64-Intensity For Primary Colours
64-Intensity For Secondary Colours
256-Intensities Level
Colour Scales
Miscellaneous Tests
Reverse Video Contrast
Screen Uniformity
Passmark Monitor Test
Pixel Persistance Test (So5)
Miscellaneous Tests
Viewable Angle Test (Text) (Degrees)
Viewable Angle Test (Movie) (Degrees)
OSD Usability Test (So5)
Price Index
Price (Rs)
Overall Score

Acer
AL1916W
15.01
0.294
300
700:1
1440 x 900
Wide
8
422 x 433 x 176
5
6

6

4

4/6
6

6

60
D-Sub
None
46.98

4
4.25

3.75
3.5
3.75
4
4
4
4
3.5
5
4
4.25
3.5
4.25

3.75
3.75

2.25

150
120
3.75
13.50
19,999
75.49

Asus
PW191
19.74
0.285
300
600:1
1440 x 900
Wide
8
520 x 490 x 280
8.5
6

4

4

4/4
4

4

48
D-Sub, DVI-D
Feather-Touch Controls
46.80

4
3.75

3.75
3.75
3.75
3.75
4
3.75
4.5
3.25
5
3.75
4
4
4

3.5
4

2

150
125
3
9.31
29,000
75.85

BenQ
FP91V 
14.40
0.264
270
550:1
1280 x 1024
Normal
12
410.8 x 419.3 x 215.4
6
6

4

4

4/6
6

6

60
D-Sub, DVI-D
None
46.05

4
4

3.75
3.75
3.5
3.75
4
3.75
4.5
3
5
3.5
3.75
3.75
4

3.5
4

2

160
130
3.75
11.25
24,000
71.71

CMV
CT-937A
16.26
0.285
330
600:1
1440 x 900
Wide
8
469 x 368 x 189
4.7
6

4

4

4/6
6

6

43
D-Sub
None
45.26

2
2

3
2.75
3
3
3.5
3.5
4.5
3.5
4.25
3.75
3.75
3.25
3.5

4.25
4.25

2.5

160
135
4.5
13.50
20,000
75.02

LG
FLATRON L1950SQ
14.32
0.294
250
500:1
1280 x 1024
Normal
8
420 x 412 x 230
5.7
6

6

4

4/4
6

6

43
D-Sub, DVI-D
None
47.28

3.75
4

3.75
3.75
4
3.75
4
3.75
4.5
3.75
5
3.75
3.75
3.5
3.5

3.75
4.25

2

160
130
3.75
12.27
22,000
73.88

Wide-screen, good 
performance
None in particular

Stylish looks, portrait
mode
Expensive
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Low power consumption
Expensive

Good features, low 
power consumption
Expensive

Good viewing 
angles, portrait mode
Very expensive

Low price, good 
viewing angles
Below-average build 
quality

Low power 
consumption
Expensive, no 
DVI-D input

Good viewing angles
Expensive

NEC
AccuSync LCD92V
13.62
0.294
250
450:1
1280 x 1024
Normal
8
418 x 427.8 x 199.5
6.5
6

6

4

4/6
6

6

40
D-Sub, DVI-D
None
46.94

3.75
4

3.75
3.75
3.75
4
3.75
3.75
4.5
3.5
5
3.5
3.75
3.75
4

3.75
3.75

2

155
120
4
11.54
23,400
72.10

NEC
MultiSync LCD1970NXp
16.78
0.294
250
800:1
1280 x 1024
Normal
20
412.5 x 386.5 x220
8
6

6

4

4/4
4

6

38
D-Sub, DVI-D
None
46.77

3.5
4

3.75
3.75
4
3.75
3.5
3.75
4.5
3.75
4.5
3.5
3.75
3.75
3.75

4
3.75

2

155
130
4.25
10.00
27,000
73.55

NEC
MultiSync LCD1980FXi
16.85
0.294
270
600:1
1280 x 1024
Normal
18
402.3 x 361.5 x 200
9.7
6

4

4

4/6
4

4

48
D-Sub, 2xDVI-D In
None
46.58

3.75
4

3.75
3.75
3.75
3.75
3.75
3.75
4.5
3.75
5
3.75
3.75
4
3.75

3.75
4

2

160
150
4.25
4.29
63,000
67.72

NU
L921G
16.00
0.294
320
600:1
1280 x 1024
Normal
12
448 x 447 x 193
5.3
N
4

4

4/6
6

6

50
D-Sub, DVI-D
None
46.52

3.5
3.5

3.75
3.75
4
3.75
4
3.5
4.5
3
5
3.5
3.75
4
4.25

3.75
4

2

155
135
3.75
15.00
18,000
77.52

Philips
190V
14.11
0.294
240
500:1
1280 x 1024
Normal
8
425 x 419 x 235
5.4
6

6

4

4/6
6

6

34
D-Sub
None
46.43

3.75
4.25

3.75
3.75
3.75
3.75
3.75
3.75
4.5
3
4.5
4
4.25
4
4.25

4.25
4

2.25

155
125
3.5
10.80
25,000
71.34

ViewSonic
VX922
17.16
0.294
270
650:1
1280 x 1024
Normal
6
431 x 370 x 66
6.7
6

4

4

4/6
6

6

35
D-Sub, DVI-D
None
46.17

3.75
4.25

4
3.75
4
3.75
4
3.75
4.5
3
4
3.25
3.25
3.5
4

4
3.75

2.25

155
130
4.25
10.80
24,999
74.14
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because of its overall better image
quality. It was priced at Rs 14,000,
which is just below the average
price of a 17-inch monitor. The
Philips 170S was awarded the Digit
Best Buy Silver.

19-INCH LCD MONITORS
We found the NEC monitors to be
a world apart from the others, due
to their better features and quality.
But they were also priced exorbi-
tantly high, and remain beyond
the reach of most.

The NU L921G had high bright-
ness and contrast ratios, and a low
response time, while weighing just

5.3 kg, scored good points under
Features. It also fared well as far as
performance was concerned. The
low price tag of Rs 18,000 was the
deciding factor in adjudging the
NU L921G the winner of the Digit
Best Buy Gold in the 19-inch LCD
monitor category.

The Asus PW191 was in a class
of its own with its wide-screen
aspect ratio and unique looks. It
scored the highest points in Fea-
tures. We also found it to be a
good performer. But with its
heavy price tag of Rs 29,000, it
had to settle for the Digit Best
Buy Silver.

In Conclusion
We’d like to confess that we had
initially planned to carry out two
separate shootouts of both LCD
monitors and CRTs, but we were
surprised at the very low turnout
of CRTs. Manufacturers told us
they are pushing for sales of LCDs
over CRTs, hence the low turnout.

The wisdom behind this deci-
sion is debatable. If you recall our
last LCD shootout, you would
realise that the prices have not
plummeted as much as we had
hoped they would, and India is a
price-sensitive market. People will
still want to buy CRTs.

If you have noticed, there were
many more 17- and 19-inch moni-
tors than 15-inch ones. To us, it
seems like manufacturers are bent
on dictating purchasing terms.

We can only hope for a signifi-
cant drop in LCD prices the next
time round. Better technology
should also bring in better
response times. The transition
from CRTs to LCDs would then be
more likely. 

jayesh_limaye@thinkdigit.com  
anup_nair@thinkdigit.com

Luminance (Brightness): An LCD can be
made brighter by increasing the
brightness of the backlight. In the case of
a CRT, an increase in brightness also
increases the beam spot size; this lowers
the effective resolution, yielding a fuzzy
image.

Flickerless: An LCD display does not
flicker. In a CRT, an electron beam scans
the phosphor screen in horizontal lines
from top to bottom and this illuminates
the screen. This must be done fast enough
for the eye to not notice a flicker, which is
not always achievable. The LCD has a
constant source of light over the whole
screen which means that once a pixel is
on, it stays on until turned off, and
vice-versa.

Crisp And Sharp Image: For a CRT
screen, the electron beam is circular
when aimed directly forward, but it
becomes elliptical when aimed at any
other direction. This may cause
image clarity or focus issues at the
screen edge.

An LCD has millions of pixels hard-
etched onto the panel, each effectively
independent from its neighbour. With no
scanning electron beam, distortion is not
an issue. Therefore, the image always
appears crisp over the entire screen.

Perfect Geometry: LCD monitors provide
geometrically-perfect and distortion-free
images, which is a huge advantage for
graphics artists and designers.

Longer Life: The life of an LCD depends
on the life of the backlight, which is
composed of one or more tiny fluorescent
tubes. The typical life of a backlight is
stated to be around 50,000 hours to the
half-brightness point, which is the point at
which brightness is one-half the original
brightness. This is the industry standard
measure for product life.

In case of a CRT, the age depends on
the formation of oxide layer on the
cathode of the electron gun, which
decreases beam current. Also, the
phosphor ages and becomes less efficient
over a period. The typical CRT half-
brightness point has been found to be
between 10,000 and 20,000 hours.

Power Consumption: The power required
to run an LCD is about one-half to one-
third of that required for a CRT with the
same screen area. In addition to this,
LCDs generate considerably less heat than
CRT monitors because of the
technological difference. This indirectly
leads to a lower load on air conditioning,
thus reducing running costs. Similarly, the
lower power requirements of an LCD

monitor make it easier to be used with an
uninterruptible power supply, because the
lower power required provides precious
extra minutes to save important data
and shut down the PC in the event of
a power outage.

Low Emissions: A CRT monitor can
generate electric, magnetic and even
X-ray emissions due to the high-voltage
power supply necessary to drive the CRT
and the electron beam striking the
phosphor screen. An LCD has no such
issues because of the different technology.

Better Ergonomics: LCD monitors are
smaller, more compact and lighter when
compared to CRTs. Thus, they take up less
precious desktop space. They can fit in
locations where bulky CRTs just cannot.
Those with VESA mounting can even be
mounted on the wall. Some LCDs also
have pivots to rotate horizontally,
vertically and even from landscape to
portrait mode, which makes them
more versatile.

Total Cost Of Ownership: The prices of
LCD monitors have been decreasing in
recent years. When calculated, one can
imagine the power-saving features of
LCDs reducing the total cost of ownership
over a period of a few years.

The Advantages Of An LCD Monitor

Phone Web SiteCompany E-mailBrand

Contact Sheet LCD Monitors

Acer
Asus
BenQ
CMV
Gigabyte
Intex
LG
NEC
NU
Philips
Samsung
ViewSonic

Acer India Pvt Ltd
ASUSTek Computer Inc
BenQ India Pvt Ltd
Cee Vision Technologies P Ltd
Gigabyte Technology (I) Ltd
Intex Technology (I) Ltd
LG Electronics India P Ltd
Shiba Comp P Ltd
Shiba Comp P Ltd
Philips Electronics India Ltd
Samsung India Electronics P Ltd 
Roop Technology Pvt Ltd

080-25213520
022-40058923
022-25705230
022-26733353
022-2652669
011-41610224
0120-2560900
011-26413437
011-26413437
022-56912000
011-41511234
022-26681921

rajesh_aiyar@acer.co.in
mamta_bhatia@asus.com.tw
kamlesh.salunke@benq.com
mumbai@chemoplast.com
sales@gigabyte.in
info@intextechnologies.com
response@lgezbuy.com
shiba@del2.vsnl.net.in
shiba@del2.vsnl.net.in
pcp.india.info@philips.com
vineet.kanaujia@samsung.com
roop@vsnl.com

www.acer.co.in
in.asus.com
www.benq.co.in
www.cmv.com.tw 
www.gigabyte.in
www.intextechnologies.com
www.lgezbuy.com
www.nec.com
www.nu-global.com
www.india.philips.com
www.samsungindia.com
www.viewsonic.com
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Digital Tools l Know More About

Ram Mohan Rao

Everyone has encountered
PDF files, and in all probabil-
ity, you have Adobe Reader

installed. Reader often urges you,
on the top right of the screen, to
get the full version of Acrobat. So
what can you do with Acrobat
apart from just converting docu-
ments to PDF? Actually, there’s so
much you can, it would require a
tome to tell you. Here, we’re just
giving you a flavour for the variety
of functions Acrobat is capable of.

Capturing Content
Combining elements from differ-
ent sources to create organised,
searchable documents is one thing
Acrobat can do for you, but that
doesn’t even scratch the surface.

A first example of how you
can use Acrobat is Web capture.
When you convert a Web page to
PDF—simply by going to Create
PDF > From Web Page—you
supply the Web page address,
and specify various parameters,
including how deep (in terms of
levels) you want to go. Acrobat
will faithfully create a PDF of the
site, with all images and links
intact and in place. What’s really
cool is that each page header gets
a convenient bookmark. And you
can nest the bookmarks accord-
ing to your convenience.

Want to move towards an
office that uses less paper? OCR
all your documents by going to
Create PDF > From Scanner, and
build up a collection of search-
able documents. The OCR is rea-
sonably accurate, and suspect
words can be incorporated as
bitmaps without being OCRed!
And there are plenty of options
under “Image Settings,” which
let you tailor the capture accord-
ing to the type and quality of doc-
uments being OCRed.

You can capture in two
modes—”searchable image” and
“formatted text in graphics.” The
former is an image file of the doc-
ument that retains searchability
by cleverly keeping the OCRed
characters in a layer “beneath” the
document. This format is useful if
you want your PDFs looking exact-

ly like the original, while still
being searchable. Remember,
using either of these formats,
you’ll be building a searchable
document collection—in Acrobat,
you can search for all occurrences
of a word in an entire folder.

Modifying Content
After you’ve converted documents
to PDF—whether by OCRing them
or by converting them from other
formats—there’s plenty more to
do. You can add headers, footers,
and watermarks, all under the
Documents menu. If a particular
part of a document needs special
attention, you can copy that sec-
tion as an image using the
Snapshot Tool on the the standard
toolbar. You can add list boxes,
combo boxes, and more, all from
the Advanced Editing Toolbar,
under “Advanced.”

You can, of course, take pages
off one document and add them
to another and so on, building up
your document collection exactly
as you want it. And you can export
all images in a document to a
folder, by simply going to
Advanced > Export All Images. As
another example of Acrobat’s ver-
satility, you can even do things
like using a radio button to access
part of another document!

Restricting access is well
implemented in Acrobat. You can
password-protect documents so
they can’t be opened, or altered,
or printed. These features are
under Document > Security. And
from the Document > Digital
Signatures menu, you can digital-
ly sign a document before send-
ing them so the receiver knows
it’s you who’s sent it.

Explore the Comments menu:
once a document has been sent
out for review, you can collate all
the comments from all reviewers
and merge them into a single PDF
document. Comments can be
managed using the sorting and fil-
tering tools. They can even be
exported to Word! Besides, using
the Tracker tool, again under the
Comments menu, you can track
the progress of the document
review process: the Tracker keeps
track of the reviewers you’ve invit-
ed to take a look at your docu-

Adobe Acrobat 
ment, and of when they respond-
ed with their comments.

A new feature in Acrobat 7 is
that if you’re conducting your
review over the Web, the Tracker
acts as an RSS reader!

Web And E-mail
Acrobat is truly Web-ready. Using
the Advanced Editing options, you
can add links and annotations,
forms and security options, and
even video and sound to your PDFs.

Acrobat can be used as a cross-
platform image viewer. Using a
plug-in, you can convert images in
different formats to PDF files.

A PDF file can act as a contain-
er for files of almost any type—you
could attach the original Word
document from which the PDF
was created, so the reader can
compare and figure out what
changes were made. Besides, since
you can attach a range of docu-
ment types, the PDF format can be
used as a medium for secure deliv-

ery of any sensitive content!
You can edit any part

of a document before
you publish it—the
Touch Up tools (under
Advanced Editing) can
be used to edit text

including fonts and
sizes, move graphics

around, and so on.

New Features And More
New features in version 7 include
the option to import e-mails from
MS Outlook and sort them within
a PDF document. The new
Organizer makes it much easier
to, well, organise documents: for
example, with the History feature,
you can see which PDFs you
opened when, with thumbnails!

Probably the best thing about
all this is that in the end, regard-
less of what system and platform
and applications you used to
create your PDFs, your documents
look exactly the way you created
them—to anyone, on any platform,
using the free Adobe Reader!

Help in Acrobat is extensive,
and we’d advise you to go through
the full help file to get a real feel
for what you can do with this do-
it-all software. 

ram_mohan@thinkdigit.com

“There’s more to Acrobat than the Reader,” the tagline went. Acrobat’s features are indeed endless

New
features in
version 7
include the
option to
import
e-mails from
MS Outlook
and sort
them within
a PDF
document
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It was high time I
took on a new
programming
language to see
what use i could
put it to. After
several auditions,
the lucky candidate
was XSLT: the
eXtensible
StyleSheet
Language
Transformation.
Since the purpose
was personal,
classes didn’t make
sense (there aren’t
any institutions
that will teach only
XSLT anyway), so it
was between using
a book and going
online.

One simple Google search is all it takes, and I have
everything I need right in front of me. It did take me
some time to wade through sites to decide which one
seemed the best, but I could do it in the comfort of
my chair and without having to pay anything, too. I
settled on W3Schools.org. 

It’s all free, so there’s no guilt about wasted
investments on books that are bigger than I’ll ever
need.

Of course, the time I spend in the train will be
wasted twiddling my thumbs.

The site is organised quite like a book itself, and I
need to just click on the link for the chapters I’m
interested in, without having to think about the
others. What’s more, I can keep cross-referenced
items open in different windows, so when I read
something like “refer this,” the “this” is just an [Alt] +
[Tab] away. 

There are millions of online forums and help sites
for any language—each of which have about a
thousand users just waiting to solve my problems.
They even pitch in with tips of their own based on
their own programming experiences.

Out Hunting for a good book And surfing from my chair

1

2

3

4

One needs to realise that this is a programming
language we’re talking about and all the information

available couldn’t fill just one book—getting connected is
the fastest way to expand your knowledge. Finding
information you can digest is a task in itself, though—you’ll

need to do plenty of dirty work before you can begin
learning. If you are just a hobbyist, online is the way to go.
Whether you do so before or after you invest in a book
depends on whether you feel you’d learn better from a
book. 

OLD
WAY

TECH
WAY

Ease: 3/5
Total Cost: Rs 500 

Ease: 5/5
Total Cost: Rs. 0 

And 

The

Winner

Is...

Nimish Chandiramani (nimish_chandiramani@thinkdigit.com)

My first XSLT! Pity it doesn’t work properly. This is the
book at its most useless. I can’t see anything wrong
with my code, and leafing through the book over and
over again trying to find out what’s wrong achieves
nothing.

Learning A Programming Language

Twenty per cent of any book effectively covers over
eighty percent of the XSLT I’m ever going to use, so
a goodish number of those pages are probably
wasted on me. Still, it’s heartening to know they’re
there—I can browse through them on the train
journey to work.

The most daunting task—hunting down a good
book. After reading loads of reviews online, I short-
listed a few books that would probably suit my
needs. Next step: running around the city in the
sweltering heat to find them in bookstores. 
The books start at about Rs 300, but some of them
actually come for around Rs 1,500. Ouch! 
I settled for XSLT: Working with XML and HTML by
Khun Yee Fung, which was quite pocket-friendly at
Rs 500.

On to learning. Reading is quite convenient—after
all, it is a book—easy on the eyes and what-have-you.
It’s also expectedly well-organised and cross-
referenced, so finding the information I need isn’t
much of a hassle.

I find the bundled sample code a tad limiting
though—there just isn’t enough to satisfy random
curiosity, so I need to go online to check if my weird
ideas are actually feasible.



Pretty But Pricey

The P4350 All-in-One is an inkjet photo MFD. It uses a
dual-cartridge system for photo-quality printing, and the

colour scanner is an A4 flatbed. This is a good thing,
because a sheet-fed scanner could very well crumple your
photos while you’re scanning them!

MFDs do not have to look boring, and the P4350 proves
it. It sports sleek, elegant looks and blue LEDs all over the
place that would make any printer, let alone an MFD, turn
green with envy.

The P4350 supports almost all memory card standards,
and also PictBridge. So you can just click away with your
digital camera, insert the memory card into the MFD,
preview your photos on the 1.7-inch colour LCD screen, and
just press a button to print your photos!

The Lexmark Imaging Studio—a photo editor, and the
ABBYY FineReader 6 Sprint OCR software, make this a
complete package. Overall performance, however, was a bit
slow, and print quality was just about average. At Rs 15,999,
the Lexmark P4350 All-in-One is still out of reach for most
home users.

Feature-Full

MSI has just launched a Flash-based MP3 (and WMA)
player—the MEGA PLAYER 533 SD. The clincher is the

SD (Secure Digital) card reader—you only need to insert
the card to start playing songs from it! It has its own 256
MB of internal memory, accessible from a PC via USB. The
player can also be used as a portable USB device; it can
also function as an SD card reader for your PC!

You can record FM—or a speech—directly to memory!
There is also a graphic equaliser. The build quality of the
casing is a let-down, and the earphones seemed a little
uncomfortable and oversized. The AAA alkaline cell
lasted for about eight hours, as claimed. For the price,
this is not a bad buy at all!
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Rating

Lexmark P4350 All-in-One 

MSI MEGA 533 MP3 Player

Rating

Slim, Stunning, Sexy

Apple’s latest, its a bit wider than the original iPod, because of the larger screen and
smaller scroll wheel. The new model has been beaten down to look slimmer and smarter.
The most desirable feature of this iPod is that it plays video. What formats? Apple specifies

H.264 video in 320 x 240 at 30 fps and MPEG-4 video in 480 x 480 at 30 fps. Audio can be
encoded in AAC-LC up to 160 Kbps at 48 kHz. One good thing is that the new QuickTime has
an “Export to iPod” option, which automatically takes care of these specifications.  

During our test, the video playback was crisp, clear and enjoyable. Since the standard
bundle doesn’t include the AV cable, we were unable to connect it to a TV set. The device
provides about 11 hours of battery life! Some nifty new apps have trickled into the iPod
Video—a world clock, a great stopwatch and a superb-looking screen lock. But Apple has cut
some corners—there’s no A/C wall charger, AV cable or dock. Our verdict? The Video iPod
makes for a great personal video player—if you can cough up the money.

Company Apple Computer International

Price Rs 15,000 (30 GB)

Phone 1600-4254683 

E-mail indiainfo@asia.apple.com

Web site www.apple.com

Company Micro Star International

Price Rs 2,700 (estimated )

Phone 011-41758808

E-mail info@msi-india.com

Web site http://www.msi.com.tw

Company Lexmark International (India) Pvt Ltd

Price Rs 15,999 

Phone 022-26057744 

E-mail sandeepk@lexmark.com

Web site www.lexmark.co.in

Rating

Video iPod 
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Small But Loaded

The hot new Xda Atom from O2 is a PDA
phone that packs in loads of features in

an extremely small form factor. The Atom
lives true to its name, and packs a punch in
a diminutive casing. Measuring 58 x 102 x
18.5 mm and weighing just 140 gm, the
Atom is a tad smaller than its predecessor,
the highly successful Xda II Mini. 

Encased in an elegant piano-black
casing, the Atom sports a 2.7-inch screen.
The front facia also includes large Send and
End keys, a circular five-way navigation key,
two keys assigned to the Start Menu and
the MediaPlus application respectively, and
two tiny speakers. You can find two volume
keys on the left, a voice recorder and
camera keys on the right, and a power
button on top next to the stylus silo. The
camera lens, self-portrait mirror and flash
are located on the rear, while the bottom is
where you will find the USB connector,
headphone socket and reset button.

Powered by an Intel PXA272 processor
running at 416 MHz, the Atom comes with
128 MB of ROM and 64 MB of RAM. You can
add more memory by using the mini-SD
slot located on top. The 2.7-inch touch-
screen supports 262K colours at a
resolution of 240 x 320. Connectivity
options include tri-band GPRS/EDGE
functionality, infrared, Bluetooth and Wi-Fi
802.11b—basically everything a globe-

trotting user
would need.
The camera is
a 2-megapixel
CMOS that
can capture
both stills
and video.
Other goodies
include an
integrated FM
tuner,
integrated
strobe Flash,
and a stereo
wired
headset. You

can even record from FM in the WAV or
AMR formats. The device synchronises with
a PC using the bundled USB cable.

The Atom runs the new Windows
Mobile 5.0 operating system, the most
notable feature of which, in our opinion,
is persistent storage. This means that
unlike with devices based on the earlier
Windows Mobile 2003, this baby will not
lose any data or installed programs when
you run out of battery.

The Pocket Word, Excel and PowerPoint

have been rechristened Word Mobile, Excel
Mobile and PowerPoint Mobile, with
added support for embedded images,
charts and tables. Standard PIM
applications such as Calendar, Tasks and
Notes are all there. O2 has thrown in quite
a few of their own applications—
noteworthy of which include O2
MediaPlus, SMS Plus and Equalizer. 

MediaPlus provides an interface akin
to that of Windows Media Center, and
gives you the ability to play and view
various media—radio, music, pictures and
video, from a single window. O2 SMS Plus
lets you view your text messages in an
instant messaging format. Apart from
these, you also get useful utilities such as
an Auto Configurator, a photo editing
application and a self-diagnostic tool. 

Coming to performance and usability:
the glossy casing attracts fingerprints and
dust, so be prepared to spend a fair bit of
time cleaning your phone! The 416 MHz
processor is capable of running most
applications and games with ease, and
will even let you multitask. The new OS
still retains the nagging “Smart Minimise”
feature, which does not close applications
even when you tap the Close button.
However, this can be easily circumvented
by using a task manager such as SPB
Pocket Plus or SmallMenu (or using the
Memory module in Settings to shut down
applications manually). Phone clarity
is very decent, even in areas with low
network coverage.

You can use the speakerphone in a
noisy environment. The stylus is a bit
skinny, but the touch-screen is quite
sensitive. You can use the virtual keyboard
or handwriting recognition to input text.
The screen display itself is quite vibrant,
but visibility is reduced significantly
under sunlight.

The camera application is quite slow,
and does not redeem itself in the quality
department—images taken in low light
turn out to be quite noisy.

Audio output from the inbuilt
speakers is decent, but the wired stereo
headset provides much better quality
when listening to music. The 1530mAh
user-replaceable lithium-polymer battery
lasts for a decent two to
three days with
standard usage.

Features-wise, the Atom
has just about every
feature one would
want. Sure, you can buy a
laptop at this price, but can you carry
it in your pocket?

O2 Xda Atom

Company Creative-e-biz.com

Price Rs 38,888

Phone 022- 56314845/46 

E-mail cr_mum@yahoo.com

Web site www.seeo2.com

Rating
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A Must-Have For 3ds Max Users

Discreet’s Combustion has come a long
way since its first days as a tool that

would normally be used only with 3D
Studio Max (3ds Max). Today, Combustion
can do for video what Photoshop can do for
images, and it’s a strong competitor to
Adobe’s After Effects in this area.

Firing Up
Combustion’s interface is a tad
unconventional, and beginners will find
themselves lost for a bit, but some tinkering
and many silly mistakes later, one finds that
it’s really quite intuitive. If you have used
After Effects, though, getting used to
Combustion might be a little more difficult.

With Combustion, you can fix most
problems with videos—eliminate camera
jitter, colour correction, and “key” out
backgrounds from scenes and add new
backgrounds in their place. It’s also a very
powerful tool to create 2D and 3D video
composites, and integrates tightly with 3ds
Max to add some amazing post-production
special effects to your 3ds Max scenes. 

With some incredible particle and fire
effects, Combustion makes up for 3ds Max’s
shortcomings in the special-effects
department, and there are more than
enough presets to keep you happy for a long
time. Creating these effects in 3ds Max
would have been too resource hungry (not
that they aren’t in Combustion), and this
saves a lot of time.

Diamond Keys
New to Combustion 4 is the Diamond Keyer,
which is a much more powerful tool to
remove backgrounds from videos than the
existing Discreet Keyer. It’s also extremely
simple to use and much lighter on resources
than the multitude of operators one would
use to get the same effect. With the
inclusion of this, Combustion’s abilities

now begin to approach those of the
higher-end compositors such as
Flint, Flame, and Inferno.

The G-Buffer Builder
Before Combustion 4, creating
depth-of-field effects would be
extremely torturous if you didn’t
use Discreet’s Rich Pixel Format
(RPF)—3ds Max’s rendering format
that saves even depth information—
but now, Combustion comes with
the new
G-Buffer builder, which lets you use
its paint tool to define the different

levels of depth in the video; now, creating
stunning depth-based effects
are easy to create even in
non-3ds Max scenes. 

Time-warping
Another major improvement
is the Timewarper, which
creates much more
convincing slow-motion,
speed-up and other time-
distortion effects. Instead of
simply changing the frame-
rate, Combustion now
renders intermediate frames
to give much smoother
transitions between
keyframes and finer control
over the effects.

Capsules
Capsules let you save the
whole gamut of effects you
just created as a single effect
and save it for application in
another project, or even
share it with friends!

The Rig 
While Combustion will run
on a machine with 512 MB
of RAM, you’ll need at least
1 GB to get some productivity out of it,
and even more if you plan on using it for
more high-end effects. A dual-core
processor would also make it quite happy. 

If you are a 3ds Max user, Combustion
is an application you don’t want to be
without. If you’re looking to make your
big break into compositing and special
effects, this should be on your list.
Unfortunately for Maya users, Autodesk
still hasn’t introduced support for it
despite taking over Alias, but that should
come soon.

Company Autodesk Media & Entertainment 

Price Rs. 49750/- 

Phone 022-56952000

E-mail selina.pinheiro@autodesk.com 

Web site www.autodesk.com 

Rating

Discreet Combustion 4
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Digital Tools l Net Gain

Jyotsna Rege

Atechnology news site this is,
but, well, a tech news site with
a difference. The content here

is not managed by an editorial body
but by you—as a registered user, of
course. Although users can post arti-
cles on the site after registration, the
content retained is largely determined
by what readers like to read. Each time
someone likes an article, he “diggs”
it—a word borrowed from the Amer-
ican slang for “preference.” An article
has to be relatively new and has to
have a sufficient number of diggs
before it is posted on the home page. 

The articles you see here are not
authored by users, but are interesting
reads they’ve come across in their Net
wanderings. This, therefore, isn’t an
original news site—it’s a community
bulletin board of sorts.

At A Glance
This is a very pretty, well-designed,
XP-esque site. The home page is dom-
inated by links to stories that have
made it here. A box on the left of the
title mentions the number of time the
story has been “dugg.” In addition, a
tiny link below the number box allows
the reader to digg the story. Once you
do so, the number on the yellow
number tab increases immediately to
accommodate your “digg,” or
approval. Links that allow the user to
read and add comments, blog and e-
mail the article are arranged below
the story title and introduction.

Just so you don’t feel lost, there’s
a search bar, and also a list of cate-
gories you can click on—such as
“robots,” “hardware,” “apple,” and so
on. You don’t need to register to read
articles, but if you want to do anything
more, you have to.       

Let’s Start Digging! 
One gets started using three links on
the top right—“Digg for Stories,”
“Submit a New Story,” and “Digg
Spy.” With the first link, you get a
look at the stories that are up for
reading and being rated, either in
“story view”—where you see a set
number of stories on the page—or
“cloud view,” wherein all “queued”
stories are clustered together.

As a registered user, you can
invite others to read your pick of the

crop, by clicking on “Submit a New
Story”. You submit the URL of the
news site from where you chose the
story, then the site conducts a search
for it. Once your story has been con-
firmed, you give it a title, submit a
brief introduction, and specify the cat-
egory under which you would like your
story listed. The final bit is where the
site searches if the same (or a similar)
story has already been submitted, and
if it has, the site requests you to not
submit your story! The story is then
posted to the “Digg Area Queue.” Sto-
ries are held here until (and if!) they
are promoted to the home page. Pro-
motion, as we’ve mentioned, is based
on the number of diggs it receives.

The third link—”Digg Spy”—is
interesting. Clicking on this gives you
a “real-time view” of the site—all sto-
ries on the site get streamed, and you
can pause a story if you want to. 

Besides simultaneously checking
out who wrote what, how many diggs
a story received and whether it made
it to the home page (or got “buried”),
you can also sort them according to
your preference with the help of the
little buttons.

In this view, clicking on a story title
does not take you to the article link,
but to the comments the story has
received and the diggers who com-
mented. You can then take a peek at
the profile of the digger and also look
at the all the articles he has dugg. 

…And Do More
It’s not all about spending geeky hours
looking up and reading stories and
articles about technology. As a regis-
tered member, you have a profile via
which you can create a circle of

www.digg.com

friends. Links on the home page take
you to the top stories and show the top
diggers. Besides, the site also has a
podcast feed, and a link called
“odeo”—which takes you to the Web
pages of Diggnation, a weekly
tech/Web culture show based on the
top digg.com news stories.

Why Digg?
The news posted on the site, though
largely controlled by its readers, is
also monitored for content. The site
also requests and instructs readers
to prevent inappropriate or irrele-
vant content from residing on the
pages by reporting this on the
“problem” link that accompanies
each article. And, of course, you can
digg a site only once.

It’s true that there are an awful
lot of “front pages”—1,097 at the time
of writing! While this may seem too
much to surf through, you can always
refine your choices.

We can think of four reasons for
being a regular Digger: first, you get
the most popular tech news on the
home page, without needing to
wade through tens of other sites. 

Second, you can actively partici-
pate in several ways in what’s going on.

Third, everything on the site is
so neatly organised and arranged! 

And fourth, the site embodies a
sound democracy.

Trust us, if you’re a tech buff,
you’ll get hooked on your first visit! 

jyotsna_rege@thinkdigit.com

The next time you see a piece of tech news you want to share, don't bother passing the word
around. Just Digg it!

“Digg” your favorite site on the home page

Clicking on a title on “Digg Spy” shows the comments the
article received 



81DIGIT APRIL 2006

Applies to the Nokia 3230, 6600,
6630, 6680, N-Gage QD and other
Nokia Smartphones.

Recover Your MMC
Password

If you ever forget your MMC
Password, connect your
phone to your PC and
navigate to the (hidden)
System folder. Here, open the
file “mmcstore” in Notepad,
and surprise! Your password!

Managing
Applications

S60 includes a task manager
to view running applications
and switch to or close any of
them. Hold down the
application key (the button
with the two-dots-spinning
icon) to bring up the task
manager. Press the [C] (Clear)
key to close the application
and free up memory, or
choose the application to
switch to it.

Full-text Editing
Many don’t realise it,

but there are a lot more text-
editing options in S60 than is
apparent. To select text, hold
down the Text key (the one
with the Pencil) and move the
cursor. A “Copy” option
should now be available. To
paste the text, go to the place
you want the text to be
pasted, and hold down the
Text key again. A “Paste”
option should now appear.

Listen To Music All
The Time

Go to the gallery and start
playing an MP3. Press the
“End” button to jump back to
the standby screen while the
music is still playing to see
the song title on the standby
screen. You can select the
song with the up and down
arrow keys, and you can use
the left and right arrow keys
to control the volume. Press
the joystick/pad to open the
music player again.

Reformat Your
Smartphone

If your Symbian S60 phone is
infected with a virus or a
malware program and
nothing you try seems to
work, you should reformat the

phone. Start by backing up all
your data and contacts—
synchronise your PIM with
Outlook to make sure your
contacts are safe, and write
down all your Instant
Messaging settings (if any).
Also copy all the data from
the memory card to your PC.
Switch off your phone.

On recent S60 devices,
simply hold down [Green], [*]
and [3] at the same time to let
your smartphone format
itself. You should refer the
phone’s manual to verify this.

Once this is done, you
will have a clean, malware-

free phone to which you can
now re-synchronise your data
and contacts.

Some Handy
Shortcuts

Use these shortcuts to save
some time while performing
simple, everyday tasks:

KeyPad [1] : Copy
KeyPad [4] : Cut 
KeyPad [7] : Paste 
KeyPad [*] : Go to root 
KeyPad [3] : Page up
KeyPad [6] : Top of list 
KeyPad [9] : Page down 
KeyPad [#] : File

properties

[Shift] + [0] ([Pencil] + [0]
for the Nokia 3650 or 6600):
Take a screenshot

Get Rid Of The “App.
Closed Main” Error

To get rid of the “App. Closed
Main” error, do the
following: open your file
manager/explorer and
navigate to
c:/system/bootdata. Delete
FirstBoot.dat. Now turn off
your phone and remove the
MMC card. Turn on the
phone to put in the date and
time. Once it boots up,
switch it off again, put the
MMC card back in and turn
on the phone.

Image Viewer
Shortcuts

Use these handy keypad
shortcuts while viewing
images:

[1]: Rotate image 90
degrees anti-clockwise

[3]: Rotate image 90
degrees clockwise

[5]: Zoom in 
[0]: Zoom out
[2]: Move up 
[8]: Move down 
[4]: Move left 
[6]: Move right 
[7]: Full-screen

Y Not?
Palm’s Graffiti text

input is accurate enough
once you get the hang of it,
but letters such as Y can still
pose a problem. The best
method so far seems to be
an open figure-of-eight. Start
at the top-left corner of the
graffiti area, stroke
downward and to the right,
loop around when you hit
the bottom and stroke
toward the top-right corner,
and you’ll never have to re-
write a Y again.

A Swift Stroke
You can tie a function

that you use often to the
vertical graffiti upstroke—go
to the Prefs application, and
choose Buttons in the menu.
In the Buttons area, click the
Pen button at the bottom,
and you can now assign
functions such as the
backlight, the on-screen
keyboard, the beam data

Palm OS Devices 

Symbian S60 
Smartphones
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function, and Turn off &
Lock, among several others.

Make HotSync Wait
Forever

If your Palm device gets
impatient and times out
waiting for your PC to make a
connection during a HotSync,
there’s a Developer’s
Backdoor in the Palm OS
which you can use to force
your device to wait until a
connection is made.

Open the HotSync
Application. Press and hold
the up and down scroll
buttons simultaneously with
your left thumb, and use the
stylus in your right hand to
double-tap in the uppermost
right corner of the screen. A
small dialog box titled
“Developer’s Backdoor” should
open up, containing the text
“DLServer Wait Forever is ON”.
Click on OK, and your device
will now wait until your PC
makes a connection.

Resetting Without
Data Loss

If your Palm device is
misbehaving and you don’t
want to lose your data in a
hard reset, you can try
resetting the Palm OS instead. 

You’ll need a bent paper
clip for this. Press and hold
down the up scroll button
and at the same time, use the
paper clip to reset the device
(the reset port is a small
pinhole at the back of the
device). Release the up scroll
button when you see the Palm
Startup screen.

Cursor Tricks In
Graffiti

To do a backspace when using
graffiti, make a horizontal
right-to-left stroke on the
graffiti area. If, however, you
just want to move the cursor
to the left, make a continuous
left-right stroke: start at the
right side of the graffiti area,
stroke to the left and then
stroke back to the right
without lifting the stylus. 

Similarly, you can move
the cursor one step to the
right by making a continuous
right to left stroke.

Create Your Own
ShortCuts

A ShortCut is a code that

inserts a commonly used
phrase when combined with
the ShortCut stroke in the
graffiti area. The graffiti
ShortCut stroke is easy—much
like the cursive letter L. Start
at the bottom left, move
upward and towards the
right, loop around and move
towards the bottom right.

Suppose you use the
phrase “Meeting With” a lot.
You could assign a shortcut
called “MW”, which will just
insert the phrase for you.

In the Application
launcher, open the Prefs
application, and tap the drop-
down box in the upper right
corner. Select ShortCuts, and
tap New. In the line under
ShortCut Name, write “MW”.
In the line under ShortCut
Text, enter the full text—
“Meeting With”. To use this
shortcut in a memo, first make
the ShortCut stroke (which will
now appear on the line), and
then write out the ShortCut
name (“MW” in this case). Your
ShortCut text should appear
on the line in an instant!

Applies to Smartphones from O2
and iMate, and PDAs like the 
HP iPAQ

Get MSN Messenger
In The Start Menu 

Windows Mobile 5 comes with
PocketMSN, which combines
MSN Messenger, Hotmail and a
couple of other programs in
the same interface. This makes
starting up Messenger a more
tedious task than it should be.
To make MSN Messenger
accessible in a single tap,
follow these steps: start File
Explorer and navigate to the
\Windows folder. Look for
“instmsgr”; tap on it and hold
to bring up the menu, and
select Copy. Now navigate to
\Windows\Start
Menu\Programs. Select Menu
> Edit > Paste Shortcut. You
can now rename this shortcut
to “MSN Messenger” or
anything else.

Change Opera’s
Behaviour On

Windows Mobile 
In the Opera 8.5 beta for
Windows Mobile, you will

notice that when you try to
scroll through Web pages,
you’re actually taken from link
to link. This can get extremely
annoying if you’re viewing a
site with lots of links. To get
around this, use any file editor
to edit 
\Application
Data\Opera\input.ini. 

Change: 
Up = Navigate up
Down = Navigate down
to:
Up = Page up
Down = Page down
Sites will now scroll page

by page. 

Reinstalling Software
To A Flash Memory

Card (Windows Mobile 5)
To save internal memory, you
can reinstall existing
applications to your extendable
memory card instead.

Go to Tools > Add/Remove
Programs in Microsoft
ActiveSync, and locate the
program you want to reinstall.

Deselect the checkbox next to
it to uninstall it from your
Pocket PC (the installation files
will remain on your Desktop
PC, though). Close Add/Remove
Programs and start it again. 

Now check the box next to
the software to install it. You
will be asked where you want
to install the program—simply
choose “\SD Card” and click
Install. 

Really Close
Applications

Contrary to what it suggests,
the X button doesn’t close an
application—it only
minimises it. To really save
your system resources and
close the program, you have
to click on Start > Settings >
System and select the
Memory icon. From there,
click on the Running
Programs tab to end your
tasks. You could also use a
freeware task manager such
as vBar or PocketNav.

You Can Overclock
Your PocketPC Too!

If you want to push your
PocketPC to the limit, try
overclocking it using third-
party tools such as
Immiersoft’s XCPUScalar or
Pocket Hack Master from
Anton Tomov. You should
back up all your data first,
because overclocking can
cause your device to freeze or
hard reset—which will wipe
our all your data and settings.

Switch screen
orientation quickly 

If you find yourself wanting to
switch between portrait and
landscape mode often, assign
a button for it. Tap Start >
Settings > Buttons and select
the button you want to assign.
Under "Assign a Program",
select "Rotate Screen" and
click OK. From now on, you
can use this button to switch
orientations quickly.

Get the most out of
the battery 

Go to Start > Settings > System
> Power. In the Advanced tab,
set your device to turn off in 3
minutes or less to conserve
battery power. 

If you're ever using a
CompactFlash card or
interfacing with any
peripherals, use the AC adapter
to save your battery.

Unless you really need a
bright backlight, turn it
down—go to Start >
Settings > System > Backlight
> Brightness. Turn down the
brightness to the lowest setting
you're comfortable with.

Make the battery last
longer 

How long your battery power
lasts depends on battery type
and how you use your device.
Try the following to help
preserve battery life:
o Tap Start > Settings > System
> Power. On the Advanced tab,
you can specify when your
device turns off to conserve
battery power. For optimum
conservation, specify 3 minutes
or less.
o Use the AC adapter to plug
your device into external power
whenever possible, especially
when using a CompactFlash
card or when using a modem
or other peripherals.
o Adjust the backlight settings.

Windows Mobile Pocket
PCs and Phones

Relocate programs to a Flash card
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Jayesh Limaye

Traditionally, we’ve always kept
photographs in an album—and if

we’ve been diligent about it, they’re
in proper sequence. We’ve moved on,
of course, and paper albums are all
but extinct. When you go on a trip,
are you more likely to snail-mail your
photos to your friend in Texas or to
invite him to view them online? But
then, you might want to send your
friend a single file that presents a
classy slideshow, rather than having
him log on to a site and click each
photo individually…

In our quest for the perfect photo
sharing app, we came across Flash
Album Creator from Dreamingsoft,
Inc., an easy and efficient way to
organise your photos and to create
and share digital photo albums. 

What’s different here is that in
with Flash Album Creator, you can
create slideshows. Here’s a step-by-
step walkthrough of the process to
create a digital photo album using
this software.

Getting It
Download and install Flash
Album Creator from

www.dreamingsoft.com. It’s a very
small download—just 1.14 MB. Flash
Album Creator works on Windows
98/Me/NT/2000/XP, and there are no
special hardware requirements.

Getting Started
Launch the application.
When the window opens,

click on the first button to the right
of the Album Photo List to pop up a
Select Photos dialog, which has a
preview pane. Browse to the location
where your photos are located, select
as many photographs as you wish to

include in the photo album, and
click Open to add them.

Once added, click the last two
buttons in the same line to set the
order in which the photos will be
displayed in the slide show. (The
preview pane on the right makes this
task easier.) Set the delay time to a
suitable value. You may also enter
descriptions or captions to each of
the photographs for easy reference.
Click Next.

Getting Set(tings)
You can now adjust the
various image settings. There

is an option to set the resolution of
the frame size of the digital album.
You can also opt to resize the
photographs to the current frame

size, or you can choose to crop the
photo to the size of the frame. The
JPEG quality option allows you to
choose the quality of the final
output. If you choose Best Quality,
the size of your album will, of
course, increase, so you need to
experiment with this setting to
choose what works best for you.

The ‘Hide Navigation Panel’, ‘Start
Slide Show Automatically’ and
‘Endless Loop’ checkboxes are self-
explanatory. Check the ‘Enable Fade
Transition’ box to enable transitions
between photos. The ‘Scale when the
Flash window resizing’ box should be
enabled so the photo album stretches
to fill the screen if you maximise it
or switch to full-screen mode. If you
don’t choose this option, you can
select a background colour that will
appear behind the photographs. 

Building It
Clicking on Build Album
results in a Shockwave (SWF)

file—this requires the Flash plug-in to
be installed on your browser. Select
the ‘Generate executable file’ box to
create a standalone executable file,
in addition to the Shockwave file.
This executable will run on any
computer—with or without Flash
installed! Similarly, checking the box
next to ‘Generate HTML page’ will
create an HTML file. Enter a name for
your album in the title field, which
will appear as the title of this HTML
file. You may also specify a
background for the HTML, or assign a
bitmap image as the background.

After you click on Build Album,
you can click on the Test Flash, Test
HTML and Test EXE buttons to see if
the album was created the way you
want it to be.Depending on the
output format you selected, to view
the album, you can drag the SWF
file to an Internet Explorer window
to view it, or double-click on the
HTML or EXE files to view the
album. You can navigate through
the album by clicking on the
controls at the bottom. If you had
opted to not use the Navigation
Panel, you can click on the left third
of the photo to go to the previous
photo, and the right two-thirds to go
to the next one.

To share your photographs, all
you need to do is e-mail either the
EXE file, or the HTML and SWF files
together!

Flash Album Creator 1.59 is
shareware—it works for 30 days in
demo mode, with the limitation that
the output file has a demo stamp.
The full version costs $29.95 (Rs
1,350).

Creating photo albums has never
been this easy, and there’s never
been a better way to present them!
Give it a try! 

jayesh_limaye@thinkdigit.com

Flash Your Photos!
If you want a clean interface through which to share your pics—as a slideshow, for
example—Flash Album Creator is what you’ve been looking for

Add Photos To Your Project

Your Photo Album Is Ready

Digital Tools l Tips & Tricks

Customise The Various Settings For Your
Photo Album
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Boot from this month’s Digit
CD to start using Damn
Small Linux (DSL) and
marvel at all that fits in this
50 MB distro!

Carry DSL With You
You can use the Live

Installation on this month’s
Digit CD to install DSL to
your USB Drive. Right-click
on the desktop and go to
Apps > Tools > Install to
USB Pendrive > For USB-
HDD Pendrive. When asked
for the device name, type in
“sda”. Confirm all the other
options, and DSL will be
installed on your pen drive.
To get the most out of this,
the drive should be bootable,
and the motherboard of the
PC you want to boot it on
should also support booting
from a USB device. 

MS Word Files In DSL
You can use the MS

Word Viewer to view MS
Word Files, or convert them
to the PostScript format.
Right-click on the desktop

and go to Apps > Office > MS
Word Viewer to launch it. 

Mount Or Unmount
Your Drives

DSL offers a simple, handy
mount tool to mount and
unmount drives for control
over writing data to them.
Right-click on the desktop
and go to System > Mount
Tool to bring up the little
application window. Click on
the top button to choose the
drive, and use the lower
button to mount or unmount
it—no more terminal
commands!

All Your Office Apps!
Apart from MS Word

Viewer, DSL also gives you
nearly all the office
applications you’ll need. To
get to them, right-click on
the desktop and go to Apps >
Office.

Ted is a text editor much
like WordPad. It can read
and write Rich Text Format
(.rtf) and text (.txt)
documents.

XPdf and PDF Viewer can
read Adobe PDF Documents.

Siag is an Excel-like
spreadsheet program that
can save spreadsheets as

Comma Separated
Values (.csv),
which can then
be read by nearly
any spreadsheet
program—so 
you can share it
with Excel users
as well.

My Own DSL
To download and install

applications built specifically
for DSL using the MyDSL tool,
double-click on the MyDSL
icon on the Desktop to start
it. Click on the category of

application you want to
install to view a list, and then
download the one you want. 

If you’ve downloaded a
.dsl package and want to
install it, navigate to it using
the Emelfm file manager,
select the package, and click
on the “myDSL” button right
in the file manager.

Installing new
fluxbox themes

You can use MyDSL to
download and install new
fluxbox themes, but if you’ve
downloaded them from
somewhere else, you might
not find things that easy. The
themes will usually come in a
tar.gz or tar.bz2 file which
contain the directories “styles”
and “backgrounds”. To install
the theme, just extract the
background files to
/home/dsl/.fluxbox/backgrou
nds and the style files to
/home/dsl/.fluxbox/styles. 

View HTML mail in
Dillo

Sylpheed—the e-mail client
that comes bundled with
DSL—translates HTML mail to
plain text, which can be
quite drab if you like
receiving pretty, colourful e-
mails. You can’t change this
about Sylpheed, but you can
make HTML mail open in the

Dillo web browser (or Firefox,
if you please). In the e-mail,
click on the Attachments
tab; you will see text/plain
and text/html and any
remaining attachments like
images, etc. Right-click on
the text/html attachment
and choose Open With. Type
in “dillo (or firefox) ‘%s’” and
click OK. You’ll now have this
option available to you every
time you right-click on the
attachment.

Tearaway Menus
The Fluxbox window

manager supports tearaway
menus—which can stay on
your desktop for as long as
you want—for items you’d be
accessing often: just click on
the coloured bar at the head
of the menu and drag it to
make it a persistent item on
your desktop. To get rid of it,
right-click on the top bar.

Damn Small Linux

You can use the mount menu and
mount tool to easily mount and
unmount drives

Installing DSL applications

All you’d ever need for official
work is already there in DSL

Tearaway Menus are like
shortcuts  to your favourite
applications

Viewing MS Word documents in DSL

The Emelfm (the file manager) will make installations a breeze

Install DSL to a USB drive

Bet You Didn’t Know

Run DSL In Memory
Did you know that you could
run DSL completely from your
system memory? When you
boot from the CD, type in “dsl
toram” at the boot prompt.
DSL is much faster when it
runs from memory, and you
don’t even need the CD once
it’s been loaded. What’s more,
it will run even on a system
with as little as 128 MB!
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Set Up An Internet
Connection

To set up your LAN-based
Internet connection, right-
click on the desktop and go
to System > Net Setup >
netcardconfig. Use this
utility to enter your IP
address, DNS address, etc.

If you have a dial-up
connection, use the Net
Setup > Dial-up PPP utility
and set up your connection.

You can now use any of
the three browsers to surf
the Net—Dillo, Firefox or
Netrik, accessible from the
Apps > Net > Browsers
menu.

Shoot to Kill
If you’ve used Linux

before, you will know that the
[Ctrl] + [Alt] + [Esc]
combination is manna when
you need to kill an errant
application with a single click.
You can get this in DSL as well.

Code
2
base
desktop=

dma
host=web123
lang={us/cs/da/de/e
s/fr/nl/it/pl/ru/sk...}

mem=xxM

minimal
mydsl={hda1/sda1}
nodhcp
noicons
no{scsi/pcmcia/usb/
agp/swap/apm/apic/
mce/ddc}
protect

restore
restore={hda1/sda1/f
loppy}
secure

{ssh/lpd/nfs/syslog/
monkey/ftp}

tohd=/dev/hda1
vga=normal
xsetup

Effect
Runlevel 2, Textmode only 
Skip myDSL and only load the base system 
Choose your window manager. Options:
fluxbox, jwm 
Turn on DMA acceleration for all drives 
Set hostname 
Choose Language/Keyboard 

Specify the RAM in MB. If you are running on
a machine with very low RAM, use this code
to tell DSL how much memory is available.
For example: for a machine with 24 MB of
RAM to use, use “mem=24M” (“mem” must be
lowercase and the “M” at the end must be
uppercase)
DSL will use the “Minimal” fluxbox theme 
Where to store your myDSL apps 
Skip network setup 
Use a plain desktop 
Disable detection for the specified hardware

On boot, DSL will prompt you for an
encryption password and then triple des
encrypt the backup file 
Load previously saved configuration 
Specify saved configuration location 

On boot, DSL will prompt for passwords for
root and dsl 
Start these deamons at boot. (A daemon is a
program that runs in the background and
provides a service)
Copy CD to HD partition and run 
Most compatible video mode 
Prompts you to setup X

DSL Cheat Codes
They’re not really ways to cheat, but with these options,

you can get some more control over the way DSL behaves. At
the boot prompt, type dsl followed by the cheat code to get the
effect you want.

Use Apt To Install
Packages

DSL is based on the Debian
kernel, so you can use the apt-
get command to install new
programs and updates from
the Web. First, you need to
enable Apt. Right-click on the
desktop and go to Apps >
Tools > Enable Apt.

If you know the package
name for the software you
want to download, type sudo
apt-get install <package>
in a terminal window, and the
application will be
downloaded and installed
from Debian’s repositories on
the Internet.

Configure your dial-up connection using pppconfig

The Ted Text Editor

Start Ted by double-clicking
the icon on the desktop.
Navigate to the ./fluxbox folder
and open the file called “keys”.
You will get an error saying
“keys” is not in the rich text
format—ignore the error. 

When Ted opens with
“keys”, add this entry at the
end:

Control Mod1 Escape
:ExecCommand xkill

Restart the Fluxbox
window manager by
right-clicking on the desktop
and going to Window
Manager > Restart. Now,
when you need to kill an
application, you can use
[Ctrl] + [Alt] + [Esc] and then
click on the misbehaving
app to end it. 

Expert
Failsafe
install 

lowram

Interactive startup/setup 
(Almost) no hardware detection 
Menu-based install system for easy access to
all possible installs 
Low RAM usage GUI with Minimal Desktop 

Other Boot Labels
You can also use these boot labels while DSL boots. (You

don’t need to use the preceding “dsl” for these.)

Configure your
LAN
connection
with
netcardconfig



86 DIGIT APRIL 2006

Digital Tools l Tips & Tricks

Keeping Track Of
Network Traffic

Linux, by default, does not
show a network traffic icon
in the panel. The icon shows
if your computer is connected
to the network or has a
broken link.

Gnome users need not
worry. The tool is there—all
you need to know is where to
find it. KDE users, don’t waste
time looking for the tool! And
obviously, those who prefer to
work in text mode do not
have such privileges.

For Gnome users: to add
the Network Activity Monitor
to the panel, right-click on
the bottom panel and choose
‘Add to Panel...’ This will open
the “Add to Bottom Panel”
dialog box. Scroll down the
list to choose Network
Monitor and then click Add.
The Network Monitor is by
default configured to eth0, so
double-click on it and
configure your Ethernet card
accordingly.

KDE and text mode users
need not be disheartened by
the absence of this facility.
You can make use of the LEDs
on the keyboard. The Scroll
Lock LED is never used, and

the Num Lock is turned off by
default in Linux. You can
make use of these two LEDs
to show network activity.
Download the Tleds package
from
http://users.tkk.fi/~jlohikos/tl
eds.html

Download version
1.05beta10, available in tar.gz
format. Any Linux x86
machine user can download
and use this software. You
may have to make a few
changes or get certain
dependencies resolved,
because the package may not
cater to all distributions. The
newer beta version has
support for kernel 2.1.x, 2.2
and also 2.4. So, after you
have downloaded the tarball
and extracted it to a suitable
folder, open the Makefile in a
text editor and make the
following changes:

Append the line
‘GCCOPTS = -D_GNU_SOURCE
-O3 -Wall’ with an entry ‘-
DKERNEL2_1’ to support
lower version of kernel. The
final line will be ‘GCCOPTS = -
D_GNU_SOURCE -O3 -Wall -
DKERNEL2_1’

The last change is for the
man files entries. Tleds adds
man pages to /usr/local/man;
we need to change this to
/usr/share/man. Look for the
line ‘MANDIR  =
/usr/local/man/’ and make the
necessary changes. 

After you are done with
the changes, install the
package by issuing the
following command:

#make all install + [Enter]

You can run this software on
any interface, such as ppp0 or
eth0. You need to know which
interface of the machine is
connected and active to the
network. Let’s assume eth0 is
connected to the Internet,
and it is also active offline

but on a LAN. To activate
tleds on eth0 issue:

#tleds -qd 50 eth0 [Enter]
The Num Lock LED shows

received packets, while the
Scroll Lock LED shows sent
packets.

In order to activate tleds
for eth0 on every boot, do the
following:

#echo
“/usr/local/bin/tleds -qcd 50
eth0” >>/etc/rc.d/rc.local

If you want to run tleds
again but on a different
interface, then issue ‘tleds -k’
and re-run the tleds
command on the interface
you want it to run on. For
ppp0 users, the command
switch will vary slightly:
‘tleds -qd 100 ppp0’.

MP3 In Text Mode,
MP3 Blaster

The heart of the Linux or Unix
platforms lies in the text mode
of the OS, popularly known as
the command line. Many
enthusiastic open source
developers have helped to
bring entertainment even to
the command line
atmosphere, which is perhaps
unimaginable for a Windows
user.

MP3Blaster is one such
non-graphical music player
for Unix-like operating

systems. The development of
this utility is still alive as a
project at sourceforge.net. To
download MP3Blaster, go to

http://sourceforge.net/pro
ject/stats/?group_id=154673&
ugn=mp3blaster

The file you get here is a
tarball (tar.gz or tar.bz2). We
follow a method by which we
download such applications
to a folder called “Utilities”,
and if it is a tarball file, we
extract it to another folder
called “more-apps”. This way,
we can avoid folders and files
of the same name (extraction
creates a folder with a name
identical to the compressed
file) under the same folder,
and this is also a methodical
approach. So the command
we use to extract is:

[root@test3 Utilities]# tar
-C /usr/more-apps/ -zxvf
mp3blaster-3.1.3.tar.gz

Now change your directory
to /usr/more-apps/mp3blaster-
3.1.3 to start with the
installation. To install:

#./configure + [Enter]
This command collects

the system details and creates
a file containing these
details. The process may take
some time, and if
dependencies are
encountered, you need to
clear those by downloading
the necessary packages.

#make + [Enter]
Uses the system

information recorded by the
configure script to build an
application as per your
system. This process may
consume time depending on
your system performance.

#make install + [Enter]
This process places all the

build files of an application
in folders as per the Linux
File System Standard.

At the shell prompt, type
in “mp3b” and hit [Tab]. This
should complete the command
as “mp3blaster”. If it doesn’t,
then hit [Tab] twice to list all
probable commands that begin
with “mp3b”. This is a shortcut
to know if your application has
been installed perfectly, and of
course, even run it.

#mp3blaster + [Enter]
Will start the application

on the entire Konsole
window. That means you will
have to dedicate a mingetty
(TTY) to MP3Blaster.

LINUX

Network Monitor will add an
interactive icon on the bottom
panel in Gnome desktop

Make the changes to the following lines in the Makefile under tleds
folder just before compiling it
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Kailas Shastry

In this little article, we present the
basics of how to protect access to

sensitive data on your computer. Follow
one or more of these tips based on how
much of a paranoiac you are!

Use A BIOS System Password
One of the basic ways of
securing your PC is to prevent

it from even booting unless a password
is entered. This is achieved by assigning
a system password in the BIOS. Once
you enter the BIOS, look for an option
that says “System Password.” 

Usually, you can either set a BIOS
Password, which prevents open access
to the BIOS, or a System Password,
which allows booting only if a
password is entered. Assign a System
Password when prompted. Once the
password has been confirmed, you can
save your settings and exit the BIOS.
(On some BIOSes you need to change a
Security or Password setting under
‘Advanced BIOS settings’ to read
‘System’ or ‘Always’.  Now, when your
computer restarts, you will have to
enter the password during booting.
This can be your first line of defence.
However, the BIOS password can be

reset by someone who knows his way
around the motherboard. But such a
person risks being caught opening up
your computer’s cabinet! Even then,
let’s look at some other things you can
do to keep your files from being
opened by others.

The Windows Password
If your guest account is
enabled in Windows 2000 or

XP, you may turn it off so only
registered users and the Administrator
can get into Windows. This setting can
be accessed by going to User Accounts
in the Control Panel. This should take
care of most intruders except for the
really determined ones who, given
enough time, can boot off a CD or USB
drive and copy or read your files. This is
time-consuming, but possible
nevertheless.

Encrypting Files
Even if someone does get into
your system, you can still

prevent them from opening your files,
by using XP’s encryption feature.
Encrypted files can be opened only by
the user who encrypted it. It will still
be possible for other users to delete
them. This system is OK in cases where
losing a file is better than someone else
knowing its contents.

Even if the encrypted file is copied
onto another machine, it is not
possible to open it without a Security
Certificate imported from the
computer on which the encryption was

done. The encryption feature works
only with the NTFS file system.

Passwords in MS Office
If you want to go a couple of
steps further in making your

documents secure, you can assign a
password to your MS Office and
OpenOffice.org files from within the
software. In MS Office applications, you
can assign a password by going to File >
Save As > Tools > Security Options.
Here, you can assign passwords for
modifying or even viewing the file.

If you are working on files such as
images that cannot be password-
protected, you can add your files to a
WinZip archive—or, if you have Adobe
Acrobat, then to an Acrobat file—and
assign a password to it. 

Choosing a good password
Avoid using dictionary words.
Use many characters.

Use numbers randomly in the
password.

Upper case should be used in part.
Special characters such as @ and ^

may also be used if the software
permits it.

Destroy them for good!
Just like you would shred

sensitive documents that are
no longer needed, break CDs / floppies
that contain personal data before
throwing them away.

When you delete your files from the
Recycle Bin, the raw data of the file is
retained on the hard disk. To
permanently delete the data, use file
shredding software such as Simple File
Shredder (www.scar5.com).

The paranoid geek!
Some of us don’t stop here—we
change the extension of the

file, rename it to make it look like a
system file, change the date attributes
and then move it to the Windows
folder where no one can identify it
unless they know the exact file name.
File hiding software such as Magic
Folders and Gate Keeper offer
encryption and hiding of files. Then,
there are also mechanisms by which
Windows can be set such that it will
start only if a USB drive with some
authentication files is inserted. 

One last word: there is no system
that cannot be beaten given time and
expertise. The only way to totally secure
your computer would be to prevent
physical access to it. Sorry, but that’s
the way it is! 

kailas_shastry@thinkdigit.com  

Secure Your Sensitive Data
An open door attracts even a saint—tempt no one! Protect your precious files and
folders, and breathe easy

Set a supervisor (system) password

Right-click on
the File > 
Properties >
Advanced >
Encrypt files

Set the password check to ‘Always’ or ‘System’
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Player Control
Even if the mouse is
enabled, it cannot be used to
click on buttons. The entire
control for this application
is possible only via the
keyboard. The top of the
screen lists all the keys in
order to play the music file.
The right pane contains
buttons for play, pause,
forward, etc. and it also
displays the toggle switch
for repeat and shuffle. In
between the top and right
pane is an empty area (when
run for the first time) where
the playlist will appear after
selection of media files.
MP3Blaster supports OGG,
WAV, Sid, and of course,

MP3. Below are the list of
keys you will need to operate
the player:

Once you enter a folder
view using [F1] or [F3], the
function of certain keys listed
above changes. For example,
[F6] gets assigned to “Convert
MP3 to WAV,” and [F7] is
assigned to “Add URL
(shoutcast).” Look at the key
list given on the player’s
interface—the playback keys
will never change. Use [Q] to
exit the player.

Tricks with ifconfig
This is a versatile

command. It is mainly used
to deal with network
adapters such as displaying

the address and details of an
adapter, say eth0. It can also
be used to shut down an
active adapter or bring up a
deactivated one. But very
few are aware that it can be
used to spoof the MAC
address of your Ethernet
controller.

This command followed
with the interface name and
parameter “up” or “down”
will start or shut down the
interface specified.

#ifconfig eth0 down +
[Enter] will shut down the
Ethernet service.

#ifconfig eth0 up + [Enter]
will bring up the Ethernet
connection on your PC.

Assuming that you have
only one network interface
i.e. eth0, we shall try a
different trick with the
ifconfig command.

We all know that ifconfig
by itself will display the
details of all the installed
interfaces. Use it to get the
MAC address of your
Ethernet card, as shown in
Table 1 below.

Select the line ‘HWaddr
00:0C:76:52:E6:F5’ using your
mouse (note that your
interface address will be
different from ours). Open a
text file using any text editor
and paste this line by
clicking the middle button of
your mouse (applicable for a
three-button scroll mouse;
else enable emulate three-
button feature) or if you have

emulated three-button
feature, then click both the
left and right buttons
simultaneously to paste it.
Name the file ‘MAC addr-
orignal’ or something similar
so that you will remember
this file contains the real
address. Although the
original MAC address is
restored on restarting the PC,
we maintain this step so that
we can restore the MAC
address manually, without
restarting.

To spoof the MAC address,
you need to shut down the
interface and then change
the address, and finally,
activate the interface
connection. Here’s how to go
about doing it:

#ifconfig eth0 down +
[Enter]

#ifconfig eth0 hw ether
00:00:00:00:00:00 + [Enter]

#ifconfig eth0 up + [Enter]
Now check if the changes

are made:
#ifconfig + [Enter]
You will see Table 2
You can even change the

“inet addr” (IP address) and
“Mask” (subnet mask) directly
using the ifconfig command:

#ifconfig eth0
10.10.124.28 + [Enter]

This will change the IP
address. And

#ifconfig eth0 netmask
255.0.0.0 + [Enter]

will change the subnet
mask from 255.255.0.0 (/16) to
255.0.0.0 (/8). 

The playlist get maximum space at the centre and controls are located
on its broder

[F1] To select music files using the inbuilt file browser. After
selection, hit [F1] again to add to the playlist.

[Spacebar] To select or deselect music files
[F4] To create a playlist. Name the file with a .lst extension
[C] To clear the playlist
[F3] To load a playlist
[F6] Toggle repeat
[F7] Toggle shuffle
[F] Toggle file or screen display
Playback (Numeric keypad keys)
[4] Previous track
[5] Play/pause
[6] Next track
[1] Rewind a track
[2] Stop a track
[3] Forward a track
Sound mixer settings
[T] Toggle mixer: Volume, PCM, IGain, Spkr, Line-in, etc.
[>] Increase the level of a mixer setting, for example, 

Volume
[<] Decrease the level of a mixer setting, for example, 

volume

eth0 Link encap:Ethernet  HWaddr 00:0C:76:52:E6:F5
inet addr:128.128.255.51  Bcast:128.128.255.255
Mask:255.255.0.0 inet6 addr: fe80::20c:76ff:fe52:e6f5/64
Scope:Link UP BROADCAST RUNNING MULTICAST
MTU:1500  Metric:1
RX packets:375613 errors:0 dropped:0 overruns:0 frame:0
TX packets:2467 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:26276079 (25.0 MiB)  TX bytes:494497
(482.9 KiB) Interrupt:11 Base address:0xaf00

eth0 Link encap:Ethernet  HWaddr 00:00:00:00:00:00
inet addr:128.128.255.51  Bcast:128.128.255.255
Mask:255.255.0.0 inet6 addr: fe80::20c:76ff:fe52:e6f5/64
Scope:Link UP BROADCAST RUNNING MULTICAST
MTU:1500  Metric:1
RX packets:375613 errors:0 dropped:0 overruns:0
frame:0 TX packets:2467 errors:0 dropped:0 overruns:0 
carrier:0 collisions:0 txqueuelen:1000
RX bytes:26276079 (23.5 MiB)  TX bytes:494497
(477.2 KiB) Interrupt:11 Base address:0xaf00
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Don’t Do That!
Recently, I visited some Web sites and clicked
on certain links that offered free screensaver

downloads. Ever since, my PC has been plagued by
spyware and adware. As a result, whenever I am
online, many pop-up windows open by themselves.
What do I do?

Abhishek Ramesh

In order to get rid of spyware and adware
fro your computer, you should install a

good anti-spyware such as AD-Aware from
www.lavasoftusa.com and update its defini-
tion files prior to thoroughly scanning your
hard drive.

Not all spyware and adware can be deleted
by a single anti-spyware software and hence
you should also install another good anti-
spyware such as Microsoft AntiSpyware from
www.microsoft.com, update its definition
files and run a scan to minimize the chance
of any spyware and adware surviving on
your PC.

Help Blocker?
I have Office 2003 installed. Under the Help
menu, when I click on Microsoft Office Online

for help, the Help window does not appear, and an
information bar appears at the top of the window.
I have Windows XP Professional SP2.

V Mahendra

This happens because of the pop-up block-
ing feature of the version of Internet

Explorer 6 that comes with Service Pack 2. You
could override the pop-up blocker: click on the
link that opens the pop-up window, while
keeping [Ctrl] pressed. To temporarily enable
pop-up windows, click on the Information Bar
at the top of the window, click “Temporarily
Allow Pop-ups.” When you shut down the IE
window, this temporary permission will be
revoked, restoring the original pop-up block-
ing settings.

In the second method, you could perma-
nently enable pop-up windows
on the Microsoft Office Online
Web site: click on the
Information Bar, click on
“Always Allow Pop-ups from This
Site,” and when prompted with
the message “Would you like to
allow pop-ups from ‘office.
microsoft.com’?” click Yes. This

will permanently set the pop-up blocker to Off
for this Web site.

If for some reason you wish to restore the
original pop-up window settings for this Web
site, open Internet Explorer. Click on the Tools
menu, point to Pop-up Blocker, and click on
Pop-up Blocker Settings. In the “Allowed Sites”
list, click on office.microsoft.com, then click
on Remove followed by Close.

The More, The Merrier
I have an HP Pavilion w5130in PC with Intel
GMA900 onboard graphics. I recently

upgraded my PC to 512 MB of RAM. My onboard
graphics is using 8 MB of memory, and I wish to
upgrade its memory too. Is this possible?

Mithik Biswas

While it not possible to upgrade the
memory of onboard graphics, it is certainly

possible to increase the amount of shared
memory that you can allocate to it. To do this,
enter the BIOS and go to the Advanced
Peripherals Setup, under which you will be able
to find the option to increase the amount of
onboard graphics shared memory.

Admin Autopatched!
I have Windows XP Professional. I loaded
AutoPatcher XP from your November 2005

DVD, and on the same day, I updated Windows via
windowsupdate.com. The problem is that now, a
Guest account login icon is available instead of the
Administrator login, so I can’t log in as
Administrator. The other account I have is a limited
account, and is of no use—I can’t install software or
make changes to my system settings. 

Venkat

Your Guest account icon is now visible
because your Guest account, which must

have been disabled thus far, has been enabled.
Even though you may not be able to view your
Administrator account, you will still be able to
log in to it by pressing the Ctrl-Alt-Delete key
combination twice at the logon screen. Enter
“administrator” as the username, and your
administrator password. You may then change
the type of the account you already have from
Limited to Computer Administrator.

Update And Patch
I have an Intel Pentium 4 3.0 GHz, an Intel
D915GVWB motherboard, 512 MB of RAM and

an 80 GB SATA hard drive with Windows XP Pro
SP2. Whenever I run games such as Age of
Mythology, Age of Titans and such, the game
crashes to the desktop after a while. I’m using the
onboard graphics and sound.

V Phani Sekhar 
Download and install the latest version of
the graphics and sound drivers from Intel’s

Web site. Also download the latest version of
DirectX from  Microsoft’s Web site. And finally,
download the latest patches for your games
from their respective sites. 

Your Questions, Our Answers

Temporarily turn off IE’s pop-up blocker
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Insomnia
I have an AMD Athlon64 2800+, an MSI
RS480 motherboard with 512 MB RAM, and

Windows XP Pro. I have been using the hibernate
feature instead of shutting down my computer. Of
late, the low disk space warning on the C drive
has started appearing, and the hibernate option
appears to be disabled.

Pradip Ghosh

When an XP-based computer goes into
Hibernate mode, it creates a file called

hiberfil.sys in the root directory. The size of
this file is, of course, equal to that of the
system RAM, because XP stores the contents of
the RAM in this file.

In your case, because of the low disk space,
there is not enough space to create this file, so

the Hibernate feature is disabled. To re-enable
it, free up enough space—512 MB in your case—
on your C drive.

Startup In Slo-Mo
Every time my PC boots, it takes around 30
to 40 seconds to detect the combo drive

before proceeding. Then, when the XP welcome
screen appears, it takes another 2 to 3 minutes to
start Windows. The hard disk activity LED is on
during all this time.

Priyesh Kanodia

The problem could just be caused by a
loose data or power cable. Remove the

cables and clean the contact areas using a
brush. Do the same at the contact area of the
hard drive and the combo drive. Then, run a
thorough disk scan of your hard drive to verify
if there are any cross-linked files, or if any bad
sectors have developed.

To do this, open My Computer, right-click
on each drive, select Properties, and click on
the Tools tab. Under Error Checking, click on
the Check Now button. In the Check Disk
window that opens, select “Automatically fix
file system errors” and “Scan for and attempt
recovery of bad sectors,” and start the disk
checking process. If problems are found and
fixed, you’re good to go.

Sounding Off
My Samsung 40 GB 7200 rpm hard drive has
recently started making weird sounds—they

sound like “kit kit,” and the computer is not able
to boot into Windows. I connected it to a friend’s
PC: while his PC detected the hard drive, it could
detect only two of the four partitions. Can NDD
recover the data on the other two partitions?

Harish Negi

The kind of sound you’re talking about
generally indicates that the media—the

disk platter—has suffered physical damage. In
your case, since at least some data is accessible,
it seems the partition table of your drive has
become corrupt. Many disk utilities such as
Disk Scan and Norton Disk Doctor can attempt
to repair such errors, but there is no guarantee
that the data will be recovered. Hence, before
running such utilities, it is better to run data
recovery utilities such as OnTrack Easy
Recovery Professional, or one of the utilities
from R-Studio, to maximise the chances of
recovering data.

If your data is recovered, back it up and
then run the disk scanning utilities to repair
the errors in the partition table. You should be
able to use the drive. But even then, the sound
from your drive is not something that can be
ignored—you’ll likely need to replace it. 

Nero Says Nyet
I have an LG GCC-4240N DVD-Writer. My
computer has Windows XP and Nero 6.3.1.15

installed. Whenever I begin writing a CD or DVD,
after completing 2 to 3 per cent, Nero reports an
“Invalid write state” error, and a coaster results.

Manikant Patel

There is not one definite reason due to
which this error occurs, but you can try

downloading and install the latest ASPI layer
from Adaptec. Also try using a different brand
of media. Look for and download the latest
firmware for your drive off the Internet and
upgrade to that version. If even that doesn’t
help, your DVD-Writer has developed a hard-
ware problem, and you’ll have to replace it.

Download The DLL
I have Windows XP installed. When I try to
install eDonkey, I get an error: “MSVCP71.DLL

was not found.” What could be the problem?
Chirag Bhunatar

This could happen either if MSVCP71.DLL
is missing, or if it got unregistered. Search

for the file in the System32 directory. If you
find it, go to Start > Run, type in “regsvr32
C:\Windows\System32\MSVCP71.dll”, and hit
[Enter] (assuming that Windows is installed in
C:\Windows). This will register the file. If the
file is missing, you can download a zipped
version from www.dll-files.com/dllindex/dll-
files.shtml?msvcp71. Register the DLL as
explained above.

The Hibernate option gets disabled due to low disk space
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Mix Tracks Using Audacity

Kailas Shastry

Here, we look at the basics of
audio mixing using Audacity,
a very powerful free and open

source software. You can download
Audacity from http://audacity.source-
forge.net/download/windows. To
save your tracks as MP3s, you need
the LAME MP3 Encoder, which is
available under ‘Optional Downloads’
at the same site. 

Opening Tracks
Once you start Audacity, you
can open the songs you want

to work with by selecting Import
Audio from the Project menu. File >
Open will open the file in a different
window. The song(s) will open in dif-
ferent tracks in the same window as
waveforms.

A waveform is a graphical repre-
sentation of the audio file. It shows
the amplitude (or volume) of the
track at every instant of time. You can
play from any position on the track
by simply clicking on the waveform
at the desired point (timeline) and
pressing the spacebar or the Play but-
ton. To select a portion of the wave-
form, just click and drag your mouse
cursor and you will see the waveform
being highlighted. 

Making A Selection 
Let’s say you want to mix the
music from Darude with the

track of Alice Deejay. Open these files
in separate windows. Note that you
cannot copy just any part of Darude
and mix it at any point in Alice Deejay.
First, you must take care to begin
your selection (in this case, Darude) at
a point on the waveform where the
amplitude is zero. Zoom in to the
waveform to pin-point a position
where the Y-axis (hence amplitude) is
zero. Similarly, end the selection at a
zero amplitude point. 

When you play the tracks, ensure
that the mix sounds good. You may
need to spend some time on it before
you get the proper hang of mixing at
the correct points. You can try differ-
ent combinations like mixing the intro

music of a number at the end of the
song, extending the track by pasting
another song at the end. The possibili-
ties are limited only by your creativity!

Normalising The Tracks
When you have two songs
open, you will immediately

see that the average levels (the Y-axis
levels) of the two are different (in
most cases). Before you do any mix-
ing, you need to bring them to the
same level by a process called nor-
malising. Press [Ctrl] + [A] to select all
tracks, and go to Effect > Normalise
and apply the change.  

Mixing The Tracks
Open the Alice Deejay track in
a new window and here, cre-

ate a new blank track by going to Pro-
ject > New Stereo Track.

Choose the point(s) in Alice Deejay
where you want to mix your selection.
Now, in the blank track that appears

just below, paste this selection
(from Darude, by our example) at
a point of your choice. Now when
you play the track, you can hear
the sound from both tracks. You
can repeatedly paste your mix-
ing selection to create a loop
effect or even paste them at dif-
ferent points.

If your mixing appears at
the beginning of the track, you
may want to Fade In your selec-
tion (increase the amplitude
gradually) or conversely, Fade
Out if it appears at the end of
the track. These options can be

found under the Effects menu. 

Deleting Parts Of
A Track
Deleting is perhaps the sim-

plest thing you can do—just highlight
(select) the portion to delete and
press [Delete]. You may select a whole
stanza or beat sequence to delete if
you want to shorten the song. Erasing
at random will make the track sound
bad, to say the least!

Save The New File!
Once you’re satisfied with
the way your mixed track

sounds, you can save it as an MP3 by
going to File > Export as MP3. Your
output file will contain the “mix” of
both the tracks.

Mixing two tracks is just one of
the basic operations that can be per-
formed on audio files using Audacity.
Audacity offers a lot more editing and
manipulation options. Try different

options under the Effects menu
on parts of the file. The hitherto
dormant Music Director in you
might just be unleashed! 

kailas_shastry@thinkdigit.com

Ever felt you can do better than the unrelenting remixes streaming from your radio?
An audio editing tool and some creativity is just what you need to make your own mixes!

6 Do not start your selection from this point 
4 Selection can start from here

The main and mixing tracks

Zooming Into The Waveform

By default, the waveform is 'fitted'
onto your screen’s maximum
width. For finer detail, you can
zoom into it using the zoom
controls. As the waveform is
unfolded before you, you will find
it easier to make an accurate
selection. 
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A Question Of Existence
I have an LG laptop with Windows XP Home
Edition. I am unable to run the Group Policy

Editor even though I log in as Administrator. How
can I run GPEDIT.MSC?

James Thomas

The Group Policy Editor is not available in
Windows XP Home Edition, and therefore,

the file GPEDIT.MSC doesn’t exist on your
installation. 

Can Connect, Can’t Chat
Our school computer connects to a server in
the school for Internet access. While I am able

surf freely, I am not able to connect to any messen-
gers such as Yahoo!, MSN and Rediff. Why?

Shachi Dixit

The PC probably accesses the Internet
through a proxy server. It looks like the

administrator has disabled the default ports that
are used by messenger services, probably in accor-
dance with the school’s policy—meaning you
aren’t allowed to use Instant Messengers. You
could try asking your administrator for access!

We Don’t Help No Pirates!
My PC has Windows XP Pro with SP2. Digit
distributed IE 7 Beta on a CD. When I tried to

install it, I was unable to: I was taken to the Microsoft
Web site to verify if my Windows was genuine. I’ve
heard this check can be bypassed. Can you help me?

Pravin Mehra

You can only install IE 7 if you have a legal
version of XP. It appears you’re using a

pirated version. There may be ways to circum-
vent the check, but that amounts to piracy. We
can’t talk about any of these “workarounds.”

Of Batteries And Software
I have a Celeron-M 1.5 GHz based HPnx6110
laptop. It has a six-cell Li-ion battery. Is there

any way to extend the battery life? I came across a
battery-maximising software called “Battery
Doubler” at www.dachshundsoftware.com.
Battery Doubler has been discontinued; can you
suggest a similar software?

Stanley Leo

Software can’t manage anything but a few
system tweaks. The best way to maximise

battery life is to adopt a few good practices. In
the Control Panel, launch Power Options, and
set the power scheme to Portable/Laptop. You
can also set a custom power scheme—for exam-
ple, you could choose to switch off the hard
disk after five minutes of inactivity. Remove any
USB devices that are not being used. In addi-
tion, shut down Wi-Fi, Bluetooth and infrared. 

Universal Serial Bug
I have a Panasonic NV-DS60 DV video camera
with the IEEE 1394 4-pin connector. I

purchased a USB 2.0 cable to connect the camera
to my laptop. When I try to connect it, however, I
get an error message: “One of the USB devices
attached to this computer has malfunctioned, and
Windows does not recognise it.”

Prasanna Gonthi

If you’re using Windows 98, you will have to
install the drivers for the camera for

Windows to recognise it. If you’re using XP, then
for proper USB 2.0 functionality, you should
install SP2. In addition, some DV video cameras
require drivers to function in XP—most manufac-
turers provide these drivers along with the prod-
uct. Also look for updated drivers on the Net.

The Heat Is On
While booting, the CPU temperature
displayed in my BIOS is between 40 and 80° C.

Can XP hang because of this? Second, my BenQ
Combo drive is not able to write CD-RWs, nor read
from them. I have Nero 6.6; in the Nero Info Tool, it
says I don't have the drivers for my drive installed.

Deblina Naithani

Your CPU is overheating, and XP might very
well be hanging because of this. Possible

causes can be the CPU fan not working, an
improperly mounted heat sink, or an ill-venti-
lated cabinet. You might want to invest in a
good heat-sink fan assembly.

The CD-Writer not being able to write CD-
RWs is because it is old—this cannot be rectified.
XP does not use the ASPI drivers that were used
by previous versions of Windows to access the
CD writing function. It uses a driver of its own—
that’s why Nero Info Tool reports the error. 

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we might answer
them here! Since we get
many more mails per day
than we can handle, it
may take some time for
your query to be
answered. Rest assured,
we are listening!

Get Help Now!

AGP Acting Up
I have a P4 3.0 GHz, an Intel D865GBF motherboard, 512
MB of RAM and a Seagate 40 GB IDE hard drive. Recently,

I purchased a Leadtek GeForce 6600 256 MB AGP card. My
problem is that when I plug in the card and try to start my PC,
it suddenly hangs (after loading XP), the monitor goes off, and
the system restarts. The PC works properly with onboard
graphics. I have a 350 W SMPS.

Arvind Sudevan

First see if the cooling fan on your display adapter is
working. Second, you could try completely uninstalling

any graphics drivers and then installing the
latest drivers for your display adapter along
with the latest version of DirectX for your
version of Windows. But ideally, you should
first plug in the display adapter and do a fresh
install of Windows, then load DirectX and the
latest display drivers. This way, only your display adapter’s
GART (Graphics Array Relocation Table) driver—which is
necessary for full AGP functionality—will be loaded.

A 350 W SMPS is more than enough for the GeForce
6600 to function properly even at full load. If what we’ve
mentioned doesn’t get your card to work, your display
adapter is probably faulty and needs replacement.

Question 

of the

Month
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I’ve taken up photography as a full-fledged
hobby, so to speak, and clicking away is all the
more enjoyable when you’re travelling. And

yes—the summer holidays are here! Time for me
to chalk out an itinerary of worthy places to visit,
but before that, I’ve got to get myself a good—and
I mean good—camera.

My Nikon FM-10 manual SLR may only be
three years old, but being film-based, it’s expen-
sive to run. I therefore decided on a new digital
camera for this summer. Mind you, when it
comes to buying a digital camera, a lot of things
need to be considered, the most important being
the megapixel count, optical zoom, optics qual-
ity, and type of memory supported. 

“The higher the megapixel count, the better
the camera.” That’s what most folks believe. It’s
partly true, but one also needs to pay attention
to the quality of optics—Carl Zeiss, Schneider-
Kreuznach, and Nikkor lenses, amongst others,
are considered good. My advice would be to not
pay too much attention to the megapixel count;
it is not the yardstick.

There are many cheap digicams out there
that claim high megapixel counts, and which
cost around Rs 5,000. Avoid such cameras, since
they use low megapixel count sensors and digi-
tally bump up the resolution. This results in
loss of quality. 

The best place to check out
digital cameras in Mumbai are
Heera Panna shopping centre
and Alfa. Other great places
are the lanes near the Fort
area. For other cities,
make sure you go with
some references!

A year ago, a basic
digital camera from a
known company would
cost around Rs 10,000; the
price has now slipped to an average of 
Rs 7,000. The feature sets offered are good
enough for casual shutterbugs. One can expect
a 3-megapixel camera with an optical zoom of
around 2X and memory storage on an SD/MMC
card for this price. Canon’s PowerShot A410 is
the cheapest camera I could locate; it retails at
around Rs 7,000 and comes with a good feature
bundle. It’s rugged, and it’s definitely a good
point-and-shoot camera for the price. Of
course, you’ll need to bear in mind that these
are grey market prices; the official prices will
be a little higher.  

If your budget centres around Rs 10,000, you
can get a decent point-and-shoot camera. The
Sony CyberShot S90 retails at around Rs 10,500.

If you stretch your budget a little, Nikon’s
Coolpix 5600 is available for around Rs 11,000.
It’s a 5.1-megapixel camera, with 3x optical
zoom and great optics. If you are considering a
mid-range camera, the Nikon Coolpix 5600
would make a good buy. In the same price range
is the Sony CyberShot W5, which has a large
LCD display and boasts of terrific performance
(we’ve tested it). The W5 is quite compact, offers
a 5-megapixel sensor, nearly 3x optical zoom,
and a good lens.

Canon’s PowerShot A540 is a 6-megapixel
camera with 4x optical zoom, and cramps in
many easy-to-use features. Priced at Rs 15,000,
the A540 is attractive, and should be considered
if you’re looking for a compact digicam.

That apart, Sony’s P200 is one great camera
to look out for. This model comes with a 7-
megapixel sensor, a Carl-Zeiss lens, 3x optical
zoom, and offers wonderful performance. At Rs

13,500, the P200 is hard
to miss, and is probably
the camera you should
be buying if you’re
interested in a compact
point-and- shoot camera.

The entry-level digi-
tal SLR market is quite

“hot” right now as they
say, and anyone aspiring to

go beyond the amateur  stage
should opt for one of these.

What you should be looking at
are the Nikon D50 and D70. They

retail at around Rs 35,000 and 48,000
respectively—that’s the cost for the body and
one removable lens. Later on, you can go for
additional lens such as wide-angle, close-up,
and more. As for Canon, think about the 350D,
which is a direct competitor to the Nikon D70.
Retailing at between Rs 38,000 and 42,000, the
350D, too, is a good entry-level digital SLR.

Since I already have an SLR, I thought I
should get myself a point-and-shoot thingy. And
that’s what I did—the Sony P200, at Rs 13,000,
was simply too good to be ignored. 

Agent 001

Agent 001 Hunts 
Down The Perfect Pixelator
Want to get yourself a compact digital camera… or even an entry-level SLR? Here's a look at
the market scene

Want more of Agent 001? Turn over to read his
answers to your buying questions

Illustration Pradip Ingale
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Dongles By The Roadside
I want to get myself a Bluetooth USB dongle with
a range of up to 100 metres. What is the best

one available? Also, please explain the difference
between Bluetooth V1.0 and V2.0.

Ami Chaudhari

Since we haven’t tested Bluetooth dongles,
I would reserve my opinion. There are

many makes; I have been using a Billionton Blue-
tooth dongle for over a year and it hasn’t given
me any problems. You might want to opt for a
Billionton; they come with good applications too.
Or else, visit http://www.thinkdigit.com/forum,
and ask our readers what they’re using. A 100
metre dongle retails at around Rs 500—this was
the price the last time I checked; you should be
able to get it for less. If you are in Mumbai, try to
procure such items from roadside vendors in
Lamington Road selling computer accessories—
you’ll get a good deal.

Version 1 of Bluetooth supported fewer
features and lacked certain security features. In
version 2, new features were added, and the secu-
rity issues were resolved.

Laptops: Don’t DIY
I am planning to assemble a laptop. Please
provide me a complete list of required parts and

approximate prices. I wish to configure a P4 Centrino
mobile 1.86 GHz or above, 512 MB of RAM, 80 GB HDD,
DVD-Writer, and a Sony LCD.

Vikas 

It is certainly possible to assemble a laptop
at home, but provided there’s a vendor

who is ready to sell you the required compo-
nents—and I don’t think any vendor is. In my
humble opinion, you should drop the idea, and
opt for a decent laptop from a proper brand. Also,
the Centrino platform has a Pentium M processor
and not a Pentium 4. Try HP laptops—you’ll find
a good range, and most make decent buys. A
laptop with the configuration you’ve mentioned
will set you back by Rs 60,000 or more.

Digicams—For Better Or For Worse
I want to get myself a digital camera and have
short-listed two models—Sony’s CyberShot DSC-

P200 and Nikon’s COOLPIX S4. Which is better? 
Anil Kumar

We tested the Sony CyberShot P200 last
year and found it to be a good camera—a

worthy successor to the P150 that won our best
digital camera award a year before that. The
CyberShot P200 is a good camera when it comes
to picture quality, and if you’re interested in print-
ing 4 x 6 photographs, it’s more than enough.
However, like in most 7-megapixel cameras, the
sensor tends to introduce noise into the final
picture when used at the highest settings.

The Nikon COOLPIX S4 is an ultra-zoom
camera with a 10x optical zoom lens. Despite the
zoom factor, the S4 is compact and should fit in a
jacket pocket. The best thing about the S4 is its
swivel body, which allows turning the lens by 270

degrees—great for shooting over people’s heads
or at awkward angles. We haven’t tested this
model, so I can’t give a clear verdict as far as the
picture quality is concerned. But generally, going
by Nikon’s standards, the camera should be good
enough for amateur photography. I would
recommend the Sony CyberShot P200 though.    

TV-Tuners: Good And Better
I want to buy an internal TV-Tuner card with FM
radio and capture capability. Can you suggest

some of the brands available and the best amongst
them? My system configuration is a Pentium 4 3 GHz, a
915 Motherboard, and 512 MB of memory. 

A Venkata Siva Moorthy

There are lots of brands of TV-Tuners.
Mercury, Intex, Enter and others catering

to the entry-level segment. Cards from these
vendors are generally in the range of Rs 1,500 to
1,800. Pinnacle and Compro are premium brands,
and have quality products priced above Rs 2,500.
You can think about getting yourself the Pinnacle
PCTV 110i internal TV-Tuner card, which retails at
around Rs 4,250. 

A Storage Conundrum
I want to buy an external storage device, and
I’m stuck between a pen drive and a card

reader. My budget is Rs 1,500, and I want 256 MB or
more of storage.

Kapil

Before I resolve your dilemma, let me
clear the mist for you. A card reader isn’t

a storage device; it is a reading device needed to
read data from cards such as MMC, SD, Memory
Stick, etc. An analogy would be that a card
reader is similar to a floppy drive, which is
required to read data from floppies. As far as
pen drives are concerned, you can opt for a 256
MB drive from a good brand such as Transcend,
Gigabyte, Kingston, and others. These should
fall in the price range of Rs 1,200. 

Want a tech product, but
don’t know how to go
about buying it? E-mail
agent001@thinkdigit.com
with your complete 
contact details, and he
might answer them here!
Please note that
Agent001 only answers
purchase-related ques-
tions in this space.

Ask Away!

Ask Agent 001

Choose Your Computer

The Middle Path
I get lot of mails asking for a good mid-

range PC configuration. Here’s a list of compo-
nents that should go into making a good mid-
range PC.

AMD 939-pin Athlon64 3200+ 
ASUS A8N-VM CSM or MSI K8NGM2
512 MB DDR 400 Hynix
120 GB SATA WD / Samsung /
Seagate
17-inch Acer 715 or Samsung DF793
Logitech 
Logitech Optical
Any
Antec / VIP 350 W 
Lite-On / Sony DVD-Writer 
Creative Inspire 2.1

XFX GeForce 6600 GT

MakeComponent
CPU 
Motherboard
RAM
HDD

Monitor
Keyboard
Mouse
Cabinet 
Power supply 
Optical Drive
Speakers
Total

Graphics Card

7,500
6,500
3,500
2,650

6,500
300
300
500

2,000
2,750
2,400

34,900
12,000

Cost (Rs) 



How Parental Control
Software  Works

2. The software checks the text 
on the site for banned words. If it 
finds any such words, it blocks the 
site’s content. If not, it moves on to 
the next step

3. The software then checks the 
images on the site. Using a special 
algorithm, it determines whether 
an image contains too much “skin 
colour,” and blocks it

There are three ways by which
parental control software block
sites or their content:
1. They check requested URLs 

against a list of blocked sites in
their repository, which is 
automatically updated (like 
anti-virus updates)

Parental control software sits
on your computer between a
browser and the Internet. It’s
something like a firewall—no
data can be sent to and from
the Internet by the browser
without it first being checked
by the software



Considering that a
home might have
children of different
ages, many parental
control software allow
for user accounts to be
created. Each account
can have different
“paranoia” settings.
So, for example, you
can set the security
level to maximum for
your 8-year-old, but
relax the setting for
your 15-year-old

You need to remember that these software are still not perfect, and chances
are that some cleverly disguised adult content might get through.

However, what’s more likely is that a lot of innocent content might get
blocked. For example, Web pages that talk about “breast cancer” might be
blocked because of the word “breast”; sites that offer “sex education” will
definitely be blocked

Thankfully, most parental control software allow you to administer the
browsing habits of your children, so not only can you see what sites they were
trying to visit (even by accident), you can also approve any sites that were
inappropriately blocked! The pros outweigh the cons a million to one in this
case, and if you have Net-savvy kids, we really recommend that you install a
parental control software

If the site that is being
requested fails test 1 or 2,
you get an error page. If the
site passes test 1 and 2, but
some images fail test 3, the
site gets rendered without
the possibly offensive
images.

This setting is controlled
via the options, and different
software have different
settings. As a result, some
software might actually block
the entire site if any images
fail test 3

Illustration Chaitanya Surpur

Text Robert Sovereign-Smith
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How Technology Can Help Your Organisation
Business
Digital

Life In A USB
Nutshell102

Number Crunching
Back in 1983, Uttamchandani heard about a
device called the calculator from friends who had
been to Singapore. In the wake of reports that this
machine, being startlingly accurate and fast,
would reduce the need for mental math-juggling,
he purchased a Casio 100. The simple advantage it
brought about in speedier customer billing, espe-
cially during peak hours, was the fillip for Uttam-
chandani to explore the role technology could
play in his business.

As he studied the brochure that came along
with the Casio 100, he saw one with a printer.
Three months later, he ordered a piece. This one
also gave a printout of the grand total of all the
calculations done on it in the course of a day (i.e.
daily gross turnover), thus initiating his entry
into the world of machine-generated reports.

Coding Products
Early on, Uttamchandani had realised that time
saved is money earned. A simple example was the
salesman who would have to leave the sales
counter at 7:30 pm every day to replenish items on
the rack. Were he to remain at the counter it

would mean more sales, espe-
cially during peak seasons
such as Diwali. After the
shutters were down, one day

he and his team
mulled over possible
solutions to save
time on the rack
filling task every day.

They decided to
numerically code
150 of the fastest-
moving items among
the 1,200. Also,
alphabetically-coded

Philip Malayil 

unshi Khancha Market in Vadodara
(Gujarat), the royal city of the Gaekwads,
is far removed from any signs of royalty

today. Its bustling alleys are crowded with people
and innumerable shops butting out from every
wall. From nine in the morning until nine in the
evening, the place is a retailer’s paradise, at least
in terms of the sheer number of customers who
pass through. But as crowded is the competition:
you cannot sell anything the guy next door
doesn’t have.

In the midst of such a crowd of opportunities
and competition lies the story of a 10-foot-by-6-foot
retail outlet, Welcome Store, and its founder
Satish Uttamchandani’s visionary use of tech-
nology. A typical shop that stocks FMCGs, dry
fruits and cosmetics, among other items of daily
use, this outlet has oodles of technology being
used to ease its various operations.

M

Life @ 24 FPSThe Brightest
Bulbs in Town 120106

A Step in Time...
The workings of a
little shop
demonstrate how
tech—at every
stage of evolution
—can help
business
productivity

Case Study
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labelling stickers were affixed on the racks and a
similar rack was replicated at their godown (ware-
house). The refill list could now be categorised
rack-wise. Thus, on a refill trip to the godown,
each rack would have to be visited only once.
Making a list of out-of-rack and out-of-stock items
now took 90 minutes less, which meant more
time for the sales counter.

Simple Products, Smart Use
While this was a process upgrade, the next tech-
nology upgrade came in the form of a calculator
that displayed sub totals. While a customer was
purchasing goods, his sub total (amount till the
last purchase) would be read out to him if
required. He could thus budget his purchase, and
this pleased the more budget-conscious shoppers
at Welcome.

In 1987, a company called Bradma introduced
a programmable printer. This was the next
obvious buy for Uttamchandani. Apart from being
able to give his customers a printed and itemised
bill (name, price, amount for each item and grand
total), there was hot-key access to the 20 hottest-
selling items—meaning these could be keyed in
with one stroke—thus speeding up customer turn-
around time. Daily sales reports could be gener-
ated, too. Two of such printers were soon added to
the store’s “IT resources.” 

It was in 1991 that these gave way to the
Bradma Cash Register. Memory increased to 300
items, and purchase price of products could also
be stored. Margins increased on account of this
simple utility: different wholesalers would quote
different prices, or the same wholesaler would
quote different prices at different times. Because
of the facility to cross-check at the turn of a key,
purchases became cost-effective.

The 300-item-memory limitation was
bypassed by the purchase of another next-gen
cash register with an additional card as expanded
memory. But since the memory was volatile, a
power failure meant having to reprogram it,
which took six to seven days.

Enter The PC
Uttamchandani has a simple philosophy—time
wasted is money lost—so when he first heard of
computers, it was the non-volatile nature of the
memory that attracted him: reprogramming

would become a thing of the past! In 1993, the PC
arrived at Welcome Store. One comprising a 286
processor, a 40 MB hard disk and a green-tone
monochrome monitor replaced the cash register.

The first D-Base program for billing and inven-
tory control did not impress Uttamchandani. He
had a simple reason: 857 was the code for Lux
soap. Two bars were billed by the instruction
2*857 followed by [Enter] in the case of the cash
register. In the software, the same process meant
the following key sequence:

857
[Enter]
2
[Enter]
Two keystrokes of [Enter] for every item meant

precious customer turnaround time! Within a
week, Uttamchandani decided to change this. He
contacted his friend, philisopher and guide - Pad-
manab Desai, a computer expert who also teaches
MCA students. At eleven in the night, Uttam-
chandani landed up at his doorstep, and sat
through the night till the change in input had
been implemented.

But as the business grew there was obvious
crowding at the store’s single billing terminal, so
the next step was to procure another machine and
set up a LAN. Novell 2 was the program he used for
this. But the cash drawer remained one, and was
operated in sequence according to the billing
cycle: whoever was processing a bill would operate
the cash drawer, while the other person would
wait to access it. At the end of the day, the “cash
in hand” reading on the system had to tally with
the cash in the drawers.

While this took care of billing, certain short-
comings were soon realised. There was the need
to consider different sales prices for product sub-
categories, generate stock statements and rack
filling lists, and re-order reports.

The Need To Upgrade
In1996, a software upgrade using Clipper and C+
was completed in a 90-day timeframe by Vado-
dara-based Infosoft company. The salient fea-
tures of the improvement were Stock Validation
Control (a user would not be able to bill a sale
without “stock in hand” or placing an order for
purchase); cash in hand report; rack filling
report; re-order list categorised according to sup-
plier; outstanding receipts and payments report;
and purchase order generation —this was
updated even for instant purchases (those made
even while the customer was waiting for it).

When
Uttamchandani
first heard of
computers, it was
the non-volatile
nature of the
memory that
attracted him

Smart Working is the way for Satish Uttamchandani 

Rack replicated at the warehouse



101DIGIT APRIL 2006

Digital Business l Case Study

The old hardware could not keep up with this
upgrade, and the PCs soon took on 486 processors
and 16 MB of RAM. Novell 3.11 ran the LAN.

Soon, the first Pentium came along. The first
machine Uttamchandani got had two hard disks
—one was a mirror disk for backups. The operating
system changed from MS-DOS to Windows NT, but
the software remained the same. A Paragon 36 dot
matrix filled in for the printing tasks.

The 1996 upgrade had took care of the require-
ments of multiple-drawer cash transactions and
banking transactions. In 1999, Uttamchandani
started off with an Oracle database application. By
the middle of the year, he  opted for Microsoft’s
SQL Server. Delphi was used for the front-end. The
entire application development took two years,
and was completed in December of 2001.

The State Of The Art
At the current level of evolution, the key benefits
of Uttamchandani’s system include:

‘Multiple cash drawer monitoring: transac-
tions from all three drawers are accounted for
in real-time, and cash-in-hand is a password-
protected option.

‘Rack filling report: location-wise reports gen-
erated for each of the 145 racks, which means time
savings since the rack refiller has a list of not only

items required, but also the exact shelf in the
warehouse from which it has to be picked up.

‘Real-time inventory assessment: three boxes
at the bottom of the sales screen displays the cur-
rent stock of the item, and the location of the item
in the warehouse and the shop.

‘Re-order report generation.
‘Expense register: all petty cash dealings are

maintained here.
‘Mirroring of bank account.
‘Multiple sales screens: “simultaneous” billing

of two or more customers because of the “min-
imise” option: one customer’s bill process can be
minimised and put on hold while the next one is
being processed.

‘A database of top customers and profits gen-
erated from each.

‘Charting of sales and profits for analysing
sales trends and forecasting.

‘User privileges can be defined and password
protection assigned for different registers such as
purchase, expense and cash drawer reports. 

On To Telecommuting
Tech-savvy though he was, it was only in early

2006 that Uttamchandani got himself a mobile
phone. His reason: any technology should help in
saving time or money, otherwise it is pointless.
With the help of a GSM modem, a SIM card, and
Real Time— a software he got free because of his
offer to run it on a trial basis—Uttamchandani can
now access all sales and purchase reports on his
cell phone.

Opting for a “200 SMS free” plan, he decided,
was the best bet. The most important informa-
tion is the outstandings due and payable, cate-
gorised customer or supplier-wise. Apart from
that, total sales, profits categorised date/month
or yearly, and the latest purchase price of any
item with its date of purchase and supplier is
available on an SMS, thus giving him much-
needed mobility while being in command and
control of a business which, by its very definition,
demands physical presence.

Tech Not For Tech’s Sake
Uttamchandani used this freedom to overcome
the limitations of a counter-sale/cash business
which, in the Indian context, requires the pres-
ence of the proprietor who could only be relieved
by a family member, thus requiring at least two
persons from the family to be fully occupied.
While technology has freed Uttamchandani’s son
to concentrate on his career with an MNC, it has
granted Uttamchandani the leeway to undertake
other ventures—such as manufacturing of a petro-
leum jelly, and also the time to pursue his hobby
of interior designing.

Another advantage of systematic data pro-
cessing was capitalising on the market research
requirements of large corporations. For example,
a multinational company wanted to buy three
years’ sales data in nine categories of soaps, which
he could give them at the stroke of a key. He made
a similar deal with a market-research organisa-
tion in town. His tech initiatives have now gener-
ated another revenue source for him. 

Also very popular is Welcome Store’s cus-
tomer loyalty program. Customers are tracked
on the basis of their annual and monthly billing,
and profitability rankings are developed for the
top customers. Annual prizes are given away
depending on a customer’s rank.

Welcome Store is a classic example of the pos-
sibility of technology deployment even for a small
setup. Tech is certainly a business productivity
enabler even for such stores. Systematic inventory
management in this little retail outlet not only
proved to be a valuable tool in hedging against
typical business risks, but also opened up vistas in
data mining and business expansion. 

philip_malayil@thinkdigit.com  

Tech Armour at Welcome Store

Tech support at the Welcome Store

n Three desktop computers with P4 processors
n Two 9-inch colour monitor and one 15-inch LCD

monitor
n One laptop
n Two Epson Printers
n A GSM Modem
n A 100 Mbps LAN switch
n A CAT-5 cable
Total cost: Rs 1,40,000
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Nimish Chandiramani

o most people, computing on the go
means investing in a laptop, PDA, smart-
phone, or any such mobile device that

lets one carry one’s data and applications along
with them. This is all very well for big corporates
who can afford it, but what of the common busi-
nessman? In a SoHo or Small Business, you can’t
really be expected to buy a company laptop for
everyone who needs it and not feel the pinch,
can you?

The ultimate solution to this problem will be
on-demand computing—when we’d sit in front
of any PC, anywhere, and with the digital equiv-
alent of yelling “Gimme!”, have all our applica-
tions and data at our beck and call. Of course,
there’s still a few years to go before that.

But strangely enough, most of us don’t even
realise that we don’t need to wait for the advent
of on-demand computing—we’ve got the solution
to these woes in our hands already! Many people
carry their data around on a USB stick—presen-
tations, documents, spreadsheets, you name it—
why not carry programs too? Portable
Applications are built for the sole purpose of
being run off a USB stick—no installation, no

writing settings to anything other than its own
folder, and best of all, nearly all of them are free.

All you’d need then would be access to any
PC with a USB hub, and you’ve saved yourself at
least Rs 20,000!

The Demands
Finding the best portable application for your
needs is all about balancing size and features.
Your first consideration is that the application
should not write any settings to the host com-
puter—you don’t really want to leave your mark
anywhere. The next priority is size—you’d rather
have several small programs rather than one that
hogs all the space. After all, even 512 MB USB
drives can get full alarmingly quickly, and the
more room you have for our data, the better.
Smaller applications do tend to have fewer fea-
tures, but let’s admit it—few of us use all the bells
and whistles in most software anyway.

So it’s decided: you go out and buy a 512 MB
USB drive (this will cost you about Rs 1,650). You
should remember, however, that all the applica-
tions need to be crammed into 200 MB of space—
the remaining 300-odd should be kept free for
data. Small size is a priority, but as far as pos-
sible, you don’t want to compromise on features.
You also have to take into consideration the 

Must we really wait a few more years for anytime access to our
applications?

T

Life In A USB Nutshell
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possibility that the data you carry on the drive
will be shared, so all programs must work with
all common file formats, where applicable.

And so begins the hunt.

The Office Suite
While there are plenty of office suites out there
that could even fit on a floppy disk, hardly any
of them have support for the ubiquitous .doc
format, leaving only one choice: Portable
OpenOffice.org. Right from its excellent support
for all common MS Office formats, to its MS
Office-like interface that ensures that its users

don’t feel like lost
sheep, Portable
OpenOffice.org is
the office suite you
want to carry

around with you. It weighs in at 144 MB, taking
up a huge chunk of our limit, but when you con-
sider that it gives you practically everything that
your current 500+ MB (and very expensive) instal-
lation of MS Office does, it’s worth it.

The Word Processor
There are loads of people who install whole
office suites where a program or two would have

sufficed, but even if you
don’t need an entire gaggle
of office applications, you
will need a good word
processor—enter Portable
AbiWord. AbiWord has a
look and feel similar to
Microsoft Word’s, and

offers nearly the same features. So if all you need
is something to write and to edit documents on,
this 15 MB alternative is one worth considering.

The E-Mail Client
On one hand, there’s i.Scribe, a small, seem-
ingly simple e-mail client that fills up only 1
MB of space. It even comes with its own
Bayesian spam filter, and
is extremely light on
system resources. It’s a
stripped-down version of a
commercial product
called InScribe, and is lim-
ited to only one user pro-
file and one user filter.

If all you need is
something to
write and to edit
documents on,
the 15 MB
AbiWord is one
alternative worth
considering

At the other end of the spectrum is Portable
Thunderbird, which brings to the USB all the
features of Mozilla Thunderbird—e-mail,
internal support for RSS feeds, a spam filter and
a spell-checker. On the flip side, it occupies 9 MB. 

The Anti-Virus
Now you could be safe in assuming that you’re con-
necting your USB drive to a clean PC, but it never
hurts to carry an anti-virus
with you—just in case.
ClamWin is a free, open
source, 18 MB anti-virus that
comes from the ClamAV
team, who have been devel-
oping the Clam anti-virus
engine since the days of DOS.
Getting it to work off a USB
drive does take some time
though. You need to first
install it to your current PC and follow the instruc-
tions in the manual to set it up for USB drives.
Luckily for you, we’ve done the dirty work, and
you’ll find a ZIP file on this month’s CD, which
you just need to extract to your USB drive.

Remember, it isn’t a real-time or on-access
scanner, so you will need to start the program
and choose the file/s you want to scan.

The PIM
For busy individuals who need to keep track of
their tasks and schedules, EssentialPIM is a
very useful Personal Information Manager
(PIM), which looks a little like Outlook’s PIM
side. You can use it to create to-do lists,
schedule meetings and appointments, manage
contacts, and leave little notes to yourself—just
as you would do in Outlook, and the famil-

There are applications that boast about being
portable, and then there are more modest

applications that don’t talk about it so much.
For example, you’d think that Winamp would be
tied to one PC at a time, right? Copy the
Winamp program folder to a USB stick and try
to run it from a PC that doesn’t have Winamp,
and surprise, surprise—it’s portable! So if you’re
ever in the mood, go ahead and see if a
program you need is portable. And tell us about
it, too!

Some Homework
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iarity of its interface means that you need
hardly spend any time getting to grips with the
software itself. 

The Browser
There are only three browsers worth mentioning
today—Internet Explorer (IE), Firefox and Opera. 

For IE users, there is Crazy Browser, a 500 KB
browser that seems to be a heady mix of all three—
it uses the IE engine, but also brings in some cool
features from the other two, like tabbed browsing,

plug-ins (à la Firefox extensions) and mouse ges-
tures (quite similar to Opera’s). It even has its own
pop-up blocker and RSS reader. 

The same open source community that’s
responsible for Portable OpenOffice.org and
Portable Thunderbird also gives us Portable
Firefox, which is just that—a
fully functional USB version
of the Firefox browser,
including support for
installing the insanely pop-
ular Firefox extensions, but at
17 MB, you’re going to be
crunched for space.

Unfortunately, Opera hasn’t yet released a
portable version of their browser, but a few
intrepid users have tweaked the existing Opera to
make it capable of being run off a USB drive. You
can download it from www.opera-usb.com.
Remember, this is not an official release by Opera,
so if things go wrong, you’re on your own. 

The Media Player
Work or play, chances are you can’t escape
without encountering a sound or video clip
that needs viewing. Since we can’t guarantee
that the PC of the hour
has all the codecs neces-
sary for us to open the
files, we’ve decided on
VLC Player, which can
play nearly any audio
and video file in exis-
tence, and doesn’t
require any codecs to be
pre-installed on the
system. It’s a tad costly at
nearly 35 MB, though. 

Another option is
MPUI, a GUI for the pop-
ular open source
MPlayer. This, too,
doesn’t need any codecs
to be installed on the PC
you’ll be working on,
and it’s a lot lighter at 7
MB. In its current stage

it’s a little buggy, but definitely worth the 28 MB
you’ll save.

The Image Viewer
IrfanView supports a
huge number of image
formats, is light on
system resources, easy to
use, and can even convert
images to different for-
mats with some really
good compression ratios. 

The Newsfeed Reader
You still need to keep in touch with the latest
news when you’re on the move, and what
better way than with a good RSS feed reader?
GreatNews is a really good feed reader which
even integrates browsing via the IE engine. It
also comes pre-loaded with settings for many
great sites, including a vital Dilbert comic feed.

You can view the feeds in any style you
choose—be it simple text or a newspaper-like
appearance. And at 3 MB, it’s more than you’d
hope for.

The PDF Reader
While Adobe Reader is the de facto for reading
PDF documents, it’s bulky and is a resource hog.
Overcoming both these nags is Foxit PDF Reader.
It occupies only 2 MB of space, and is so light that
it even works even on PCs that are a couple of

On PCs with Windows XP and Service Pack 2, you can
bring up an autorun menu (just like the one for

CDs) for your USB drive, too! This is how we made an
autorun item for PStart, the portable Start Menu:
1 Open Notepad and type in the following text:

*[autorun]*
*open=PStart.exe* (This is the application that you
want to run through the autorun menu)
*action=Open your Start Menu* (This is a
description of the action that will be performed)
*icon=PStart.exe* (This is the icon which will be
displayed in the autorun menu)

2 Save the file as *autorun.inf* in the root of your
USB drive.

3 Now, every time you plug the drive into a PC with
Windows XP SP2, you’ll get an autorun menu that will
include the action you specified in autorun.inf.

Getting Your USB Drive To Autorun

While Adobe
Reader is the de
facto for reading
PDF documents,
it’s bulky and is
a resource hog.
Overcoming both
these nags is
Foxit PDF Reader
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years old. It also looks just
like Adobe’s Reader, so once
again, you aren’t going to feel
lost. We recommend this not
only as a portable applica-
tion, but as a credible
replacement for Adobe
Reader altogether.

The Start Menu
It isn’t fair that road warriors shouldn’t have the
benefit of a Start Menu, is it? PStart is a program
that sits in the system tray and gives you your
own menu that lets you choose which applica-
tion you want to run. It even hunts down exe-
cutable files on your
drive, so you don’t even
need to make any manual
entries—once you’ve put
all your applications on
your drive, just select the
“Scan for Executables”
function to create your
own portable start menu. 

You can find all these and
more portable software on
this month’s CD and DVD.

Packing It All In
Once you’ve decided on what you’re going to
put in your drive, installation is usually simple
enough. Most of these applications come as ZIP
archives, so all you need to do is extract them
to the drive.

For the ones that come with installers, you
could either install them directly to the drive,
or install them to your Windows drive and copy
the program folder from “C:\Program Files” 
(or wherever you installed the application) to
the drive.

The Next Step—The Mobile Geek
We have, of course, assumed that you’ll be
working on PCs with Windows loaded on them,
so you’ll still have to bear with whatever set-
tings the owner of the PC has kept in store for
you. If, however, you wish for the same com-
puting experience on every PC you ever sit at,
you could go a step further and put an entire
OS on the USB stick! We’re talking about Damn
Small Linux (DSL), a 50 MB Linux distribution
that fits more than neatly into a portable drive
(find it on this month’s DVD). “It’s probably got
no GUI,” you might say, before we tell you that
it does come with the FluxBox window man-
ager, as well as a host of applications including
the über-light Dillo browser. On the hardware
front, you will need a bootable USB drive (most
drives today are), and the motherboard of the
PC you’re working on must support booting
from a USB device. 

Of course, you will have to learn the basics of
Linux and get used to the user interface, but
once you do, every PC you ever work on will be
like your own. 

So with everything so eerily close to the ulti-
mate vision of on-demand computing, are you
still going to wait? 

nimish_chandiramani@thinkdigit.com
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A
picture speaks a thousand words, and it
is imperative to have a projector that says
all the right things about your sales
pitch. People make the common mistake

of believing that you can get away with a business
projector of average quality and less-than- perfect
rendition; after all, PowerPoint presentations and
Excel sheets do not need the precision com-
manded by the more expensive Home Theatre
projectors. That is a grave misconception. Just like
a hypnotist needs total silence to get into the
psyche of his subject, your projector, too, should
be free of any imperfections and artefacts that
can break the spell and reflect badly on your
presentation.

Fortunately for us, the ongoing war between
the DLP and LCD projection systems translate into
better and more advanced projectors at reduced
prices. What was high-end a couple of years ago
has now trickled down to the budget segment.  

Projectors today are based on the DLP, LCD,
LCoS and CRT technologies. With the LCoS and
CRT projection systems out of the scope of this test
due to their astronomical costs, choosing a busi-
ness projector boils down to a binary choice
between the DLP and LCD systems.

Current-generation DLP and LCD projectors
have benefited from refinements of key technolo-
gies, giving them better colour accuracy, bright-

ness, contrast, and resolution, which hitherto
were the sole prerogative of people with deep
pockets. That’s precisely why we at the Digit Test
Centre have put these projectors through a com-
pletely revised test process to bring forth the true
picture—warts and all.

Understanding The Features
A proper understanding of a projector’s features
and their relevance to your requirements is vital.
It is imperative to not be swayed by specmanship,
gimmicks and features that look good only on
paper, but do not justify the extra cost they entail.

Aesthetics
First impressions count. It makes a difference
when you whip out a well-sculpted projector, as
opposed to something with the aesthetic appeal
of a brick.

Resolutions
Featured in this projector shootout were SVGA
(800x600) and XGA (1024x768) resolutions. 

Choosing the optimum resolution is depen-
dant upon the kind of tasks you’ll be using the
projector for. SVGA is the way to go if you’ll pri-
marily be using the projector for graphs, movies,
pictures and presentations without intricate
detailing. However, if your projection needs
include fine text, computer desktop projection
and large spreadsheets, it would be prudent to
opt for the more expensive XGA projectors. 

In a world of cut-throat competition and low attention spans, a projector is the most potent weapon
to turn your ideas into business deals. We put eight business projectors to test

The Brightest
Bulbs In Town

Imaging  pradip ingale Photograph Sandeep Patil
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The immediate advantage of the XGA projector is
the small pixel size of the projected image, which
lends it a smooth effect as opposed to the blocky
SVGA detailing. Also, due to the increased number
of pixels, the amount of aliasing (jagged edges) in
geometric shapes is reduced.

All display systems except the CRT technology
are plagued with the problem of “Native Resolu-
tion.” This, essentially, is the default resolution at
which the projector will give the best image
quality. Even though it is possible to scale an SVGA
projector to display at XGA resolution, this will
severely affect image quality. Another important
factor is that DLP projectors have an inherent edge
over LCDs because they generally project a
smoother picture and do not suffer from the grille
artefacts seen in LCD projection systems. However,
LCDs are known for their sharpness and more pre-
cise focusing—but this very attribute leads to more
pixelation in movies and pictures.

Brightness
As a rule of thumb, it is advisable to get the
brightest projector that your budget allows.
Ambient light has a significant effect on the
brightness. As far as totally dark rooms are con-
cerned, you can get away with projectors with up
to a 1000 lumen brightness rating. Projectors with
a 2000 lumen rating are suitable for small confer-
ence rooms, where a little ambient light is toler-
able. High-performance projectors with 3000
lumens are ideal for reasonably bright ambient
lighting conditions. Such projectors are your best
bet if you happen to travel around to different
venues, where the audience, screen size and
ambient lighting conditions vary. These will save
you the embarrassment of poor visibility due to
washed out images. 

If, however, you want to cater to huge confer-
ence halls and auditoriums, you’ll have to consider
the ultra-bright range of projectors that starts at
3000 lumens and goes well over 12,000! You can
even try using high-gain screens, which can sub-
stantially increase the existing brightness levels. 

At the end of the day, you must realise that as
brightness levels increase, the precision of black
and greyscale levels decreases. A projector cannot
reproduce black well in bright ambient lighting
conditions. So if image accuracy is what you’re
looking for, we suggest a grey screen paired with
a good DLP projector and zero ambient lighting.

When it comes to light efficiency, an LCD pro-
jection system traditionally has the upper hand
over the DLPs. Also, the saturation levels of the
colour rendition of LCDs are better than DLPs and
hence their perceived brightness is much higher. 

Contrast Ratio
The contrast ratio is the least important feature
from the point of view of a business projector. It
refers to the ratio of the dynamic range between
the darkest black shade and the absolute brightest
white. A projector with a high contrast ratio is
capable of large number of colour gradations and
grey scales. Business applications such as simple
presentations, text, and graphs will not show any
improvement on high-contrast projectors. But
movies will. DLP projectors easily outclass LCDs
when it comes to accurate black-level rendition.

This is due to the reflective nature of the DLP,
which allows the tiny micro-mirrors to completely
divert the light away from the lens, to render per-
fect blacks with ease.

Weight
Business projectors need lightweight construction
along with portability. DLP projection systems are
generally lighter than their LCD counterparts, due
to the compact digital nature of a single micro-
mirror device at its heart, as opposed to the pop-
ular three-panel implementation found in most
contemporary LCD projectors. However, porta-
bility doesn’t come without its problems; the
catch is the lower brightness associated with com-
pact and lightweight projectors.

The Long And Short Of It
Different projectors ship with different kinds of
lenses—short and long-throw lenses. We cannot
comment about which is better because they cater
to different projection needs, and are more about
convenience than image quality. 

A throw distance is the measure of separation
required between the projector and the screen to
project a certain area of image. Projectors with

standard lenses need approximately two feet of
distance between them and the screen to project
an image of one square foot. 

Short-throw lenses, with their wider light dis-
persion characteristics, are able to project very
large images over short distances. Long-throw pro-
jectors, on the other hand, are optimised with
narrow dispersion characteristics to project
images over large distances without losing much
brightness. Most high-end projectors come with
replaceable lenses that let you convert them to
short or long throw on the fly. A short-throw pro-
jector is required in small conference rooms that
don’t have enough space to display large images.
Long-throw projectors are useful in large audito-
riums, where the projector needs to be placed well
behind the audience. 

Zoom Lenses
A zoom lens is a feature included in most projec-
tors for convenience. A typical 1.2x zoom lens will
give you a 20 per cent boost in image size, making
it very handy in cramped spaces. However, this fea-
ture is pretty much useless if the zoom offered is
digital, as opposed to the ideal optical zoom. Using
digital zoom will only degrade the image quality.

BenQ MP-610

When it comes to
light efficiency,
an LCD
projection
system
traditionally has
the upper hand
over the DLPs
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Projection Modes
It is desirable that the projector possess varied
projection modes to accommodate ceiling
mounting and rear projection orientations. Usu-
ally, a ceiling mounted projector needs to have
vertical inversion of the image to counter the
upside-down nature of ceiling mounting. The
rear projection modes require the projected
image to be inverted horizontally. 

Keystone Correction
This feature is used to correct the trapezoidal dis-
tortion in the geometry of the projected image. It
happens when the projector isn’t directly in front
of the screen. Ideally, any form of keystone cor-
rection should be avoided, because it stretches
and skews an image for correction, thus bringing
about degradation of image quality. 

Number Of Preset Display Modes
These come in handy when you need speed and
convenience over quality. Presets allow you to
flick between the high-brightness Presentation
mode and the totally different setting required
for movies. 

The Remote Control
A remote control with a full range of controls is
not just a feature but a necessity when it comes
to a projector, considering the nature of its
placement. A remote-equipped laser pointer and
mouse is a welcome bonus, which can make pre-
sentations a lot easier.

The Contenders
Of the eight projectors, three were XGA (1024 x
768) and the rest were SVGA (800 x 600). We clas-
sified them into two categories based on their
native resolutions. The present lot reflect the
improvement in LCD and DLP projection tech-
nologies, which have blurred the lines between
their stereotypical strengths and weaknesses. But
still, they weren’t without their share of faults
that low-cost projectors are notorious for.

Features
SVGA
Their low price notwithstanding, these were sur-
prisingly well-built, with an impressive list of fea-
tures earlier available only on the pricier models.
Today, you can buy a projector with a 2000
lumens brightness rating in this entry-level
SVGA bracket.

The Test Bed
The test bed had an Intel Pentium 4 3.2 GHz
processor, an MSI 875P NEO motherboard, 1
GB DDR 400 SDRAM and an ATi X850-based
video card. Windows XP Professional with
Service Pack 2 and 32-bit colour depth was
used, with the Windows and ATi-based
graphics enhancements and presets 
turned off.

Evaluation Pre-Setup
The tests were carried out in absolute
darkness with zero ambient light. In order
to keep the evaluation process fair, we
maintained a uniform size of the projected
image. Having a fixed distance would have
been unfair, since projectors have different
throw distances in accordance to the room
size specifications they are built for. Zoom
was set to zero, and great pains were taken
to do away with keystone correction
altogether, unless unavoidable, because
doing that reduces image quality. DVI
interconnects were given precedence over
D-SUB wherever available. We gave the
projector lamp 15 minutes more than its
rated warm-up time to ensure pure colour
rendition, after which the pre-test
calibration was executed. All projectors
were tested at their native resolutions with
a default refresh rate of 75 Hz. Attempts

were made to rectify tracking or phase
errors, if any. We avoided using the default
projector settings and instead calibrated
each projector to give the best fidelity
possible. A white projection screen 90x72
inches large was used for the tests.

Features
Here we focused on key features such as
brightness, contrast ratio, optical zoom ratio,
keystone, preset modes, fine picture and
colour temperature control etc. Interconnect
availability such as DVI, D-SUB, and S-Video,
was also considered. 

Another key feature is the weight and
dimensions of the projector, as business
applications need to consider portability
due to need for constant mobility. Special
features such as USB control port, an
inbuilt mouse, and remotes with Laser
pointers were given additional points.

The Tests
DisplayMate Video Edition
DisplayMate is a leading video evaluation tool,
which employs accurate proprietary test
patterns to evaluate image quality, as also to
reveal defects in video displays. We tested the
projectors using 26 relevant parameters such
as contrast, brightness, focussing, resolution,
moiré, colour gradation accuracy, purity,

streaking, black and white levels, blooming,
ghosting, flicker, etc. This gives a definitive
idea of the resolution accuracy and colour
rendition, and also uncovers serious flaws
which could easily be missed otherwise.

Picture Quality
Here we used our reference high resolution
bitmaps and Adobe Photoshop PSD files to
gauge the colour rendition and the detail
levels. The test images consisted of a variety
of real photographs and flat-shaded ones with
less colour complexity. Each image had a
characteristic feature which formed the basis
for benchmarking. These were instrumental in
gauging grille effect, colour gradation
discrepancies, impurity and most importantly,
the black level detail of the projector.

Presentation Test 
This test included a PowerPoint presentation
with pictures, graphs, and text of varying font
sizes and colours. Our main focus was the
readability of normal and inverted text, with
the graph and photo quality coming second.

Animation Test
For the animation test, we used professional
reference grade, imported DVDs of Shrek and
Spirit. Shrek was used to test the intensity,
colour-scaling, and the ability of the projector

How We Tested

HP-MP2225
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On the image size front, we had the Sharp XR-
10S and Epson EMP-S3 capable of projecting an
image up to 300 inches large, while the Acer PD-115
and Hitachi CP-RS55 managed only 200 inches.
What’s notable is the fact that we had LCDs such as
the Epson EMP-S3, which managed 1600 lumens
with a 135 W lamp rating, while DLPs such as the
Sharp XR-10S offered a 2000 lumen output at 270 W
consumption by the lamp. The LCDs are clearly
more efficient when it comes to the brightness-to-
wattage ratio. All the projectors we tested had a
native 4:3 aspect ratio, which can be scaled to the
16:9 required by DVDs—at the loss of screen space. 

As expected, the DLPs totally trounced their
LCD counterparts when it came to contrast ratios.
All the DLPs in this segment sported a high con-
trast ratio of 2000:1 as opposed to the measly 500:1
and 300:1 offered by the Epson and Hitachi respec-
tively. As a fallout, the black levels offered by both
the LCDs were below par, to say the least.

When it came to the aesthetic appeal of the
projectors, the Hitachi CP-RS55 exudes class with
its silver finish and a slim profile with contoured
edges. Its discreet buttons and everything placed
flush with its body goes well with the Hitachi min-
imalist theme. This was, beyond a doubt, the most
appealing projector we tested. Even though the
Sharp XR-10S was the bulkiest of the lot, it still
had a brilliant design approach making good
use of contours and bevelled edges to balance
its bulkiness. 

The BenQ MP610 is the aesthetic equivalent of
a brick; an ugly brick at that, with a cheap, boring
black finish. The lines, edges, button placement

to reproduce intricate details and
coloured lighting effects. The Spirit DVD
had a flat-shaded animation that helped
us to focus on a projector’s absolute
colour accuracy. Any colour
imperfections and gradation problems
were conspicuous with this DVD.

Movie Test
A movie test is significant because it
transcends the major differentiating
factor of resolution, because movies
themselves have a fixed lower resolution.
This allows us to evaluate the absolute
image quality irrespective of the native
resolution of a projector creating a level-
ground across all segments.

No professional video test can be
complete without the Saving Private
Ryan and Gladiator DVDs. We had
extremely rare, limited signature
editions of the same, which feature
phenomenal mastering quality, absent
on the regular prints. Gladiator can
pretty much bring any display system to
its knees with the amount of resolution
detail it holds, and features very hard-
to-render scenes with great colour
complexity. Saving Private Ryan is the
industry standard benchmark when it
comes to gauging the black-level detail,

and its wide array of muted colours
stress any video system when it comes
to accuracy of fine colour gradation. 

Both of them have certain key areas
where the colour wheel effect of DLPs
can be easily apparent, if present.
Another DVD used to test the projectors
was Corrs Unplugged, which has close
camera angles of the performers. We
used it to check the skin tone accuracy of
the projector. Its muted colours with
great black scaling are instrumental in
loading the DLP projection system
enough to show their inherent flaws. This
also has a high dynamic range of lighting
in each frame, which amplifies any colour
noise and intensity scaling problems.

However, the most significant was
the Corrs Live in London DVD, which
has the most amazing colour
complexity you’ll ever find, with a
rainbow spectrum of volumetric
lighting, lens flares, halos and an
onstage back panel with ultra-bright
psychedelic lighting effects. There are
passages where the screen goes into
extreme intensity of colours replete
with a staggering array of colour
blending. In fact, just one projector was
able to give acceptable levels of colour
accuracy with this DVD! 

As expected,
the DLPs
totally
trounced their
LCD
counterparts
when it came
to
contrast ratio
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and the grille effect surrounding the body reveal
a total lack of aesthetic sense.

The oddly-shaped Epson comes across as
trying too hard, with its overactive shapes and
contours. The Acer PD-115 is pretty average in the
looks department, with nothing substantial to
write home about—but tolerable nonetheless.

The build quality of the Sharp and the Hitachi
was excellent, which can be felt with the smooth
and progressive nature of their focus rings. The
quality levels were excellent, with a great tactile
feel to the buttons. The BenQ MP-610 had the
worst build and finish levels of the lot, with a
cheap feel to the plastic and an absolutely
dreadful jerking feel to its focus ring. This one
really feels built to its price.

The Hitachi CP-RS55 was the lightest of the
bunch at 2.2 kg, as opposed to the Sharp XR-10S
weighing in at a massive 3.9 kg. This completely
defies the notion that LCDs are bulkier when com-
pared to DLPs.

The lack of any optical zoom on the Hitachi
can be attributed to its weight-saving measures.
It only has digital zoom, which must be avoided
at all costs.

The Epson EMP-S3 has the highest optical
zoom ratio of 1.35:1. All the projectors had the
essential set of features—projection modes, key-
stone correction, preset modes, etc. The Sharp
led the pack as far as OSD usability and features
were concerned. We were impressed by the
wizard-like interface it used for troubleshooting,
which rectifies the display according to 
the symptoms you specify. This will enable 
even a complete layman to tweak his projector 
to perfection.

The Sharp had the most comprehensive, albeit
dull-looking remote, which could have done with
better button segregation.

The Acer PD-115 had the best remote of the lot,
with colour-coded keys separated intuitively by
button shapes and position. The remote can be
easily handled in the dark. 

The Epson EMP-S3 had the second-best remote,
with great button placement—it also offered a
thumb-stick for mouse control! The Hitachi’s
remote was brilliant, but was let down by poor
button quality. The BenQ shipped with the least
impressive card-type remote, which suffered from
a severe lack of buttons. The buttons required a
hard push to get registered.

XGA
The three XGA projectors we received for testing
had better build and finish quality, but were
lacking on features. Not surprisingly, due to our
(approximately) Rs 1 lakh price limit for this test,
we could only get the entry-level XGA projectors.
Their brightness ratings and other features were
thus on par with their SVGA counterparts.

The Sharp XR-10X had the upper hand with an
image size of 300 inches, with the Infocus LP-600
and HP MP-2225 coming in second and third
respectively, with 268 and 230 inches of max-
imum projection size. 

The brightness of the projectors was on par
with the SVGA models, the only exception being
the HP at 1400 lumens. The XGA models came
with the 4:3 aspect ratio, along with the capability
to display in the 16:9 mode. The HP MP-2225 had
the best contrast ratio of 2200:1; the 2000:1 ratio
of the Sharp XR-10X was similar to that of its
cheaper sibling. The Infocus LP-600 had the
poorest contrast ratio of 1000:1—surprising, since
DLPs are supposed to do better than that.

The diminutive HP was the lightest, weighing
in at just 1.1 kg. It was the smallest of the lot with
a dual-tone design reminiscent of the Sharp. If
portability is the criterion, look no further; they
don’t get any smaller than the HP projector. 

The Sharp XR-10X had the exact same shape,
size and build as its SVGA counterpart; the only
differentiating factor was the champagne-gold
finish this one sported. 

But our favourite design amongst these was
definitely the Infocus LP-600. Its LCD display panel,
aesthetically proportioned contours and button
layout all exuded a look that does justice to its
price. All these sported excellent levels of build
quality, with the Sharp once again beating the
competition to it. But it lost out to the lightweight
HP and Infocus, which weighed in at 1.1 kg and
2.4 kg respectively. The Infocus, however, clawed
back with a class-leading zoom ratio of 1.24:1, with
the Sharp and HP following, tied at 1.15:1. 

In miscellaneous features, such as projection
modes, keystone correction, and preset modes,
these projectors didn’t disappoint us. The Sharp
OSD was unbeatable in this segment too.

The HP MP-2225 disappointed us with its card-
like remote, which doesn’t bode well for an XGA
projector. However, it does offer mouse control,
and its keys aren’t too bad. The Sharp remote is
similar to its SVGA counterpart, which is a shame,

Hitachi CP-Rs55

Acer PD115
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considering the price you have to cough up for
the XGA model. The best remote so far is the
Infocus remote controller with its chunky build
that snugly fits the contours of your palm. But-
tons are neatly segregated and arranged on the
remote with a lot of air between them. There is
absolutely no way you can accidentally press the
wrong button.

Performance
Every projector we tested faced phase problems
with varying intensities, with both the Sharp pro-
jectors being immune to that artefact. The phase
problem, which is optic in nature, affects the
ability of the projector to define pixels properly
onto the screen. This results in the pixels being
rendered with varying brightness, with shifted
centres and banding across them. This seriously
affects the resolution of the rendered image, and
leads to other artefacts such as vertical and hori-
zontal banding. Some projectors had options to
adjust the phase, frequency and tracking con-
trols, but still, none of them could rectify these
issues. In fact, modern projectors placed a little
higher in the price segment come with the ability
to automatically correct these problems at the
push of a button.

The bottomline is that nothing can substitute
for good old precision engineering. If a projector
is built to exacting standards, it simply will not
have to deal with such artefacts. Such precision
was present in the Sharp line of projectors; nei-
ther of them had any such flaws.

SVGA
Since these are the cheapest projectors available
in the market, they are built that way too, with
the level of engineering precision not being up to
the mark. These projectors show optical issues
such as phase, tracking problems, vertical
banding, gradation, colour impurity and the char-
acteristic artefacts associated with the DLP and
LCD projection technologies. However, the overall
quality levels are still better than what you could
buy in the same segment just a year ago. To our
collective surprise, though, the Sharp projector
defied all pricing logic and put forth a perform-
ance that caught us unaware.

The Presentation Test
DisplayMate Video Edition
Most of the projectors here had issues rendering
blacks, and hence messed up the greyscale. The

Infocus LP-600

SVGA
projectors
show optical
issues such as
phase, tracking
problems,
vertical
banding,
gradation,
colour impurity
and
characteristic
artefacts
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Acer had acceptable black levels, but got oversat-
urated when the intensity was increased. The
BenQ wasn’t very keen on proper black repro-
duction and greyscales. All of them had varying
levels of colour shift, with the problem being
severe with the Epson. Every DLP projector except
the Sharp had problems rendering the colour gra-
dations and the blacks, and the subsequent
greyscales were plagued with impurities ranging
from bluish to red from one projector to another.
Even the LCDs weren’t spared, with the Hitachi
giving better results when compared to the
pathetic performance of the Epson.

The projectors with phase problems fared
poorly in the sharpness and resolution tests. The
Epson’s performance in this segment was at rock-
bottom levels, because its inherent problems pre-
vented it from rendering any of the test patterns
properly. The Sharp was the absolute winner in this
segment, followed by the BenQ. The Acer and
Epson had problems with focusing and resolution
detail at the corners of the screen. The BenQ, due
to its lower phase issues, scored very well in the
moiré pattern test, while Sharp once again aced
the segment with virtually non-existent moiré pat-
terns. The Acer, Hitachi and Epson saw a lot of
banding and moiré patterns.

In the colour and greyscale tests, the Sharp yet
again dominated the scene. The only place where
it faltered was the 16 intensity levels, where it
missed one colour intensity test. The LCDs in this
segment had a problem with streaking and
ghosting artefacts, and this was reflected in their
poor scores. The BenQ and Sharp showed great
resistance to black and white level shifting, which
means they can handle high dynamic ranges
much better. Not surprisingly, the colour tests saw
the Epson give better results, as colours are the
strongest points of LCD projection systems. It was
the same case with the Hitachi. The Acer per-
formed miserably in the colour segment, with too
much colour contamination and absolutely no
gradation accuracy in the 16 intensity levels
test. The LCDs performed well in the colour accu-
racy and purity tests, with the Hitachi coming
close to the excellence offered by the Sharp in
colour reproduction.

Choosing The Right Screen

You may buy a Rs 2 lakh projector, but it
will not perform as well if you pair it

with a cheap screen. As a rule of thumb,
20 to 30 per cent of the projector budget
should be allocated for buying a screen to
go along with it. Anything less than 20 per
cent of the total projector cost means that
you are not getting the full image quality
you paid for in the first place.

A projector screen, can, in fact,
compensate for the shortcomings of your
projector. For example, a high-gain screen
will compensate for the low brightness
rating of your projector, while conversely, a
grey screen with high contrast will enhance
the contrast ratio and enable your LCD
projector to render purer blacks. Basically,

“gain” is the measurement of reflectivity of
the projection surface. It is denoted by a
unit known as the gain number, which is the
ratio of the light reflected by a screen in
comparison to the reflectivity of a standard
reference white magnesium oxide board. So
a gain rating of 1.3 reflects 30 per cent
more light. Grey screens used for better
contrast have a negative screen gain
quotient like .80 gain rating which
translates into 20 per cent reduction in
gain, but at the added benefit of better
black reproduction.

Gain isn’t always good, however, as it
sees a lot of problems with directionality.
Since it has a reflective nature, it
significantly reduces the viewing angle of
the screen. The problem is more severe on

very high-gain screens with hot spots
apparent at the middle of the screen. This
makes the screen appear brighter in the
centre as opposed to the darker corners.

Quite simply, if your projector is lacking
in brightness, opt for a high-gain screen. If
it is plagued with low contrast issues, buy a
a high-contrast screen. Also, high ambient
light conditions warrant a high-gain screen,
because a high-gain screen will reject
omnidirectional ambient light and only
reflect the direct projector light.

LCDs generally have poor contrast
ratios and suffer at black reproduction; they
are therefore well mated with a grey screen
with low gain. A DLP, which traditionally has
better brightness and contrast, on the other
hand, can use both screens effectively.

The brilliant screen uniformity was evident in
the Sharp, while all the others had some issues
with brightness variation and noise across the dif-
ferent areas of the screen. No noticeable flicker
was apparent on any of the projectors. The Sharp
aced the difficult ANSI Brightness test, the most
amazing thing being its ability to distinguish
between 5 per cent brightness and contrast varia-
tion, which is even beyond the requirements of the
test, while being better than any other projector’s
capability. The BenQ failed the test due to its
inability to render finer black levels. The Epson’s
resolution and focusing problems were apparent
in the Defocusing, Blooming and Halo tests.

The Movie Test
The kind of high-grade test material we used for
these tests are very unforgiving when it comes to
colour inaccuracies. DLP projectors being digital
in nature cannot produce accurate colour grada-
tions if their image processor isn’t fast enough.
Every DLP projector had the previous generation
DLP engine; only the Sharp was endowed with a
state-of-the-art DDR DLP system with a really fast
3x colour wheel as opposed to the 2x colour wheel
the others had.

Also, the new fabrication process of its
improved DLP chip endows it with excellent
colour accuracy and variation across a larger
dynamic range. This was evident in its excellent

Sharp XR-10X
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performance across all the movie tests, with
superior black levels in Saving Private Ryan, to
richer and more detailed rendering of the Glad-
iator DVD. This projector consistently offered
more detail than the rest of the pack. All the
other DLP projectors were faced with colour
gradation problems, which made the bright
areas of the frame appear blocky with patchy
image rendition. This is the case with poor
optical performance of the low-end DLP chips.
Skin tone rendition was messy, with severe gra-
dation, by the Acer and BenQ in the Corrs
Unplugged DVD.

The high dynamic colours used in the DVD
brought forth a lot of noise from the Acer, BenQ
and Epson projectors. The Corrs Live in London DVD
brought all but the Sharp and Hitachi projectors
to their knees—the DVD was pretty much
unwatchable on the other projectors. Every-
thing—from the skies to lighting effects—was well
below acceptable levels, robbing all the fun from
the movie experience.

That’s why the rest of the DLPs, namely the
Acer and the BenQ, scored dismally in the movie
tests. Amongst the LCDs, the Epson was just as
bad, with the same problems plaguing it. The
noise levels were pretty high in the LCDs as com-
pared to the DLP projectors.

The Animation Test
The Acer and BenQ still faced the same colour
gradation problems even with the less exacting
standards of the animated movies that we tested.
The LCDs really showed an improvement in this
segment, mainly because they have very good
colour saturation levels for increased richness
and vibrancy. But the real star of this test was the
Sharp DLP, with its brilliant colour rendition and
detail levels.

Picture Quality
The combination of brilliant colour reproduc-
tion paired with pin-point resolution made the
Sharp the clear winner in this segment. Its
ability to resolve the tiniest detail along with a
staggering range of colours was a delight when
watching images. Next was the Hitachi LCD pro-
jector, which was found lacking only in the res-
olution aspect, which is very crucial for images.
Epson fared dismally due to its issues with
phase and colour accuracy. The Acer and BenQ,
too, gave a very blocky effect with brighter parts
of images.

Epson EMP-S3

XGA projectors
quite naturally
dominate the
image quality
benchmarks.
They have an
upper hand in
the picture
tests and the
text and
presentation
tests
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Scoreboard                             SVGA Projectors

Good features; 
portable
Average 
performance

Commendable 
performance
Average build 
quality

Low power 
consumption 
Poor 
performance

Good performance 
Low Contrast 
Ratio

Brilliant 
performance 
Bulky

Light and compact 
Could do with a 
better remote

BRAND
MODEL
Features (Out of 35)
Projection System (DLP/LCD/LCOS)
Native Resolution (Pixels)
Brightness (ANSI Lumens)
Contrast Ratio
Aspect Ratio (Native/selectable)
Optical Zoom
Zoom Ratio 
Image Size (Max - Min) (Inches)
Throw Distance (Min - Max Metres)
Lamp Power Consumption (W)
Lamp (Hours) (Nominal / Eco mode)
HDTV Comaptibility
Horizontal Frequency (khz)
Vertical Scan Rate (Hz)
Video Input (S-video, RCA, D-Sub)
Audio Inputs (PC Stereo, RCA L/R)
Speakers (Mono/Auto, W)
Control Terminal (USB)
Weight (kg)
Power Consumption Nominal (W)
Rated Noise (dB) (Max)
OSD Usability (So5)
Digital Keystone
Software CD
Remote Control
Soft Carry Case 
Performance (Out Of 50)
DisplayMate Video Edition 
Sharpness And Resolution (Out Of 32)
Horizontal Bar Resolution
Vertical Bar Resolution
Corner Resolution
Focus Matrix
Fine Focus Matrix
Diagonal Resolution Matrix
Moiré Pattern
Screen Pixel Resolution (Out Of 2)
Colour and Greyscale (Out Of 29)
Streaking And Ghosting
Colour Streaking
16-intensity Levels
White Level Shift
Black Level Shift
Red Colour Purity
Green Colour Purity
Blue Colour Purity
Miscellaneous Effects (Out Of 7)
Screen Uniformity
Flicker
ANSI Brightness And Contrast
Defocusing, Blooming And Halos
Presentation And Movie Tests (out of 30)
Text Quality (P Mode)
Reverse Text (P Mode)
Quality Of Photographs
Quality Of Animation (P Mode)
Movie Quality (Movie/Pres Mode)
Price (Rs)
Price Index (Out of 15)
Overall Score

BenQ
MP-610
25.00
DLP
800 x 600
2000
2000:1
4:3 / 16:9
4

1.15:1
35- 220
1.5 - 8
200
3000 / 4000
4

31 - 82
48 - 85
4/4/4
4/4
Mono, 2
4

2.72
285
29
3
4

4

4

4

32.21

21.03
3.63
3.38
3.38
3.13
3.13
3.00
3.63
1.35
20.78
3.88
4.00
2.25
4.00
4.00
3.25
3.88
3.75
3.88
3.00
4.00
1.00
3.38
17.4
3.75
3.13
2.88
2.75
2.50
68,000
11.03
68.25

Epson
EMP-S3
23.15
LCD
800 x 600
1600
500:1
4:3 / 16:9
6

6

30 -300
0.9 - 12.1
135
2000 / 3000
4

15 - 92
50 - 85
4/4/4
6/4
Mono, 1
4

2.5
200
28
3.5
4

4

4

4

20.41

6.18
0.75
0.75
1.00
1.13
0.88
1.00
2.25
0.65
16.00
2.00
2.00
3.25
3.50
3.00
3.00
3.75
3.50
4.35
3.25
4.00
3.00
1.25
13.65
1.75
1.75
1.50
3.25
2.75
52,500
14.29
57.85

Hitachi 
CP-RS55
20.12
LCD
800 x 600
1500
300:1
4:3 / 16:9
6

6

60 - 200
2.2 - 7.4
165
2000 / NA
4

15 - 91
50 - 120
4/4/4
6/4
Mono, 1
6

2.2
240
38
4
4

4

4

4

30.08

13.83
2.50
2.25
2.25
2.00
1.75
2.00
2.25
0.95
19.00
2.25
2.25
3.63
3.63
3.50
4.25
4.25
4.25
4.70
3.38
3.63
2.88
3.75
21.7
3.25
3.25
3.75
3.75
3.75
54,000
13.89
64.10

Sharp
XR-10S
23.88
DLP
800 x 600
2000
2000:1
4:3 / 16:9
4

1:1.15
40 - 300
1.4 - 12.1
275
2000 / 3000
4

15 - 70
45 - 85
4/4/4
4/4
Mono, 2
6

3.9
330
33
4.5
4

4

4

4

43.47

27.40
4.25
4.25
4.25
4.25
4.25
4.25
4.75
1.70
24.65
4.25
4.25
3.50
4.25
4.25
4.25
4.25
4.25
5.95
4.25
4.25
4.25
4.25
27.25
4.38
4.38
4.50
4.65
4.65
71,000
10.56
77.93

HP
MP-2225
24.43
DLP
1024 x 768
1400
2200:1
4:3 / 16:9
4

1.15:1
24 - 230
2 - 9.1
156
3000 / 4000
4

NA
NA
4/4/4
6/4
Mono, 1
4

1.1
285
32
4.5
4

4

4

4

33.38

20.25
3.50
3.50
3.50
3.00
2.63
3.25
2.63
1.20
19.55
3.25
3.25
2.25
3.75
3.75
3.75
3.75
3.75
4.88
3.88
4.13
2.13
4.13
20.9
3.75
3.75
3.50
3.50
3.25
1,15,000
11.48
69.30

Acer
PD-115
25.34
DLP
800 x 600
2100
2000:1
4:3 / 16:9
4

1.20:1
60 - 200
2.6 - 7.3
200
2000 / 3000
4

31-79
50 - 85
4/4/4
4/4
Mono, 2
4

2.3
250
31
4
4

4

4

4

23.55

12.50
1.50
2.25
1.50
2.25
2.00
1.75
2.50
1.50
15.80
3.25
3.00
1.00
2.25
2.25
2.25
2.25
2.25
4.45
3.50
3.25
2.63
3.50
12.85
3.00
3.00
2.00
2.25
1.50
52,499
14.29
63.18
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XGA Projectors

Compact 
Average 
performance

Brilliant 
performance 
Bulky

Sharp 
XR-10X
24.30
DLP
1024 x 768
2000
2000:1
4:3 / 16:9
4

1.15:1
40 - 300
1.4 - 12.1
275
2000 / 3000
4

15 - 70
45 - 85
4/4/4
4/4
Mono, 2
6

3.9
330
33
4.5
4

4

4

4

43.87

27.84
4.50
4.50
4.50
4.50
4.50
4.50
4.50
1.80
26.30
4.50
4.50
4.50
4.50
4.50
4.50
4.50
4.50
6.30
4.50
4.50
4.50
4.50
25.5
4.50
4.50
4.50
4.50
4.50
95,000
13.89
82.07

Infocus
LP-600
24.29
DLP
1024 x 768
2000
1000:1
4:3 / 16:9
4

1.24:1
33 - 268
1.5 - 10
200
2000 / NA
4

31 - 85
50 - 85
4/4/4
6/4
Mono, 3
4

2.4
260
37
3.75
4

4

4

4

23.87

11.00
1.13
2.75
2.00
2.13
2.00
1.63
0.50
1.05
13.88
1.25
1.50
2.38
3.50
3.00
2.38
3.50
3.25
2.28
1.50
2.25
1.25
1.38
19.55
3.25
3.25
3.38
3.38
3.13
89,000
14.83
63.00
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XGA
XGA projectors, quite naturally, dominate the
image quality benchmarks, where resolution is
the main criterion. They have an upper hand in
the picture tests and the text and presentation
tests. But when it comes to DVDs, they do not
make much of a difference to the image quality.
That’s why the movie test gives you a better
insight to the absolute quality of the projector
across the SVGA and XGA categories. This
segment didn’t have a single LCD projector.

Presentation Test
The Sharp XR-10X was the clear winner with its
superb well-rounded performance. The other two
were plagued with phase problems, with the
Infocus faring badly—its performance was com-
parable to the under-performers in the SVGA seg-
ment. Text quality was the worst with the Infocus,
with HP coming in second to Sharp. The graphs
and pictures were severely affected on the Infocus.

DisplayMate Video Edition
The Infocus LP-600 fared pretty badly with the
black levels. In fact, it was not able to produce any-
where near an authentic black. Even the white
levels had a lot of problems with definition. The
HP MP-2225, too, had below-average black levels,
but it was much better than the Infocus. The
Sharp XR-10x, like its sibling, gave outstanding
results with black and white rendition.

The severe phase and tracking issues of the
Infocus meant that it consistently under-per-
formed in the sharpness and resolution tests.
There was a lot of vertical banding apparent in the
resolution tests. The HP fared better here. The pin-
sharp resolution of the Sharp was so good that on
closer inspection, we found that each pixel was
rendered with absolute detail. This is absolutely
unmatched by any projector in this comparison
test. The Infocus ran into real trouble, with the
phase problems giving it the worst rating in the
moiré pattern tests across the entire test range.

The Infocus showed a fair bit of streaking and
ghosting, while the HP gave decent results with
not much of it apparent from the viewing posi-
tion. The Sharp, again, was flawless in this
respect. However, in the white and black level-
shift and colour purity tests, the HP and Infocus
were neck-to-neck with their scores, with only the
red colour having accuracy problems with the
Infocus. Both the HP and Infocus had issues ren-
dering the 16 intensity-levels properly.

The Movie And Animation Tests
The upper-end DLP projectors in this segment
showed better colour fidelity in movies and ani-
mation. In fact, they make movies worth watching
with the DLP artefacts only apparent during very

stressing passages of the Corrs DVDs. The Sharp XR-
10X quite naturally dominated the other two; note
that the improvement over its cheaper SVGA ver-
sion was quite negligible. In fact, even though the
XGA version of the Sharp showed slightly more
detail, we found the cheaper SVGA model to have
a slightly better accuracy at colour gradation. This
is because the lower pixel count (480,000 pixels) of
the SVGA panel of the XR-10S puts less strain over
the same image processor found in both the pro-
jectors, as compared to the higher pixel count
(786,432) of the XGA panel, which makes the
colour response sluggish. This was bought to the
fore by the Corrs Live in London DVD, with a small
amount of colour gradation problems visible in
the XGA model of the Sharp. The SVGA version ren-
dered the colours in the DVDs without a hitch,
even at the high-intensity passages, where all the
other projectors faltered. 

Picture Quality
The Sharp comes out tops with class-leading res-
olution and colour-reproduction. Both the HP and
the Infocus have their own problems with ren-
dering pictures, but ultimately the HP does beat

it by a small margin. The XGA projectors are ide-
ally suitable for displaying pictures due the sheer
resolution afforded by them. But projectors such
as the Sharp XR-10S SVGA show that a good SVGA
can easily beat average XGA projectors such as the
HP and the Infocus as far as image quality is con-
cerned. Higher pixel count can never be a substi-
tute for good engineering!

Conclusion
In the SVGA category, we had a total of five pro-
jectors. The Sharp XR-10S dominated with its bril-
liant performance and on-par features. Its striking
performance completely overshadowed its asking
price, and it gets the Digit Best Buy Gold. BenQ’s
MP-610 did put up a commendable performance,
but was no way near to what the Sharp had on
offer. If you’re looking for a projector for your con-
ference room, we’d suggest the Sharp XR-10S
despite its high price.

Since the XGA category had only three entries,
we did not think it wise to declare a winner. How-
ever, the Sharp XR-10X does deserve a mention for
its brilliant performance. The HP MP-2225 did per-
form adequately, but fell way short of the stan-
dards set by the Sharp projectors. 

readersletters@thinkdigit.com

Sharp XR-10S
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Contact Sheet Projectors
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Epson
Hitachi
HP
Infocus
Sharp
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Hewlett-Packard India Pvt Ltd
Genesis IT Innovations Ltd
Sharp Business Sytem Ltd

080-25219520/23
1600-220808 
022-23870897 
022-56341729 
95124-2566111 
080-41280666
011-26431313

080-25219535
022-25705235
022-56587115
022-56587475
95124-2566112
080-41280668
011-26438748

alankar_s@acer.co.in
SalesEnquiryIn@BenQ.com
dmaticscomputers@yahoo.com 
justzoomin@yahoo.co.in
saranya.rustagi@hp.com 
bob@gitil.com
anilsodhani@sharp-oa.com 
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Trend

The IT industry is highly knowledge- and
competency-driven and therefore, technology
requirements change every three years. Given

this backdrop, there is a constant demand from
customers for new skills. This means that
companies like TCS recognise the importance of
new certifications and continuously invest to
develop the competencies of its associates. 

A strong academic record forms an important
eligibility criterion in our selection process,
especially for fresh entrants. While recruiting
experienced professionals, certain skill-specific
certifications can help give a person an edge over
competitors for the job.

Normally, not many freshers obtain high-end
certifications typically covered by our certification
policy. Those who do have some certifications have
an edge over other applicants. Certifications
reflect the initiative of a candidate and his urge to
keep learning. This edge is important, given the
kind of competition that exists to get a job with a
preferred employer like TCS.

C ertifications are relevant for certain types
of jobs because they bridge the gap
between conventional education and

specific skill requirements. If you looked at
specialised professions like medical, legal,
insurance etc., certifications have been pretty
much the norm. Specific to the IT industry, we
see some commonly preferred certifications like
PMP for Project Managers, Cisco and Microsoft
certifications. Networking, database, Unix/Linux,
information security, and technologies like ERP,
data warehousing, storage, and supply-chain are
the common areas.

A certification does tell me that this
candidate is interested enough and serious
enough about the profession to put in extra
effort. But that’s just a foot in the door. The
hiring decision is eventually based on
demonstrated knowledge and the quality of
experience they have gained.

When we assess recent college graduates, we
focus on basics. For us, the key factors are
aptitude, verbal ability, reasoning, value system,
and technical knowledge related to what they
learnt in their stream of education.
Certifications may help them improve scores on
those, but cannot make all the difference.

A degree can be valuable, certification can
be valuable, but in the final analysis, you should
really know your stuff in-depth. If you are
absolutely clear what area you want to work on,
certification will be valuable. 

Eli Ramon
HR director, South Asia
Intel

S Padmanabhan
Executive vice president
Global head of human
resource development
Tata Consultancy Services
(TCS)
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ARE CERTIFICATION
When it comes to recruitment, different companies treat certifications—such as MCSE or
CCNE—differently. Some say it is important; some say it might make a difference; some
attach no weightage to such courses. Here's what five HR officials have to say 
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Ashok Reddy
Executive vice president
HR and corporate affairs
Infotech Enterprises Ltd

Certification plays a very significant role in the overall
assessment of a candidate. Depending on the post a candidate is
being considered for—say for a system administrator post—an

MCSE or CCNE certification carries considerable weight.
Certification recognises and validates skills, and helps the industry

standardise evaluation criteria: an MCSE from India or the US
identifies similar competencies.

In a country such as India with half a million MCAs and BEs, the
industry is in no position to absorb all of them. Only 10 to 15 per cent
are directly employable. Certification can be a differentiating factor. It
helps a generalist become a specialist. 

A B.E. or B.Tech. graduate can decide the line of work he wants to
pursue and then choose a certification course accordingly. The ADP
portal offers training for almost every certification currently
available, including some in areas such as payroll processing and
project management.

As far as recruitment of freshers to ADP is concerned, our entry
test evaluates basic quantitative, logical and programming capability.
According to the demand and supply situation, we may not be rigid
about a candidate’s aggregate percentage, provided the candidate
demonstrates the required competence. In such a case, certification
may give him an added advantage.

Bodapatti Balaji
Director 
ADP India Pvt Ltd

Agraduation in engineering provides the necessary background for a
fresher. Gaps in specific skills are bridged by on-the-job and internal
training. In the case of experienced candidates, yes, a certification

could be an added advantage—for example, an MCSE or CCNE for a systems
position, or an OCP for a database position. But we certainly don’t consider
these a substitute for relevant experience.

For a fresher, certification can perhaps guarantee an interview, but not
a job. His concepts as proved by his academics and performance in the
interview are more relevant. Let’s say we’re recruiting a Java resource; once
basic proficiency is established, the candidate’s attitude and willingness to
learn is perhaps more important than a Java certification. If he doesn’t
have one, our internal training process will more than make up for it.

Certification is probably the last thing one would consider in the
process of recruiting a fresher, and it’s definitely not a make-good for
average or poor academics. However, after three to four years of experience,
an employee can consider certifications such as PMP (Project Management
Professional) to move into a Project Manager post.

Nitya Nivali 
Senior manager - HR
Progress Software

As told to Philip Malayil (philip_malayil@thinkdigit.com)

Certification does not play a primary role in the recruitment process,
especially in the case of freshers. Infotech recruits only graduates
who have secured first class, that is, above 65 per cent aggregate.

Such candidates are then put through an entrance exam, a group
discussion, and two levels of interviews. Apart from this, their final year
project is of importance. Even if it’s a dummy project, what the candidate
has learnt from it is important. Following all these considerations are soft
skills such as communication and team dynamics. 

It’s only after these criteria that certification comes into consideration.
Other parameters being the same, a certified candidate will probably stand
a better chance. However, in the case of freshers, our in-house training is
good enough to impart the necessary job skills.

Some clients do mention a preference for a particular number of
certified candidates in a project, but there are often experienced members
in the team with the required profile.

Of the 300 freshers we recruited in 2006, very few possess any
certification.

COURSES A VALUE-ADD?



Philip Malayil

hen Garfield wakes up to press the
snooze button—or closer home, when
Fido Dido checks out the beach scene—

much labour has been expended to add life to, or
animate, those 24 frames that move in front of
your eyes in a second. Animation is traditionally
associated with big Hollywood studios, but
according to a NASSCOM report released in Jan-
uary 2006, India’s animation industry is
expected to reach revenues of Rs 4,223 crore by
2009, from the 2005 figure of Rs 1,270 crore.

Why India?
Wage levels for animators in offshore countries
are attractive to production companies and
movie studios looking to save a penny. Billing
rates last year for animation work in India
ranged from $2,000 (Rs 90,000) to $5,250 (Rs 2.35
lakh) per minute for two-dimen-
sional animation, and between
$4,500 (Rs 2 lakh) and $7,000
(Rs 3.15 lakh) per minute of

The animation
industry is
associated with
much glamour
and more money.
But what is the
scene really like
for a doodling
career?

work for three-dimensional animation films.
Rates in the US and European markets are in the
$17,000 to $25,000 (Rs 7.7 to 11.25 lakh) range.

Analysts estimate that Indian companies
have won some $50 million to $100 million (Rs
225 to 450 crore) in business, a small slice of the
$10 billion (Rs 45,000 crore) global animation
industry. But that could change, as major US stu-
dios such as Disney, Warner Bros Studios and
Metro-Goldwyn-Mayer, who previously have
done much of their animation in-house, try to
cut costs. Companies such as UTV Software Com-
munications (UTV), Toonz Animation and Crest
Communications are leading the way.

For those looking out for careers, these fig-
ures offer comfort. But let not the moolah drive
you where talent does not! If you’ve spent your
school days doodling cartoons of the maths
teacher rather than listen to his ramblings on
trigonometry, and your classmates have cheered
not when you got caught but at the canny like-
ness of your toons, animation might just be the
field for you.
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The Path To Toondom
The traditional path would be to graduate in
Fine Arts from a school such as Mumbai’s JJ
School Of Arts and apply for a trainee position.
India’s premier design school, the National
Institute of Design (NID) Ahmedabad, has a two-
year post graduate course in Animation Film
Design. Entrants typically have to be graduates
in Fine Arts, Applied Arts, Design, Architecture,
Communication Media, Film & TV, or Mass
Media, or graduates with experience in the ani-
mation Industry. But with just 10 seats in the
program, competition is fierce. 

Akhil Succena, activity chairperson, educa-
tion, NID, says, “Since this is a post-graduate
course, we expect some level of proficiency. An
applicant has to present a portfolio as part of
the admission process. This criteria leads to
people already working in the sector such as
‘in-betweeners’ and others to apply.” According
to Mr Succena, an NID animation diploma
holder typically starts off at a salary of
Rs 30,000 per month.

For a beginner, options include private insti-
tutions such as Arena and Zee Institute of Cre-
ative Arts (ZICA). According to Atul Vohra,
country head, Arena Multimedia, “The anima-
tion industry has a current requirement of at
least 50,000 trained persons. Only 20 per cent of
this is presently fulfilled. This translates into
almost 100 per cent placement and entry-level
salaries of Rs 10,000 per month.” We ask Vohra
about what makes a skilled animator. “The
ability to express oneself through drawings and
acting is the fundamental requirement. Com-
puters only provide a tool.”

According to Mr Vohra, getting carried away
by the “cool factor” associated with animation
is easy. But success in the field needs talent and
application. The two Arena training centres in
Mumbai have only 40 seats each, and every
applicant undergoes a screening process before
being admitted. 2D animation is covered in the
first year and 3D follows suit. The course fees
of 1.8 lakh per annum also might deter the
casual hobbyist.

And it’s not all software training, either.
About 50 per cent of the classes are on drawing,
anatomy, study of motion, acting and cine-
matography. Software such as Toon Boom, Solo
for 2D, and 3DMax and Maya for 3D follow.
Composition is taught on Combustion, while
Flash and Photoshop complete the package.

In a typical animation set up, the roles
include the storyboard artist, audio specialist,
character designer, background artist, in-
betweeners and the key animator. Of these, the
key animator designs the first and last frames
of a 24 fps sequence. “In-betweeners” fill in the
gaps. While students at Arena are exposed
to every function during a course to figure
out what fits them best, Mr. Vohra recom-
mends the talented ones to focus on the role of
Key Animator.

A Reality Check
Many institutes also offer shorter six-month
module-based courses which, though cheaper,
may also be riskier. Be warned that in a country

like ours, the demand-supply equation is tilted
in the direction of the employer. A typical
example is that of Sindhu Nair from Mumbai,
quoted in a Wired News article:

“Nair’s father owns a small shop in
Mumbai. Although he earns about Rs 11,000
every month, he had great dreams for his 22-
year-old daughter, Sindhu. After reading count-
less articles in the papers, he was sold on the
great IT revolution. He borrowed money
and paid about Rs 31,000 for a six-month ani-
mation course. 

“Nair completed the course, but spent
another eight months looking for employment
before finally landing a job in the field that pays
Rs 900 per month.” 

The Industry-Side Story
When The Lion, the Witch and the Wardrobe was
nominated for an Academy Award in visual
effects, there was rejoicing in the Mumbai sub-
sidiary of the California-based animation studio,
Rhythm ’n’ Hues, because part of the animation
process was completed here. We asked Rajesh
Pai, technical director, about what this means
for the sector in general and jobs in particular.
His answer: “The visual effects industry, though
at a very nascent stage in India as compared to
the global scenario, is witnessing rapid growth.
Naturally, there will be an increased demand for
talent to meet the requirements.” As for the
areas of critical requirement, says Mr Pai, “By its
very nature, this work requires talented indi-
viduals with a background in art and with cre-
ative sensibilities.

“While most people only see the opportuni-
ties in the artistic field, very few people consider
the technological challenges that this industry
presents. All this creative magic—animation,
visual effects—would not be possible without the
amazing technology behind it. The requirement
for technical people is equally, if not more, crit-
ical for the industry. There is definitely a
demand for technology professionals, both on
the hardware as well as the software side. We, at
Rhythm & Hues Studios for example, are a totally
Linux-based facility. We are constantly on the
lookout for Linux professionals to grow our tech-
nology team.”

From an industry perspective, Mr. Pai says
that irrespective of one’s training, it has
become an accepted norm that resources need
to be trained and developed in-house for them
to be productive in a real-life production envi-
ronment. The key factor, therefore, in
selecting candidates, is the spark of intelli-
gence and passion.

Software are just
tools. Anyone can
learn to use them.
The essence is to
have the inherent
creative talent to
be able to use
those tools to
create works
of art”

Rajesh Pai
Technical director
Rhythm & Hues Studios
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Mr. Pai advises aspirants to the field, “One
would like to dispel the common misconception
that getting into the animation or gaming
industry requires one to learn or gain expertise
in the latest versions of imaging software. The
fact is, the various software are just tools.
Anyone can learn to use these tools. The essence
is to have the inherent creative talent to be able
to use those tools to create works of art. That is
what students should concentrate on.

“Technology professionals should also
widen their horizons and look at the wonderful
opportunities that this industry provides,
rather than following the herd into staid
careers in programming with software giants.
As the industry grows, their careers will grow
proportionately.”

Rajesh Turakhia, CEO of Mumbai-based
Maya Entertainment Ltd (MEL), which also has a
training division, the Maya Academy Of
Advanced Cinematics (MAAC), says, “Out-
sourcing projects for TV and film typically
extend over a period of two to three years.
During this period new projects keep coming in,
which require more manpower. According to
Turakhia, when 2D ruled the roost it was Korea,
China and the Philippines which were locations
of choice. “But India, though a late entrant, has
managed to gain ground in 3D. Also, we appre-
ciate the American sense of humour and timing
better,” adds Turakhia.

“3D is where the action is, and aspirants
should consider this avenue. Growth is only lim-
ited by one’s creativity. From a starting salary of
Rs 8,000 per month for a trainee, three years can
see one taking home Rs 75,000 per month as a
Team Lead,” informs Turakhia.

Turakhia’s advice to young aspirants: “Ani-
mation, the universal language, can form the
skill set for a serious career. Apart from enter-
tainment, opportunities exist in sectors such as
education and architecture. Considering
the potential of the industry, a well-thought-
out decision should be taken by parents and
youngsters.”

Micheal Laxman, member of the technical
team at MAAC says, “This is the field for those
who are fascinated with visual effects.” Though
proficiency in drawing or sketching is a welcome
pre-requisite for the one-year course the academy
runs, they have a month’s foundation course for
those lacking the basics. The Maya course covers
areas of 3D animation, visual effects and editing
for film and TV.

According to Laxman, of the 300-odd stu-
dents who pass out of the institute, 12 have been
placed with MEL. Towards the end of the year,
this figure is set to go up to 100.

Hotting Up
The animation industry is getting ready for more
projects and revenues. Avenues for the display of
talent are coming up. 24FPS—an animation film
festival organized by MAAC—is scheduled for
April, and invites entries from across the
country. In a creative field, the need for recog-
nition is high, and these are avenues for hidden
talents to make themselves known.

The message seems to be to look beyond 
the glamour and fancy salaries and take a leap
into the field only when one is convinced 
about talent and the ability to use the medium
to communicate. 

philip_malayil@thinkdigit.com

l NID, Ahmedabad
l Aptech-Arena
l Zee Institute Of
Creative Arts: 3-year
diploma in Animation
l Industrial Design
Centre (IIT Mumbai,
IIT Guwahati)

l National Multimedia
Resource Centre -
CDAC Pune 
l Toonz Animation
Academy, Trivandrum 
l Toonz Webel
Animation Academy,
Kolkata

Institutes

3D Layout / Background Artist
The layout / background artist must be
an excellent cartoonist, capable of
following the basic design of
characters. He needs to research
costumes, architecture, and landscapes.
Sound knowledge of perspective and
composition is essential. 

3D Character Animator
Should have mastered the mechanics of
animation (squash and stretch,
overlapping, anticipation, timing, weight,
body dynamics, secondary motions,
etc.), and should have versatility in
animating various styles of characters.
Should be proficient in acting theory and
practice. Fine draftsmanship is essential,
as is the ability to make humorous
drawings and actions. 2D key animation
skills are essential.

3D Modeller / Rigger
Character Modellers: Should be able to
model organic and complex forms. Must
be proficient in polygon modelling, and
should understand texturing and
rigging requirements. 

Sets Modellers / Props Modellers:
Should understand texturing
requirements, and should have a strong
sense of proportion. 

Rigging Artists: Should be able to
design strong interactive rigs and
simplify complex animation tasks.
Should have good understanding of
anatomy. 

3D Special Effects Artist
Must possess a strong sense of
dynamics. Should be able to visualise
and render natural phenomena such as
fire, water, smoke, cloth, etc. Should

have strong technical problem-solving
skills, and know all the special effects
tools and software. 

Lighting / Texturing Artist
Must understand how to set scene mood
and feel. Should be able to deliver
photo-realistic frames. Must possess a
minimum experience of one year.

Compositor
Should have knowledge of colour
correction, masking, tracking and wire
removal. Proficiency in online editing
software is required.

Programmer
Should have Knowledge of MEL
scripting, C, C++, VB, Perl Scripting,
the RenderMan Shading Language,
XSI and Maya.

Career Profiles In The Field Of Animation

Digital Business l Tech Careers
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Jyotsna Rege

Much of rural India lives in
what can be termed
“Media Darkness”—where

people do not have access to facil-
ities like television or radio, and in
some places, there’s no access to
newspapers either. Lack of access
to information has been one of the
impediments to development, and
lack of development, in turn,
further alienates the rural sector.
In a bid to breach this vicious
circle, an initiative called Project
i-Shakti has used technology to
provide information based on

demand, via a network, to villages
in the state of Andhra Pradesh. 

Where It All Began
Hindustan Lever Limited (HLL)
began a programme for rural
empowerment called Project
Shakti. Project Shakti aims at
creating entrepreneurial opportu-
nities in villages all over India so
they do not need to rely on agri-
culture alone for their livelihood.
Most of the individuals who have
registered with the programme
are women, and are called the
Shakti entrepreneurs.

“When Unilever developed an
interactive dialogue technology,

Technology Beyond Work
Leisure
Digital

we considered its purposeful
implementation and integration
with Project Shakti. Thus was born
Project i-Shakti. We decided to
begin the venture in AP as the
state had already initiated an e-
Seva programme, and we tied up
with them to launch the services
we had conceived under i-Shakti,”
says Rohit Harirajan, head of
the project.

What Is iShakti?
The i-Shakti venture seems simple
enough when stated out aloud: it
is a kiosk-based interactive
dialogue system that contains a
computer terminal and offers free

Bridging The Gap
At some
villages in
Andhra
Pradesh,
illiteracy is
no more an
impediment
in the quest
for inform-
ation

152130 The Terrible
Call

Skyping
Penelope Cruz126 Is Piracy

Good?

Touched By Tech
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on a computer rather than
employ a kiosk owner as the
interface between the technology
and the user. Hence, the project
emphasised on using a voice- and
video-based system, and uses
“rich media”—software designed
using Macromedia Flash—besides
being database-driven, so that all
the intelligence can be built on it.

A voice system would elimi-
nate the necessity for the user to
read off the screen, hence  making
it easier for an illiterate user. It
was also important to have a
system that would allow the
central servers to connect to these
kiosks through the barriers of
poor Internet connectivity, and
enable large volumes of rich-
media files and information to go
back and forth between the
Mumbai office and thousands of
such kiosks on an everyday basis.
Finally, the users   had to be taught
to use and understand  what they
stood to gain by  using the system,
besides being trained to use the
mouse and keyboard. 

Each i-Shakti kiosk is owned
by an individual, and it comprises
a desktop PC system that operates
independently of all other kiosks
on the network, but is connected
to the central server to which it
can synchronise data through a
dial-up connection. The i-Shakti
software needs to be installed on
PCs with suitable configurations. 

Once deployed on the PC, it
acts as a kiosk, and the owner of
the kiosk is expected to synchro-
nise the data and transfer it to
the central server once a day. The
kiosk owner also helps new users

informational services aimed at
education and community devel-
opment in rural India. The aim of
the project is to create an IT-based
rural information service so that
the population has access to criti-
cal information via the Internet,
such as updates on farming prac-
tices and hygiene. In view of the
fact that Andhra Pradesh (AP) has
a total of 7,500 predominantly
agriculture-based villages, the
task at hand was monumental.

YonEarth interactive, a
Mumbai based IT-

enabled marketing
solutions company,
was hired to design,
develop and

manage the venture.
“Every one knew

it was an extremely
uphill task,” says Vivek Marolli,
Director, YonEarth Interactive. “It
was completely untreaded terri-
tory. Making such an ambitious
project work in far-flung villages
across rural India, under difficult
conditions such as sporadic power
supply, heat, dust, poor computer
literacy and almost non-existent
or very slow Internet connectivity,
would indeed be a challenge. We
had to design a system that would
beat all these barriers and work in
ways that were never thought
possible before.”

After a study of the require-
ments for the project, and a year
spent on designing and building
the software, the system was
ready to be launched.  While
building the ICT—the Integrated
Circuit Technology—the aim was
to have a villagers get their hands

Making such
a project
work in far-
flung villages,
under condi-
tions such as
sporadic
power supply
and poor
Internet con-
nectivity
would indeed
be a chal-
lenge
Vivek Marolli
Director
YonEarth
Interactive

register and guides them when
they use the system. The central
server communicates to thou-
sands of such kiosks through a
specially-developed Compressed
Data Synchronization-based
Dialogue Technology, which
allows the kiosks to work in
offline mode. This reduces the
cost of operations to the kiosk
owner, and at the same time, he
can connect to the Central Server
every day for two-way data
updates. Technical support
teams, which have been set up all
over AP, also monitor and solve
any problems on the kiosks
within the state. For every forty
kiosks, there is a technical
manager who tackles any  prob-
lems that the kiosks face.

Currently, every one of the
i-Shakti kiosks in AP has various
channels of interactive rich-
media information created by
culling various sources such as
opinions of agriculture experts,
the Internet, and government
agencies, on topics such as
health, agriculture, animal
husbandry, education, employ-
ment, women’s issues, and enter-
tainment. As a registered user,
one can visit the i-Shakti kiosk in
his village six days a week and
access information and
services. Since there are
experts who are a part of
the project—some on a
payroll and some volun-
tary—the villagers can
also post questions on a
query mailing system.

Why i-Shakti?
How is such information critical
to the villagers? Well, most
villages are isolated and inde-
pendently-functioning entities,
and they rely on their existing
means of information and
resources to aid their everyday
activities. This implies that in
case of an illness, they have access
only to a local doctor, and possi-
bly no chance at a second opin-
ion. With i-Shakti, the villager has
access to information that comes
to him from a recognised govern-
ment source, and is an authorised
voice—most of the experts on the
panel of i-Shakti are people
employed with various agencies
all over AP. For example, the
expert on wheat might be an agri-
cultural scientist at the University
of Vijaywada. Besides, the infor-
mation is free, and one can gain
insights in any  developments in
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a  particular  section such as
health or employment right from
the kiosk in his village.

The i-Shakti system is
designed as an easy to use, “talk-
ing” voice-based system in
Telugu, the state language. All
information on various topics is
in the form of audio or video, and
the user does not necessarily
have to read off the screen. The
graphical user interfaces are
designed such that icons speak
when a mouse is scrolled over
them. Once a user knows what
area he wants information on, he
can click the relevant icon for
further information.

For example, on the Agricul-
ture icon, there are subsections
titled Wheat, Paddy, Cotton, and
so on. Once a user scrolls over an
image of, say, cotton, a voice
announces the name of the crop
in Telugu. He can then click on

the Cotton icon to access infor-
mation on types of cotton,
seasons for growth, pest control,
fertilisers, and so on. 

“We have avoided making the
Internet available to the villagers
to keep costs down. The Net
is only used to synchronise
data and mail it to the
office in Mumbai. We
monitor each and every bit
of information that is
passed back and forth and
between user, expert and kiosk
owner. Even this data comes in
during the synchronisation.
Hence, we can keep a tab on
everything from our office in
Mumbai and run things effi-
ciently,” says Marolli.

How each member uses the
data is also tracked and recorded.
The system is constantly moni-
tored for the most frequently-
visited sections and the duration

of the visits. Based on usage, there
is a lucky draw each month for
the person who uses the system
most efficiently. Besides, relevant
offers and rewards are given to
other  users who use the system
effectively. For example, if a
member visits the Education
section regularly, he might be
offered a discount on stationery
or books. This offer directly
appears on the computer screen
when the user logs in, and this
system encourages members to
use the system. Besides, the fact
that the information is free is an
incentive by itself.

In less than six months since i-
Shakti’s launch in September
2005, the network has grown to
about 970 kiosks in 21 districts in
Andhra Pradesh, with a registered
customer base of 1.5 lakh users. 

One of the kiosk owners, Shan-
tamma, says, “The programme has
created a stir ever since it began.
We have people from all age
groups using the system. Practi-
cally all are registered users, and
we have six to seven users coming
in every day.”

“The system is designed such
that it can be set up and config-
ured for use in different
languages. The groundwork has
been laid to take the initiative
forward,” says Marolli.

The people of Nallagonda, AP,
where the first kiosk was set up,
are not unaware of the opportu-
nity that is at their doorstep
today. Provided with resources,
these people are apt to make the
best use of them. 

jyotsna_rege@thinkdigit.com

An i-Shakti kiosk set up in the owner’s house
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Agent 001

W e’ve seen quite about
enough news on soft-
ware pirates being

tried. If it’s not a 10-year-old kid
being sued by the RIAA (Record-
ing Industry Association of
America), it’s lawsuits against
the developers of P2P networks
and Web sites.

Although I buy all my soft-
ware, or just use freeware, I don’t
think you can completely stop
people from pirating software—
considering that many software
products cost more than the
average PC today! There will
always be two types of software
programmers: the creators and
the crackers! There will also
always be two types of end-users:
the haves and the have-nots, or
more appropriately, the will-
nots. Rather than get into the
undecidable ethical debate
about “to crack or not to crack,”
let’s stick to software piracy and
the effects it has on the industry.

It’s Easy, It’s Fun, It’s
Illegal!
Most of us in India have a lot of
pirated software on our com-
puters, and part of the reason is
that we really cannot afford to
pay for even software that’s
cheap by American standards—
$10 is Rs 450! Obtaining work-
ing software has become the

simplest thing on earth—just go
to a download site such as
www.download.com, download
the software, and then hit
Google or Yahoo! Search, look-
ing for a crack.

You’ll almost always find
what you’re looking for (you
know what I mean…) in a flash;
download the crack, and you
instantly become one of the
millions of software “pirates”
across the globe. A lot of us don’t
even know it’s wrong!

Take for example of the e-
mails I get every day: at least two
of them per day are from read-
ers asking me to provide them
with a serial key or download
link to a “patch” for some well-
known software or the other!
When I politely reply to these
people informing them that this
is against the law, and if they
really like the software that
much —if it is that useful to
them—then perhaps they should
consider buying it, here’s a taste
of what I get as responses…

“… my system assembler can
give it to me for free, but he is
out of town so I asked you…”

“It’s illegal? But my friend
has it… it came with his
computer; and his computer
itself costs less than that soft-
ware… if he didn’t pay why
should I?”

“Do you seriously expect me
to believe that you do not
pirate yourself?”

“Never mind, I found the key
myself… thanks for nothing!

You’re Breaking The Law
It’s important to realise that by
downloading a crack for a soft-
ware, or using someone else’s
licence key to unlock a software,
is illegal. Laws across the globe
vary, but generally, the punish-
ment could be a hefty fine and/or
jail time.

Oh Shush, You Little ****
Activist! Piracy is Good
That is what was said to me
when I recently chided a
female friend who called me
to ask for a “free” version of a
very popular (and expensive)
image editing software! The
verbal abuse did not ruffle
me—I’m used to that—but her
statement, “Piracy is good,”
left me speechless.

A lot of muttering and
stammering and hurled abuses
later, things calmed down a bit
and I got down to asking her
how exactly piracy was good,
and for whom.

“Not unless you buy me
coffee and get me that software,”
she teased. Long story short, I
took her out for coffee, but made
sure she got someone else to do
her piracy work.

Here’s what transpired:
Me: So how can piracy be good?
Good for you, yes, but not good

Imaging Pradip Ingale, Shrikrishna Patkar Photograph Jiten Gandhi

Is Piracy Good?
And we’re
not talking
about the
end-user;
we mean
for
software
vendors
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tell me why software companies
have not made un-crackable soft-
ware products till date?

Me: Because they can’t, but they
will probably be able to do so
soon enough!
She: Wrong! They haven’t
because they just do not want to!
Do you seriously believe that they
couldn’t, at the least, make it a
lot harder to crack software? I
mean, how come a crack or patch
is available in a week from when
the software is released? There
has to be more than just a simple
“they cannot” answer to this.

Me: No, it’s because software is
made by humans and thus it is
crackable by humans!
She: Oh come on, don’t be so
naïve. Look at the bigger picture!

Me: There’s a bigger picture? I
thought software vendors losing
billions of dollars was the bigger
picture!
She: Fine! Let me use an example
to make you understand!

Me: Oh this ought to be good…
She: Shush! Ok, let’s say
Microsoft makes a Windows ver-
sion that is un-crackable. Let’s
say it’s Vista for this example.
What happens then?

Me: Everyone buys Vista?
She: Nope, a lot of people start
using Linux! Lindows, SuSE,
Ubuntu, you choose.

Me: It’s Linspire!
She: Oh whatever, correct all the
little mistakes if you wish, but
that’s the truth! Seriously, con-
sider how so many people today
have at least tried a Linux dis-
tro—live or dead! Don’t you think
they’d either just stick to using a
pirated version of Windows XP,
or just use a newer Linux distro?

Me: Umm… maybe. But we’re
talking majority here, not the
minorities.
She: Minority? Why do you
think so lowly of us? I’m no
techie, but even I’ve installed
Ubuntu and tried it out. Sure,
some things I just could not
fathom, but for my kind of work
it really made no difference
what OS I was running! I found
OpenOffice.org to be just as sim-
ple to type out reports in as
Microsoft Office!
Me: True, I use it too.

for the poor developer or for our
economy!
She: Nope. Piracy is good for the
software developers themselves.
I mean, it’s also good for me, but
it’s a lot more beneficial to the
big software companies.

Me: Oh really, how? Do you
KNOW how many billions of US
dollars of profit they lose
because of piracy? It’s like 5
billion a year or something!
(That was a complete shot in the
dark!)
She: Sure, but how many billions
more do they make with sales?

Me: Oh, that’s not a valid argu-
ment; it’s like saying that since 3
lakh Indians pay tax, why should
the government want tax from
the rest of the population?
She: No, taxes are different. You
have to pay them, but when it
comes to software, I don’t have
to use it; I could choose to be
like you and not use paid soft-
ware at all!

Me: So why don’t you?
She: Because I’m keeping the bal-
ance of good and evil in the
world! What do you think,
dummy? It’s because there are
popular software that are easy to
use and the not-so-popular free-
ware that are a lot harder to get
used to! I like to keep it simple.

Me: So piracy is justified for you
because you’re lazy?
She: No. Piracy is justified for me
because I want to use the same
software at home as I do at work.
My company will not buy me a
copy for home, so I pirate it!

Me: Wha… huh… umm… that’s
the most idiotic thing I’ve heard!
Why can’t you just use logic and
listen to what you’re saying!
She: What I’m saying is logical.
You just cannot grasp my logic.
Perhaps you should buy us a
couple of coffees more and I will
waste another half hour of my
time trying to put this in baby
talk.

Me: (Mumbled) ****####*******
She: Now get the coffee or I’m
going back to my office!

Me: *sigh*
10 minutes later…

She: (slurps another free coffee
and continues) Ok look; can you

She: See!

Me: No, I don’t see!
She: Typical! Why can’t you use
your imagination a bit? Think of
what would happen if I started
using GPL software only at
home… Take your own example…
don’t you use the same software
at office as you do at home?

Me: Err… yeah, so?
She: Well, now imagine the
whole world doing that! We’d
have open source software being
used at home and at work—after
all, companies would love to save
money on software, wouldn’t
they?  

Me: OK! So a lot of people start
using open source software.
How’s that bad?
She: It is if you’re a “paid” soft-
ware developer!

Me: Ouch!
She: Aha, hallelujah, hallelujah!
Let there be light, God pro-
claimed, and took a coffee break
to rest her tired self.

Me:Her? Oh never mind! (*pout*)
She: Aww, the pwwoohh baby lost
an argument! 

Me: (muttered bad words)
She: OK! I’m going back to office.
Let’s do this again sometime!

Me: (mutter) Let’s not!
That was the last time I was

going to argue with a stock
market analyst!

As I dejectedly stomped my
way back to my office, the logic
she had used to reach her conclu-
sion started to sink in. It’s not like
I believe her and will now start
pirating software, but I do think
she has a point. I know that
despite losing the debate, soft-
ware piracy is still bad, and
against the law, but I cannot help
but wonder how beneficial it’s
been to big software development
companies. Sure the smaller guys
stand to lose everything because
of piracy, but then again, since
when have smaller companies not
risked everything?

Though I haven’t found the
answer—and I doubt anyone will
ever have concrete evidence to
ever prove it either way—I now
have a possible answer to the
question, “Is piracy good?” 

agent001@thinkdigit.com

I cannot help
but wonder
how beneficial
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to big software
development
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The latest rumour about China
is that China will...

a) create its own version of the
Internet, with its own TLDs 
b) remove all Internet infrastructure

altogether                 
c) give the death penalty for porn
access
d) punish online dating by public

flogging 

Nostalgia: Name two games
bundled with Windows 3.1.

a) Pole Position and Minesweeper
b) Jetpack and Solitaire
c) Wolfenstein 0.9 and Snake
d) Nibbles and Gorilla

What are the world’s second-
and third-largest software

companies respectively?
a) Oracle and Adobe
b) Microsoft and Adobe
c) Oracle and SAP AG  
d) SAP AG and Nullsoft

Windows Vista’s user interface
is all pretty and nice, and

offers good functionality as well.
What is it called?
a) Pyro b) Aero
c) Sky d) Aqua

RSA is a public key encryption
method. What does it stand

for?
a) Really simple algorithm
b) Rivest, Shamir, Adleman
c) Recursive Self-Analysis
d) Ronald, Smith, Archie

What’s the latest news about
Technorati, the blog search

engine?
a) It’s being taken over by Yahoo!

Search
b) It now tracks 30 million blogs
c) It’s slated to shut down because of

falling blog readership
d) It now tracks more than 1.5

billion blogs

What is the Google Zeitgeist?
a) A real-time listing of the

richest people in the world
b) the W32.Zeitgeist.worm created
by a former Google employee
c) A listing of the top searches over

periods of time
d) Nothing. This is an April Fool

question!
How long would it take a
quark-based computer to

multiply two 18-digit numbers?
a) As long as a "regular"
supercomputer would take...
b) Quark-based computers are too

slow to even complete the task
c) It would do it too fast
d) There’s no such thing as a quark-

based computer!

What percentage of Internet
traffic was P2P (estimated) in

2003?
a) Just about 10 per cent
b) Almost 50 per cent
c) Between 60 and 80 per cent
d) Almost all Internet traffic - 98.26
per cent - was P2P
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ACROSS
6. State of being connected to the internet(6)
8. ‘A’ in RAM(6)
9. _____Operating Company-demerged company of AT&T in
1983(4) 
10. Images or photos(8) 
11. Integrated Electronic Corporation(5) 
13. Act of creating, changing and formatting
documents(7) 
16. _____ratio shows the proportion of height and width of
an image(6) 
17. Move light beams over photos to load images in the
computer(5)
19. Hardware or_____(8) 
21. Personal Access Communications System(4) 
22._____Or stop unwanted e-mail (6)
23. Enter an e-mail account by entering User name,
password and click on_____(4,2)

DOWN
14. Very small Integrated circuit(8)
15. Virus or worm_____(7)
18. Optical device in cameras(4)
20. Short for Output feedback(3)
21. Paper sheet(4)
1. Dish_____receiving or transmitting transducers(8)
2._____tool-paint inside an enclosed figure(4)
3. Sequence of numbers and vertical lines identifying
an item(3,4)
4._____Coupler-hardware device enabling a modem to conect
a voice circuit(8)

5. Domain Software Engineering Environment(abbr)(4)
7. Electronic Bill Presentation and Payment(abbr)(4)
12. Negatively charged subatomic particle(8) 
14. Very small Integrated circuit(8)
15. Virus or worm_____(7)
18. Optical device in cameras(4)
20. Short for Output feedback(3)
21. Paper sheet(4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
tq@thinkdigit.com
Mark “TQ” in the
subject area.

All Part Of The Game
. When is Sony preparing to
launch Blu-ray, with a few

movie titles and the first BD player
from Samsung?

a) May 2006
b) December 2006
c) Sony has joined the HD-DVD camp!
d) Blu-ray has already launched!

1

March 2006  

Answers

Google, launched in
1998, was first

popular as a rival to
AltaVista for scientific and
other research papers and
resources.

Did You
Know?

Send in your answers to
the crossword with
complete contact details
to TQ@thinkdigit.com on
or before April 15. 
One lucky participant will win 

SCJP Sun Certified
Programmer for Java 5
by Kathy Sierra & Bert Bates
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Adleman

7.b) It now tracks 30 
million blogs

8.c) A listing of the 
top searches over 
periods of time

9.d) There's no such 
thing as a quark-
based computer! 

10.c) Between 60 and 
80 per cent

1.a) May 2006
2.a) Create its
own version of the 

Internet, with its
own top-level 
domains
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SAP AG

5.b) Aero
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H. P. Lovecraft’s Cthulhu has a cult following
among readers of horror fiction, and any game
that aims to recreate the chilling, macabre feel of

Lovecraft’s books could only fall flat on its face.
Or so we thought.
The atmosphere in Call of Cthulhu: Dark Corners of

The Earth (DCoTE) is—dare I say it?—perfect. It delivers a
potent dose of creepiness and horror that will leave you
gasping for breath at the end.

The game starts with police detective Jack Walters
(you) investigating a disturbance caused by a cult called
the Fellowship of Yith in a dilapidated old house in
Massachusetts. Unfortunately, the horrors he
experiences in the house that day land him right into
the Arkham Asylum, blabbering incoherently.

It is six years later now, and Jack Walters, a shadow
of his former self, cannot remember what happened to
him during his time in the asylum. As he tries to piece
together the last few years of his life, a mysterious
phone call finds him in the port of Innsmouth,

investigating the disappearance of a young store
manager. His simple investigation turns ugly as he finds
himself fighting for his life against dark forces beyond
his comprehension.

The game is loosely based on Lovecraft’s short story
The Shadow over Innsmouth, which tells of unnamed
horrors that befell the little port. Once you’ve been
introduced to its initial chapters, it’s an ordeal to wrench
yourself away from the game. Colours are dark and
subdued, and the cutscenes are presented in an old-film
grainy style, and fit in seamlessly with the game itself. 

DCoTE is a mix of adventure and first-person
shooter, though the bias is clearly on the adventure
side—gather clues, speak to people, and solve puzzles.
Thankfully, the puzzles involve some cranial activity
rather than just running around picking up stuff to fit
it here and there—the phrase “good old detective work”
comes to mind. Just when the adventure part starts to
get tedious and boring, you’re thrown into an
adrenaline-draining situation that will instantly

“The most merciful thing in the world, I think,
is the inability of the human mind to correlate all its contents.”

— H P Lovecraft, The Call of Cthulhu

THETERRIBLE

Imaging Shrikrishna Patkar



relocate your heart to the general vicinity of your throat.
Something that deserves mention here is the escape
sequences—scripted though they are, they’re still the
most heart-pounding parts of the game, where you run
like hell, bolting doors and using obstacles to delay
enemies by just those critical few seconds that stand
between you and your coffin. You don’t even have a gun
in the first chase—a chilling “ohmygodIamgonnadie”
feeling. The mix doesn’t work as well as an all-out FPS,
but it’s still one of the better approaches we’ve seen.

It isn’t as straightforward as it sounds, though. You
have to remember that even though Jack has been
released from the asylum, his mind isn’t made of steel,
and every disturbing scene he encounters will take a toll
on his sanity—his heartbeat quickens, his breathing
becomes heavier, his vision blurs—and as this worsens,
he will start to mutter to himself, see things, and finally
liberate himself with a shot from his pistol. To regain
sanity, you must find the (very, very few) savepoints,
which give him (and you) a few deserved moments of
sanctuary. The idea could have been disastrous, but
works in beautifully with the game’s extremely
immersive atmosphere.

FPS junkies will find the lack of a Heads-Up Display a
little disconcerting, but you’ll see that it’s all part of the
experience. There’s no accurate gauge of health on-
screen, but you can listen to your heartbeat and
breathing to decide whether you need to patch up with a
few bandages, or if you need a shot of morphine. Of
course, this assumes your heart isn’t thumping in real
life. The health system is much more advanced than your
average oh-now-I’m-hurt-but-everything-still-functions-
properly. If you get shot in the arm, you won’t be able to
aim your gun well, a wound to the leg and you’ll be
limping, and an unattended bleeding wound will
gradually drain you of life. 

I can’t say this enough—DCoTE is creepy. The story is
brilliant (The Shadow over Innsmouth and The Call of
Cthulhu can freely be read online, incidentally), the
atmosphere is eerie, and the gameplay is as realistic as it
can be—from the superb health system to the very life-like
reasoning it takes to get out of tight spots. 

And if you’re feeling particularly brave, take the game’s
challenge and play it with the lights off. 

nimish_chandiramani@thinkdigit.com
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Rating: 9/10
Minimum System Requirements: PIII 800, 32 MB Direct3D
compatible graphics card, 128 MB RAM
Developer: HeadFirst Productions
Publisher: Ubisoft
Distributor: E-Xpress Interactive
Contact: 022-22850245
Price: To Be Announced
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Crashday is a simple game.
There are cars, there are
guns, and there is some

wanton destruction—three gaming
ideas that have steadfastly braved
the test of time. Though, rarely
have all three been found in the
same game.

If you are confused about what
to do with these three, note this:
the cars are to be driven, the guns
(oh, and missiles as well) are
to be used to inflict said
wanton destruction on any
other unfortunate car that comes
your way. 

All Alone
In its single player mode,
Crashday offers you many game
options—you can run around an
open arena destroying other cars
(and getting destroyed yourself) in
a Wrecking Match, play a game of
“Pass the Bomb”—like passing the
parcel, only here the loser goes
boom in the end—or a game of
“Hold the Flag”, where you need to
capture the flag and keep it for as
long as you can. There’s also the
Speed-like Bomb Run, where you
get blown to bits for falling below
a speed limit, the Stunt Show
which gives you points for trying

some of the craziest driving
stunts (à la Carmageddon), and
some simple, straightforward
racing.

And then there’s the Career
mode, where you have to do all
the aforementioned to get ahead
in the Crashday circuit. More
than enough, you’d think, to keep
the solitary player happy...

...For About A Day
All the game modes are a lot of fun,
but they tend to get boring after
the first few times. The cars are
awfully tough to control, but the AI
bots don’t seem to have a problem

CRASHDAY
Finally, a fun multiplayer game that isn't an FPS...

Imaging Vikram Kathare, Chaitanya Surpur



with them, so while you’re floundering
about trying to discern your Londons from
your Tokyos, someone has already come
upon you from nowhere and turned you
into scrap metal, or stolen your flag, or
passed you the bomb—as the case may be.

The Career Mode is just a pathetic
excuse to get you to play all the game
modes—there’s even a voice narrative
before each mission to fool you into
believing there’s an actual story, but it
takes a lot more than that awful
German/American accented voice to
convince you.

However, the Mini Games, notably the
Long Jumps and Blast Jumps (jump the
farthest you can before your car blows up),
are tremendous fun, especially if you’re
competing with someone for the longest
distance record.

Party!
To turn around all the gripes with
Crashday’s single player mode, you’ll need
to switch to multiplayer. Human stupidity
is much more entertaining than artificial
intelligence—your opponents are faced
with the same difficulties as you are, so the
chances of your winning an event are more
realistic. The Wrecking Match is the most
fun here—especially for venting
frustrations, caused mainly due to losing
pathetically in Mini Games, on bald-headed
colleagues (see Digit Diary)—we were
playing it in the office till 1 AM two days
in a row!

You will now notice that all the game
modes that Crashday offers are geared
more towards insanely fun LAN parties and
online play than the single player. It
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Rating: 7/10
Minimum System Requirements: Pentium 4 1.5 GHz,
512 MB RAM, 64 MB Graphics Card
Publisher: Atari
Developer: Moon Byte Studios

supports up to eight players per event—
quite respectable, and more than you’ll
probably ever need for a good blow-up
session anyway.

Pretty
Moon Byte Studios’ attention to the
multiplayer mode is also apparent in the
graphics of the game—they’re quite
impressive, but still remain light enough
to run on most half-decent graphics cards.
The damage modelling is also quite well
done, making all the crashes, booms and
bangs very entertaining. 

Every time you use the nitro boost
when driving, the camera changes to wide-
angle mode, and comes back to normal
mode when you release it—giving the
experience a weird rubber-band feel.

Insecta
Fun though it is, Crashday is still quite
buggy—it would randomly crash on our
ATI cards, but seemed to be happier on
NVIDIAs. It’s also riddled with graphics
bugs: there were numerous instances
where the cars would go straight into the
ground—with two wheels below the
ground surface, I mean. It gets even more
bizarre in online play—I’ve even seen cars
moving around the map with only their
roofs showing over the ground.

Overall, unless you get addicted to
breaking Mini Game records like some of
us here have, you’re not going to get much
out of the game if you don’t intend to play
it online or over a LAN. But once you do
get into multiplayer, it’s hard to get out.

nimish_chandiramani@thinkdigit.com
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The next time your parents or friends tell you to stop
gaming and “get a life,” “take more interest in your
studies,” or “get off your butt and get a job,” show

them this game review! Trackmania Nations ESWC (TmN)
is a game that can earn you Rs 1.8 crore—provided you’re
the best player in the world!

Besides being the official game of the e-SWC (e-
Sports World Cup), and having the potential to make
you a crorepati, TmN is also one of the best free games
to have been released in a long, long time! Yes, you read
that right—it’s FREE!

Unlike other games in this genre (Arcade Racers), TmN
comes bundled in a tiny package—just 265 MB. And you
don’t even have to download it—just pop this month’s
Digit DVD into your drive and start your engines!

The game has some really amazing graphics,
especially when you consider how light the installer is.
It has both a single as well as a multi-player option, and

you can play it over a LAN, or on the Internet against
people anywhere in the world.

I played the game on my AMD Athlon 64 3200+,
MSI RS480 motherboard with an onboard ATI
Radeon Xpress 200 graphics chip and 1 GB of DDR
400 Transcend RAM. At the highest settings, it
murdered my graphics chip! People with an NVIDIA
6600 (or equivalent) and above will have no problems
running this game at the highest settings—like I said
earlier, it’s light!

World War III
With 60 countries participating in the e-SWC, and
millions of individuals vying for the $400,000 (Rs 1.8
crore) cash prize, I cannot find any other way to
describe the game’s popularity except to say that World
War III is here! Trackmania Nations is affectionately
called by gamers “The Crashday Killer” (see the Crashday

Trackmania Nations ESWC
Here’s a chance to win Rs 1.8 crore, and also do your country proud!

Rating: 8/10
Minimum System Requirements: 
Windows 98/ME/2000/XP, Pentium II
450Mhz, 64MB RAM, DX9 compatible 3D
video card with 16MB RAM
Publisher: Deep Silver
Developer: Nadeo
Price: FREE!



review in this issue), because no one has time to
play arcade racers “just for fun” when there’s
huge money at stake.

The game’s single player mode is just plain
crazy: it has 90 race tracks, and you can
choose to be one of 60 countries. I chose
India, of course, and thought I could help my
country move up in the rankings (it was 44th
when I last checked); I was wrong! Except for
the Beginner mode, which is embarrassingly
easy, the game is really hard to play. I found
myself having to take 20 turns or more, on
average, before I could complete the Advanced
or Expert tracks.

Online
Since the game is light, I expected the Internet
gaming experience to be a little better than
most other games; I was wrong—the Internet
experience is quite amazing! Fast local servers
also make sure that you don’t wait too long,
and lag is non-existent. The game is
tremendous fun over a LAN as well. Pity the
maps don’t have more descriptive names
though, because it’s really irritating to try and
find that map you like: “Was it G-1 or I-1?
Maybe it was H-7?”

Track Mania…
…is what the level and map developers were
thinking when they designed these levels—the
tracks have the most amazing hurdles, but this
also makes it a nightmare to play: loop-de-
loops, spins, jumps and crashes. What else
could you want?

Drive-Throughs
One thing that will seem weird is the whole
“you can drive through your opponents” thing.
Yes, race with people and you can’t fight with
them, Need For Speed style! It’s like racing
ghosts; you compete with the track, not with
your opponents!

Customising
For a full free game, the level of customisation is
OK - but it’s not even remotely as cool as the
Need For Speed series, and you can’t change your
cars or your engines—or anything except the
colour of your ride, actually. But like I said, since
it’s a free game and is light on resources, I’m
pretty happy.

Anyway, enough with this review; I’ll take
your leave by giving it an 8/10. Take a look at the
screenshots to better understand what the game
is like. Or better still, put down this magazine,
pop in the DVD, install it and see for yourself.
Remember, it is your duty as an Indian citizen to
try and get us a little higher in the country
rankings, so best of luck, and Jai Hind! 

robert_smith@thinkdigit.com
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Wired.com, March 14, 2006

Man vs. Machine in
Newsreader War

RYAN SINGEL FROM
Wired.com rants about how
machines could never
replace man. Reality or the
ravings of a luddite?

Man vs. machine stories are
an old standby in journalism.

Think back to John Henry
racing a steam drill and
forward to Garry Kasparov
trying to outmaneuver IBM’s
Deep Blue in 1997 to the Onion
tweaking the genre with its
accountant battles Excel story.

But the latest twist on the
meme takes it to the meta-
level by raising the question:

in the future, will you find your man vs. machine story relying
on a human-edited source or from an algorithm?

Standing up for the human intellect, upstart Digg is betting
that its formidable legion of users can find better and more
interesting news faster than any algorithm Google—or a
number of upstart companies—can code.

“I have to admit when we first started experimenting with
this a year ago, the verdict was out whether (human filtering) was
a benefit or a detriment,” CEO Jay Adelson said. “We found that it
works, that it works really, really well.... We think people do a
better job.” On the machine side, the purest algorithmic news
finder is Google News, which made waves in the media world
when it debuted. With Google News, it’s code, and not a team of
editors, that decides which stories make it onto the front page.

Today Google News will even tailor the front page to your
particular interests as determined by your news reading habits
and search history (so long as you are willing to log in to
Google with a user name).

Likewise, Tailrank, a San Francisco-based startup founded
by Kevin Burton, also relies heavily on smart code to find cool
stories—not just from news outlets, but also from tens of
thousands of blogs.

Burton started Tailrank as a way to handle the information
overload created by access to blogs and media outlets via RSS.

Now he uses Tailrank to read through his 2,000
subscriptions and filter up the most important entries, based
on a secret sauce that includes a method of tracking how often
stories or blog posts are linked to by others.

The site defaults to the top stories linked to around the web,
and lets you switch to a filtered view based on sites you have
listed as your favorites. You can set that list either by uploading
from a newsreader or using a feature released last week that
scans your browser for blogs you have recently visited.

On the humanity side of the man-machine wars, Digg uses
a simpler method to find cool stories: humans clicking mouse
buttons.

Digg users submit technology stories and then others can
vote those picks up, down or simply lame. It’s not personalized,
but Digg users are fast to find new stories.

So far Digg is limited to technology news, but according to CEO
Adelson, the company will be expanding to other “sections of the
newspaper soon”—and it just might take on Google News as well.

http://www.wired.com/news/technology/0,70382-0.html?tw=wn_index_27

CNET News.com, March 17, 2006

If you give a bot a basketball...
WHAT BETTER WAY to get kids interested in math and
science than robot sports? CNET’s Stephanie Olsen finds out. 

If you want a glimpse of the future of technology in the United
States, look no further than the Ice Weasels, Space Cookies and
Cheesy Poofs. 

No, these aren’t code names of secret projects at Google.
They’re the names of high school teams competing here this
weekend for top merit in the 15th annual robotics contest
sponsored by FIRST (For the Inspiration and Recognition of
Science and Technology), a nonprofit founded by Segway
inventor Dean Kamen. With about $10,000 worth of donated
hardware and software, high school students were given
roughly six weeks to assemble a functioning robot that can
move around a court and shoot Nerf basketballs for points,
which is this year’s chosen game.

“They give you a game that’s too hard, with a time line too
short and too much stuff, and the kids have to do what they
can with it,” said Jon Rockman, a physics teacher at the all-
girls high school Castilleja in Palo Alto, Calif. Rockman is also
team adviser to the green-clad Gatorbotics.

The kooky team names and oddly challenging game belie
the genuine techno wizardry and teamwork on display
Thursday at San Jose University’s event center.

The youngsters’ enthusiasm for their robots offers a ray of
hope for the future of science and math in the United States at
a time when many educators are concerned about test scores
and flailing interest among young people in the fields.

Still, it’s a truly
odd scene, much
like a cross between
a Nickelodeon fun
house and a
BattleBot show. The
field of play is
about the size of a
small soccer field,
but it’s hardly
intimidating,
cluttered with
candy-colored Nerf
balls. Instead of bot
fights, the robots
try to throw the

Nerfs through round holes in translucent walls at each end of
the field, and electronic scoreboards on the wall tick higher
when a ball makes it through.

A giant overhead video screen and clubby rave music in
the background add a teeny-bopper MTV concert feel. If
they’re not playing a practice round, high school students clad
in jeans and team T-shirts are either milling around
(sometimes in hand-holding pairs) or engrossed in welding,
drilling or just fiddling with their bots. 

The competition is a community effort. Part of the
challenge is for teens to find and work with mentors who are
experts in technology and science.

The Gatorbotics, for example, have been working with
Emily Moth, an engineer at Ideo in Palo Alto. Homestead High
School in Cupertino, Calif., worked with Ron Crane, one of the
founders of 3Com. Homestead’s team is sponsored by Apple
Computer co-founder Steve Wozniak, who is an alumnus of the
school. 

http://news.com.com/If+you+give+a+bot+a+basketball.../2100-

11394_36050969.html?tag=st_lh

MediaWise
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Video game therapy - a new
frontier
GAMERS REJOICE! THERE'S a new rationalization for your
habit—it’s therapeutic!

Doctors pronounced Ethan Myers brain dead after a car
accident dealt the 9-year-old a severe brain injury in 2002.
After he miraculously awoke from a nearly month-long coma,
doctors declared he would never again eat on his own, walk or
talk.Yet, thanks partly to a video game system, Myers has
caught up with his peers in school and even read a speech to a
large group of students. 

“I’m doing the exact same things as them. I’m getting
buddies and stuff,” said Myers, who had relearned to walk and
was reading at a second-grade level before his video game
therapy began in May 2004. 

“I couldn’t remember where I put stuff and now I can. I
remember school stuff and people’s names,” he said in a
telephone interview from his family’s home in Colorado. 

More fundamentally, Myers can now fully open his right
hand, which paralysis had curled closed. His brother and sister,
who were in the car with him during the accident and each
suffered mild brain injuries, have also shown improvement in
their memory and other functions. 

Ethan and his parents attribute his most recent progress to
neurofeedback
training on the
CyberLearning
Technology
system, which is
often used to
play car racing
video games. 

“In the last
year, we’ve seen
the Ethan we
knew before the
accident,” said
Howard Myers,
the teenager’s
father. 

Neurofeedback is a form of conditioning that rewards
people for producing specific brain waves, such as those that
appear when a person is relaxed or paying attention. 

While this form of treatment has been around for decades,
incorporating video games marks a new frontier that taps
young people’s fascination with animation and electronics to
sweeten often frightening, lengthy and tedious medical
treatments. 

Video games are being used, for instance, to help sick
children manage pain and anxiety during hospital stays. 

A young leukemia patient inspired “Ben’s Game,” which let
him fight the cancer cells invading his body. A private island
called Brigadoon in Linden Lab’s “Second Life” virtual world is
open only to people with Asperger’s syndrome and autism. 

West Virginia’s public schools are battling obesity by
making “Dance Dance Revolution”—a step-to-the-beat video
game—part of their curriculum, while Nintendo has made a
splash with its new “Brain Age” mind-exercising game

For the complete column, visit http://news.com.com/Video+game+therapy--

a+new+frontier/2100-1043_3-6051269.html?tag=nefd.top
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Vista Sucks, No It Doesn’t, Yes
It Does…
THE ONGOING BATTLE—Will Windows Vista really change
our lives? Will it turn our PCs into blubbering masses of
nothing? ExtremeTech’s Jason Cross muses again. 

Thanks in large part to the title, my article called Why Windows
Vista Won’t Suck got linked to all over the interweb. Of course, five
minutes has now passed and the whole world has moved on,
updating their blogs furiously with numerous posts about
Microsoft’s Origami project and more “news” about how the
PlayStation 3 won’t ship this Spring. Ah, the attention span of the
‘net. 

I wanted to spend a little time in my editorial column this week
addressing some of the comments and emails I received about the
feature. And boy, did I get an earful. 

Certainly, response was varied. In our own forum, responses
ranged from (and I’m paraphrasing here), “Hey, thanks for the great
article, I didn’t know Vista had such sweeping changes” to “You’re
just a Microsoft shill
and you love DRM
and you should die
painfully and
slowly.” To those
who found some
value in the feature,
I’m glad you liked it.
To those that didn’t,
I’m glad you read it
anyway, and I hope
you just keep an
open mind about all
software and hardware products-from Microsoft and any other
vendors. 

Am I a Microsoft shill? No, of course not. Boy, having Microsoft
Shill money would be sweet! I bet they pay shills a lot over in
Redmond. If I were a shill for Microsoft, paid or unpaid, I doubt I
would have had such negative things to say about their digital media
initiatives in my column about switching to iPod. That one generated
a very concerned phone call from the Windows Media Player team at
Microsoft, as a matter of fact. I told them, in effect, to “put up or
shut up.” I want to see how they’re going to compete with
iTunes/iPod. I gave Microsoft latest and greatest Laser Mouse 6000
a whopping score of 3, because hey, I think it sucks. We calls ‘em like
we sees ‘em over here at ExtremeTech, and we go out of our way not
to let ourselves be influenced by any corporation. 

All I ask is that you bear in mind what the article was all about. I
thought the title, description, and introduction made it pretty clear:
The feature was a description of the ways in which Vista will be
more than just another Windows ME. It was a “Here’s why this is a
major update” thing. It’s not a review, and is in no way meant to
catalog all the positive and negative aspects of the upcoming OS.
Frankly, it’s way too early for that. We’ll be sure to let you know
what faults we find in the OS when it’s complete enough. Just to be
fair, when Steven J. Vaughan-Nichols over at our sister site
DesktopLinux.com wrote a rebuttal called Why Windows Vista Will
Suck, we copied over his intro, pointed to the article on his site, and
put it up front and center on the ExtremeTech homepage.

There seems to be some really grave concerns and
misunderstandings about the DRM in Vista. Quite a few readers
seemed to think that Vista will ship with an amazing, unprecedented
amount of DRM, which will prohibit them from doing all the fun non-
DRM stuff they enjoy today. This just really isn’t true.

http://www.extremetech.com/article2/0,1697,1936059,00.asp
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In what turned out to be
an exercise in how to
insert foot in mouth, a

Swedish Mac fan set up a
Mac Mini as a Web server
and challenged the hackers
of the world to “try and gain
root control.” Less than six
hours later, the box was
compromised, and the site it
was serving defaced with
the message “This sucks.
Six hours later this poor
little Mac was owned and
this page got defaced.”

The hacker, who goes
by the nickname
“Gwerdna,” later told
ZDNet that he achieved
the hack in less than 30
minutes. He claims to
have first looked for some
obvious flaws, after
which he proceeded to
attack the box through
an undocumented
exploit that Apple has
no patch for yet!
Whether or not this is
just hot air we don’t really

know, but the fact is that
the Mac OS box was
compromised in a matter of
hours after the challenge
was thrown out.

Considering that Mac OS
has one of the smallest
subscriber bases around, not
too many hackers are

interested in even trying

out their skills on a Mac box.
This is what makes the news
of the hack even worse for
Apple! If hardly any hackers
are training to hack Macs,
and the Mac Mini was still
hacked so quickly, not much
can be said for security on
Apple’s OS. 

Many believe that even
a Windows box could
have held out longer!
So is the Mac going to
become the new
Windows? Well, not

unless it can match
Windows in terms of
sales as well, which is a
tall order.

Another thing we
were left wondering
about is that if the Mac
OS is based on the
FreeBSD OS, which is
considered one of the
most secure operating
systems around, what

exactly have Apple
changed, and more

importantly, why?

No Winner This Month! Of the many
entries that we received, only a few
followed the new rules—and there
was no winner among them, either!
We’ve seen you make great desktops,
so why not tell your fellow readers
about them?

XP On Mac Proved Possible
According to the “Windows XP on Mac” Web site—
www.winxponmac.com—a hacker called “narf”
successfully managed to load Windows XP on an
unmodified Intel-based Apple Mac. Apple engineers, as
recently as early March, had said this was impossible!

HACKED IN HALF AN HOUR

Macs Easier To Exploit?

My Desktop

The Simputer?

Whatever 
Happened To…

Five years ago, we all were
regaled by the wonderful

story of the Simple,
Inexpensive, Multilingual
People’s Computer—the
Simputer. Developed in India,
it was the sure recipe to bring
affordable computing to the
masses—yes, even the rural
masses. “Illiteracy is no longer
a barrier to handling a
computer,” the Simputer Trust
claimed, and the rest of us
went, “Ooooooh!”

Constructed like a PDA—
with a touchscreen and stylus
and everything—the Simputer
runs on Linux (of course—
affordable, you know), has an
Intel StrongARM 206 MHz
processor, 64 MB of RAM, 32
MB of Flash memory, and can
read smartcards. The simple
interface based on graphics
and audio was to make it
illiteracy-proof. All this at only
Rs 9,000 if bought in bulk.
And five years ago, this
seemed foolproof.

Though it’s been out of the
limelight, the Simputer still
exists and is used minimally.
All is not well, though. There’s
more to a great product than a
great concept, and thanks to
some less-than-optimal
marketing, the Simputer sold
only a little over 4,000 units
after its release. The sad story
is that with other forms of
portable computing getting
cheaper, the Simputer is
already fighting a losing
battle, though it might still
stand a chance in the villages. 

What happens now? Are
we witnessing the slow demise
of the Simputer, or is it lurking
in the background waiting to
take us by storm? 

A Paranoiac’s Pen Drive!
Kingston recently released a pen drive for the paranoid. The
Kingston Data Traveler Elite Privacy Edition thumb drive
has a capacity of 4 GB, 128-bit AES encryption, and the
ability to erase itself if the wrong password  is entered
more than 25 times! Data was probably never this secure!

Illustrations: Harsho Mohan Chattoraj

Send your desktop with description of how you made
it to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm with the subject 
‘‘MMyy  DDeesskkttoopp’’ and tell us your postal address, too.

We want to know exactly how the
desktop was created. As usual, no
theme packs, please! Using a shell
enhancement is all right, as long as
you’ve customised it yourself. 

Remember, if we can’t recreate
your desktop the way you describe it,
the entry will be rejected, so please
be clear! 
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HUMAN ROBOTS

The Jedi
Knights Of
Japan

Yes, perhaps that’s
what we should call
Japanese company

Nippon Telegraph and
Telephone (better
known as NTT), because
they’ve come up with a
way to make you do
things you don’t really
want to! Though not as
easily as the Jedi do in the
Star Wars saga (with a wave
of the hand), NTT has
made a headset that can
force a wearer to move
against his or her will!
The commands are passed
via a pair of remote-
controlled joysticks.

The device uses “galvanic
vestibular stimulation”
(GVS); it basically controls
the wearer’s balance via
their ears. The headset,

which looks like a pair of
large headphones, fit over
the subject’s ears, and
balance is controlled using
electrical impulses that are
passed to the nerves. 

Apart from forcing
people to
turn in

a specified direction when
walking, the device also
simulates the feeling of
turning, even if the subject is
motionless—sort of like
virtual reality. Thus, the
device can even trick the

wearer into feeling motion
that isn’t really happening.

Enough about the device
though: what we’re more
concerned about is why
someone would want to
create such a technology!

Though the researchers
claim they’ve developed the
device to “enhance” a
gamer’s experience, we’re
still at a loss for why a gamer
would need his or her mind
controlled. Sure you could
simulate more surreal
motion, but are we really
ready to allow games to
control any part of our
minds (or even ears)? 

Thankfully, the device is
still not something you can
just go out and buy! Because
it works by directly applying
currents to nerves in a
subject’s head, it’s
dangerous, and if wrongly
used, could cause burning of
the skin or nerve damage—
not something a lot of
people are willing to risk just
to have a more realistic
gaming experience. 

The technology could
advance, going beyond
having to attach a headset—
GVS opens up a whole range
of possibilities. It’s the
beginnings of mind control.
One shudders to think about
the possibilities were GVS
technology to become
mainstream: imagine police
using it to quickly disperse
crowds, or teens being forced
to return directly home from
school. Is this how we want
to end up? Controlled by the
people who can afford the
technology? Let’s hope there
are enough upholders of
human rights and ethics to
cry foul when attempts to
commercialise such
technology finally crop up.
Some technologies are better
left undiscovered!

It’s strange that we’ve heard
so little about Konrad Zuse, a
German engineer, who
probably invented the
computer. “Probably,”
because there are several

definitions of
“computer,”
and one of his
machines—the
Z3—has a
strong claim
to being the
first computer.
Formally, the

Z3 was the first (functional)
stored-program-controlled
computer. The Z3 was
preceded by the Z2 and the
Z1, which was a binary
electrically-driven mechanical
calculator. All three were
destroyed in WWII.

Zuse also founded, in
1946, the first-ever computer
startup company, the Zuse-
Ingenieurbüro Hopferau.
More firsts: he founded
another company, Zuse KG, in
1949, which created the Z4 in
1950. At the time, it was the
only working computer in
Europe excluding Britain,
and the first computer in the
world to have been sold! One
wonders how much more
Zuse might have achieved
had he been born in a
country such as Britain or
the US during the War,
instead of in Germany. Or if
there had been no War at all.

Zuse suggested, as a
scientific philosophy, that the
universe is running on a grid
of computers. After he
retired, he concentrated on
painting, a long-time hobby.
He died in 1995.

In the words of his son
Prof Horst Zuse, “Many
reference works state that the
first large-scale automatic
digital computer was the
Harvard Mark 1... However,
the Z3 pre-dated the Harvard
Mark I. Today, Konrad Zuse is
acclaimed... as being the
most admired and respected
computer pioneer.” Visit
www.epemag.com/zuse for a
biography of Zuse by his son.

People Who
Changed

Computing

Konrad Zuse

The Original Computor

Booting Up The
Net!

This month’s 
winner is 
Subhash
Bhojwani 
e-mail:
mirashub@gmail.com

He wins 
Visual Basic
Database
Programming

by Roger Jennings
Published by

WIN!
Send in your entry and you could win an exciting gift just by sharing
an amusing picture with a tech angle to it. The picture should have
been shot by you, and should not have been published anywhere
earlier. E-mail your picture with the subject ‘DigiPick’ and your
postal address oonn  oorr  bbeeffoorree  tthhee  1155tthh  ooff  tthhiiss  mmoonntthh  to
digipick@thinkdigit.com. One prize-winning picture will be
published each month.



WEIRD NEWS

Google’s
World
Domination
Plans!

More plans to
dominate the world:
if you thought the

earlier story about Japanese
company NTT making
devices to control human
movement was a step
forward towards world
dominance, think again! As
of now only two companies
show promise in the “taking-
over-the-world” category: the
current world rulers
Microsoft, and the younger
challengers called Sergey
Brin and Larry Page. Since
Microsoft’s dominance is old
and boring, let’s look at how
Google plans to overthrow
the Redmond-based giant…

The Register
(www.theregister.co.uk)
recently published an article
based on a photograph (see
image alongside) of plans on a
whiteboard in “Building 43”
which, as The Register claims,
is the “cyber-equivalent of
Area 51”! Though a little
jumbled and messy, the
poorly-constructed plans on
the whiteboard actually
seem to be a plan to establish

“orbital mind control,”
whatever that means.

The plan may be a little
too complex to explain here,
but we can still get a rough
idea of what Google has
supposedly planned:
1. Buy New Zealand
2. Set up shop in a volcano
3. Launch a spy satellite
4. Launch Orbital Mind 

Control
5. Create clean fuel
6. Make the Google 

Football Club
7. Develop Google OS
8. Provide the world with

100 per cent accurate
weather forecasts

9. Make robots that have AI
and can repair broken
computers
and finally,

10. (Our interpretation) Rule
the world!
Sounds simple enough!
Well, since we’re not

even sure that this has

actually come from Google,
there’s nothing much to say.
However, the one thing we
have to proclaim is that
whoever drew this brain map
may be a genius, and
perhaps evil as well, but if
Google’s stock market results
are anything to go by, it may
be a few decades before
Google even attempts a coup
on good ol’ Bill!

“IPODS CAUSE HEARING LOSS!”

Pump Down
The Volume

There’s news, then
there’s stupid news.
We’ve already learnt to

trust Americans grab by the
b***s any opportunity to sue,
and recently, Apple was sued
by a US man who says his
iPod can cause loss of
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Chip Fabbing
If you have a one-track mind
that thinks chips and wafers are
only about food, think again.
There’s a lot of jargon you’ve
probably heard every day that
applies to the manufacture of
chips (the silicon kind you put in
gadgets), too.

Fab: 1. v. To “fabricate”
chips once they’ve been
designed. E.g. “These designs
are ready to be fabbed.” (also
see foundry). 2. n. The
production system itself—
“Did you hear about AMD’s
new fab line in <insert city
name here>?”

Note: Should never be
interpreted as “fabulous.”

65nm n. : The latest chip
manufacturing process. The
name means that the
transistors on the chip are 65
nanometres (a billionth of a
metre) wide. For reference,
your hair is about 80,000
nanometres thick.

Nanoacre n. : An area
about 2 square millimetres on a
chip design—the smallest acre.
Really, though, a nanoacre can
cost as much as an acre of land
if you factor in all the expenses.

Foundry n. : The company
that does the fabbing. Few
chip design companies have
their own foundries—these
facilities eat up billions of
dollars just by existing.

Wafer n. : What results
when you cut up a silicon
crystal into thin slices. Chips
are built on wafers. Note:
These wafers are inedible, and
perhaps even toxic.

Doping v. : The process of
adding silicon to make it
conduct electrons better—in its
pure form, silicon is about as
useful as the sand it’s made
from. So if you hear someone
talking about “doping silicon,”
the connotation isn’t as
negative as it might seem. 

And now, the best way to
explain away a chip
malfunction:

Magic Smoke n. : A
supposedly magical blue
smoke that is present inside
all chips and keeps them from
going “poof!”. E.g. “It failed?
All right, WHO let out the
magic smoke?”

It’s been a while since a gaming addiction
has infested these halls—no, really—a true

gaming addiction with obstacles to
productivity and everything. The start of
the month saw Raaabo and Nimish
satisfying the urge to blow each other’s
cars up and compare Long Jump scores in
Crashday till the wee hours, with the
occasional guest appearance from SKOAR!
editor Badri. Raaabo still continues to
shatter world records in Long Jump 1
(477m, should you care to try breaking it). 

Editor Deepak spent a week at CeBIT,
Hannover, causing mixed emotions—
jealousy, of course, at the fact that the rest
of us didn’t get to go to Geek Heaven, but
there was also much joy and lawlessness
that prevailed in his absence.
Apparently CeBIT is too
much for one man
to take—the size of
the event boggled

his mind to the extent that he even forgot
his own BIOS password when he returned
(“Someone changed it!” he still insists). 

We promised a follow-up on this—
Raaabo and Nimish finally got the 5.4 GB
NASA image of the Earth to open in
Photoshop as a Photoshop RAW, but the
battle is only half-won. The image opens
fine in greyscale, but still stubbornly
refuses to show its true colours. Then one
day, Raaabo wondered why the image filled
up exactly all the free space that was left on
his hard drive when he extracted it: “What
if it didn’t extract properly? There could’ve
been an error, but maybe we didn’t notice
it.” Quick searches revealed the absence of
the original compressed download, halting

progress on this front for now. The
two are taking a breather from

this obsession, but
something tells us this

isn’t the end of this quest.

Give us this day our daily fix



DIGIT APRIL 2006

Escape

hearing. The lawsuit claims
iPods are “inherently
defective in design and are
not sufficiently adorned
with adequate warnings.”

Also in the news these
days are reports—yes, those
officious-looking, billion-
dollar-funded project
reports—that iPods can cause
hearing loss. Like we didn’t
know that. Like listening to
anything at high volumes
doesn’t cause hearing loss. 

This is just a repeat of
what happened a couple of
decades ago, when the
Walkman was blamed for
causing hearing loss. Why
does the iPod manage to hog
a goodish portion of the
news every month?

Apple was forced to
rework the iPod for France
after it was shown to exceed
the country’s decibel limit of
100. But then, if you really
want to damage your ears,
you could just pick up a pair
of lower-impedance
headphones. You can take a
horse to the water…

People in some countries
use iPods to drown out the
noise of subway trains: “The
sound in the trains is

already high, so people
pump up the volume levels
on their players, just adding
to the possible damage…”
Can’t Apple just advise
people to use noise-
cancelling phones? Or even
bring out an iPod with a pair
of those?

Now here’s the latest:
“More research is needed to
determine whether popular
portable music players like
Apple Computer Inc.’s iPod
increase the risk of hearing
loss, the National Institutes
of Health said.” Yes, fund
that research with a billion
more dollars! Why isn’t it
part of common sense that if
you use headphones for
extended periods at loud
volumes, your hearing is
going to suffer?

On a serious note,
though, ear-bud style
phones, like the ones used
with iPods, project sound
directly into the ear canal,
while earmuff-style ones
allow the sound to diffuse.
Apple should probably
consider switching to
earmuffs if they don’t want
these officious reports to
lead to a class-action suit! 

Somewhere, somehow, there’s got to be a connection between
cobras and stock options. “Cobra strike options trading

educational program,” the page is called, and the main text says: “we
have developed certain formulas... with this data we are able to
discern which stock options are most likely to meet our
requirements.” OK, so it’s something about investing. Then the pitch:
“we offer to you the opportunity to purchase our cobra strike

straddle options calculator including
instructions in e-book form.” Now, on
the left: “purchase of cobra strike”
“monthly exercise #1”

And on it goes. The links, though,
are on the Chinese-looking character
to the left of the text.

Oh, we forgot: near the top is the
following—“does this program work?? 

With a running average for 2002
of: over 80% winners   and  with a

45% profit in an average of 8 days. It certainly does!!!!!!!!”
“view 2002 statistics” “view 2003 statistics”
These two link to interesting JPEGs. The Chinese character

features on these pages as well—he’s a mascot of sorts. There’s some
good-versus-evil thing going on here, since the cobra is always
juxtaposed opposite him.

Clicking on any of the “exercises” brings you to a page where you
fork out $2,500. Disclaimers dominate these shell-out pages. We
clicked through to transfer our hard-earned money, but it was not to
be—”Parameter Error”! We saw “http://mlm-norway.com/modules/”
somewhere in the source—and you guessed it: mlm-norway looks like
a get-rich-quick site. Cobrastrike.com is ostensibly a failed offshoot—
the ringleaders seem to have abandoned work on the project when
they found the cobra-stock connection wasn’t apparent enough.

whatweretheythinking.com

Joe
http://snipurl.com/aprilblog1
(http://techdirt.com/articles/20060306/086230.shtml
#comments)

Don’t Be Hurt, Internet, Some People Just Don’t
Care About You
Believe it or not, some people just aren’t interested in
the Internet. In recent years, the growth rate for
Internet adoption has slowed dramatically, while those
saying the Internet doesn’t interest them outnumber
those who can’t afford to get online.  What matters is
whether individuals use their time productively and
pleasurably, not whether that time is spent online…

Ouriel
http://snipurl.com/aprilblog2
(http://ouriel.typepad.com/myblog/2006/03/google_ma
rs_thi.html)

Google mars: this is what happens when you
have too much money...
Google just released mars.google.com. When my
colleague told me so I thought it was a joke. But I
checked further and I indeed find it. Doing Google
earth was a smart idea. Copied by everyone since then.
But Mars? What the hell are they going to do there?
Locate the nearest pizzeria?

Come on guys. Make us a better down to earth
search engine and invest your money in something that
makes sense! 

Dustin
http://snipurl.com/aprilblog3
(http://origamiproject.com/blogs/team_blog/archive/2
006/03/09/19.aspx)

What’s the Hubbub?
O.K., if you are reading this blog chances are you’ve in
one way or another heard about the “Microsoft
mystery” project named Origami. You probably also
know by now that Origami was the Microsoft code name
for the Ultra-Mobile PC project. We liked the code name
so much we decided to use it for our community site,
origamiproject.com.  
So, what was that teaser all about?  Well, since I was a
primary driver of the buzz campaign, I thought I’d set
the record straight by using a timeline to illustrate how
events unfolded….

Jeff Jarvis
www.buzzmachine.com

Lesson No.1
Georgina Henry, an accomplished newspaper editor,
makes the switch to blogging, heading up The
Guardian’s week-old Comment is Free, and she takes
away the most important lesson: “the randomness, that
sense of never quite knowing who’s going to post when
and what, is both the joy of the new site and slightly
scary. It's the lack of control you feel you have at times -
and control, I realise, is the one of the hardest things
for editors to cede.”

Some people think
Google Mars isn’t
such a great idea.
Then, there are
people who think the
Internet too isn’t a
great idea... And no-
one’s sure if Origami
is a great idea, but
you can check out the
timeline of its
development. And
finally, is blogging a
good idea?

www.cobrastrike.com 

We’re not biting this one... 
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Calendar Please!
The March issue was superb! The article
on XML made all the difference. I know
you’re positioning yourself as a digital
lifestyle magazine, but a lot of us geeks
out there really love to roll up our
sleeves and get to work on something
other than PPTs, so more of the same
please. How about articles on things to
do to your mobile phone, are there
cheat codes for mobile games?

On the subject of suggestions, I’ve
got a peculiar request. It would be
great if you could include a monthly
fold-out calendar that one could put on
soft-boards on our desks, with stuff
that is bound to make people stop by to
start a conversation (the calendar is
just an excuse to have it on our
desktop, justification is needed due to
increasingly paranoid BPO security
policies). I’m sure you’ll be able to
come up with something; screenshots
and cheats from games, A-list of
shortcuts and tips for XP, Excel,
Winamp or even PowerPoint if you
must. Anything that will make people
curious and get them talking and make
them aware of technology, and a desire
to walk with those who hack, crack and
cheat at Minesweeper.

Raja
Dear Raja, 
It’s good to know that you found the XML
article interesting. I agree we took the
unusual decision of entering the developer’s
domain by including this article. Hitherto, we
have always been a technology and gizmo
kind of magazine, but sometimes we do drop
our guard and try and find something that
can be as enticing for even non-developers or
programmers, and get a bit geeky ourselves.
Our Tips & Tricks this month is partly devoted
to Mobile Devices, so your first wish has been
granted. As for your suggestion regarding a
calendar or a desktop to lure others at your
workplace to enter into a technology or a so-
called digital conversation, well, this can be
done. In fact, it’s a very good idea—let’s try
and figure out what’s best that Digit can give
with its CD/DVD, or even as a New Year
calendar for one’s home or workplace. Keep
writing in!

—Associate Editor

Tales Of An Overclocker
Would the world work faster if we
overclocked it? Can I overclock myself?
This was the question I had when I read
about it in your magazine five years
ago. I was in high school then, and the

“geek” word had just spread around
campus, with my name associated 
with it.

Here’s a true story that happened at
my school—Sudarshan Vidya Mandir—in
Bangalore: my friends and I decided to
overclock our library PC. We tried to
use the BIOS for tweaking, but the
speeds were locked. We had to play
with the DP switches on the board to
remove the lock. We increased the
multiplier by a factor of seven! In no
time the fan started to emit thick 
white smoke—the processor had burnt!
We made up a story to tell our teacher:
there was some kind of power surge.
And the PC was replaced with a 
brand-new Pentium 4. (Though finally
one day we confessed and the teacher
forgave us.)

Overclocking still turns me on, and
I hope millions of Indians out there
will be inspired to do so.

Ajaykumar K S

Dear Ajaykumar, 
We do a bit of tampering with our PCs now and
then, but overclocking is not something we
indulge in too often. Can’t be burning out so
many computers time and again, you see. But I
am glad that Digit got you hooked on to this
passion so early on in life. Not that we would
advise our readers to go ahead and overclock
their PCs beyond the limits, but yes, being a
geek sometimes involves such indulgence!

— Associate Editor

Digit Games Poster?
The Fast Track to Troubleshooting Your PC
was excellent! With the help of
that I’ve been
countering 99 per
cent of my problems.
I’d really like to thank
Digit for publishing
something so useful. I’d
like to give two
suggestions too:
‘ If possible, publish a
Fast Track to Graphics
Designing with tips and tricks.
‘ It would be really good if you included
one poster (or more!) of the games you
review in the magazine every month!
Eagerly looking forward to the 
next issue.

Eshwar

Dear Eshwar,
Glad to know that our March Fast Track will
prove to be a source of help for many of your

PC problems today and in future. Your
suggestion number one is already playing on
our minds—watch out for our future issues of
Fast Track, they will definitely enter the
graphics designer’s domain. As for your
second request, well, we can certainly either
publish the poster ourselves or source it from
the game developers; to circulate any poster
with games would require permission from the
game developer.

—Associate Editor

Audio-Video Formats
Hey Mr Editor,
I have been reading Digit since your
first issue. I owe a lot to both your
magazine as well as the Thinkdigit
forums—especially now that I’ve made
so many cool friends!! Why don’t you
guys publish an article running a
shootout for various video and audio
formats such as MP3, MP4, etc. It 
would be of great use and interest 
to many readers. 

Praveen

Dear Praveen,
Glad to know that our forums and magazines
have been a good resource to increase your
tech quotient. Shootout of audio-video formats
is indeed a valuable suggestion, although let
me tell you honestly it is purely subjective and
merits of each one can vary depending on one’s
own needs. Yet, still, let me try and figure out if
we can do this.

—Associate Editor

Give Me Something To Do!
Dear Editor,
I’m in the 9th standard, and have been
a patron of yours for the past four
years. You guys rock. By referring to
your issues, we’ve won loads of quizzes
and contests at school. However, we’re
on vacation now, and are getting really
bored… I suggest you publish some kind
of project that your numerous teen
readers could undertake. A couple of
years ago, a similar magasine had
published a step-by-step creation of a
little car that connected to the parallel
port and with some C++ programming,
could be controlled through the PC!
Using simple equipment that are easily
available, who wouldn’t want
something like that on his desk? Do
think of something on these lines,
which would help all your teen readers
indulge in some cool and creative
gizmo making....

Abhinav Nayar, Jamshedpur
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Dear Abhinav,
We’re aware that a large proportion of our
readership is in your age range. We are indeed
trying to include more DIY kind of stuff in our
magazine—keep reading Digit, you might soon
find something that gives your itchy hands 
a break!

— Associate Editor

Suggestions, suggestions
First of all, accept my sincere thanks for
your Fast Track on Troubleshooting. It
was really a boon for me. Now I solve any
problem regarding my PC myself. Your
article on Vista was also remarkable, but
the CD and DVD contents were not up to
mark. I have some suggestions:
‘ Please bring out a Fast Track on image
editing software such as Photoshop,
Corel Photopaint, etc.
‘ If possible, bring out the Fast Track in
colour even if you have to increase 
the price.
‘ Increase the number of software
reviews.

Akshit Gaur

Dear Akshit,
We’ve been receiving several requests for a
Fast Track on image editing software, and it’s
very likely that we’ll bring out one soon. We
also know we should get heavier on the
software reviews, and that will be
implemented soon as well. As for bringing out
Fast Track in colour, the fact is, the price will
indeed have to be increased - which not too
many readers will appreciate!

— Associate Editor

Bored Of Windows!
Dear Sir,
I think your magazine is the best
computer magazine around. I’d highly
recommend it to anyone, and I myself
buy ever issue—can’t wait till the next
issue is out! I have an Acer laptop
running Windows XP. I am thinking of
moving to an Apple iBook. Could you
do a full review on the transition
problems, pros and cons, and
compatibility issues?

I would love for your magazine to
start reviewing more alternative OS-
based computers. I think a lot of
readers would appreciate it. It will give
us a perspective on what’s out there,
other than MS Windows! I hope you
would take heed of an avid reader’s
request, and have a complete Mac
review in your next issue.

Gaurav Vadehra

Inbox

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, D-222/2, Om Sagar Building, MIDC, TTC Industrial
Estate, Nerul, 
Navi Mumbai 400 706

Digit will publish the best letters on these pages. Letters may be edited for clarity.
YYoouu  mmuusstt  iinncclluuddee  yyoouurr  ccoommpplleettee  aaddddrreessss  iinn  aallll  ccoommmmuunniiccaattiioonn..  

For subscription queries, call the help desk at 
022-27629191/9200, fax 022-27629224, or 
send an e-mail to help@jasubhai.com

Dear Gaurav,
The fact is that we did consider a Fast Track
on something Mac-related. We’ve also done
a couple of Mac-related features, such as
one 30 Days With. However, the fact also is
that few of our readers own Macs! Yes, a
Mac holds aspirational value, but when you
think of our mainstream readership,
everyone uses Windows. It’s sad but true.
Nevertheless, we have devoted an entire
Fast Track to Linux this month, so that
should give an alternative OS option to
people like you. 

— Associate Editor

Fast Track soft copy?
Dear Sir,
As a Digit subscriber, I receive a
booklet in addition to two CDs each
month with a copy of the magazine.
These booklets titled Fast Track contain
very valuable information. But of late,
due to poor eyesight I am finding it
increasingly difficult to read them. It
would be of much help if you could
make these available as e-books with
contents as either Word or HTML
documents. If need be, I am prepared
to make a nominal payment for this
facility being made available. Kindly
give this request careful thought.

H Subramanian

Dear Mr Subramanian,
We do give out the Fast Track in PDF format
once every few months on the CD or DVD.
The last time we did so was in January
2006—it was on the DVD; you probably
missed it. Do look out for the Fast Track PDF
on future Digit CDs or DVDs.

— Associate Editor

Money Saved…
The March 06 Fast Track to
Troubleshooting was a brilliant effort by
Team Digit. It covered almost all the
topics. The article on BIOS and sound
helped me a lot. I thank you for not
only solving my problem, but for
saving my money as well (which
vendors charge for doing no work!).

Atul Sharma, Ludhiana

Dear Atul,
We know that a lot of hardware vendors and
computer repair shops charge a lot for
problems that require just a bit of
knowledge and no hard work—and we’re
glad our Fast Track helped you! Thanks for
writing in!

— Associate Editor

A Laundry List
Hi Ed,
The A-List is a quick reference
for us. Please try and expand it—
for example, mid and low-range
graphics cards are not given, only the
high-range cards are mentioned. Also
try and devote pages in the A-List for
software; this is absolutely essential!
Two software each for paid as well as
free should be given which you think
are the best. It could be updated each
month too as you find good software.

The sections could include word
processing, spreadsheets, 3D
modelling, morphers, video editing,
audio editing, image editing, etc. 

Also include games in the A-List—
for example, different genres such as
RTS, Action, Adventure, Puzzle, FPS,
Racing, RPG, etc. It should contain the
names of two games that you think
are currently the best.

Also, how about including the best
Web sites, classified according to
genres—news, games, software, tech?

In the Digit Archive, I put in
“karaoke” in the “search by
description,” and the Feb 06 CD came
up with two software; both were
shareware, and in those versions, the
karaoke feature had been not
included. This means that in the
entire history of Digit, you haven't
included a single karaoke player! Do
something about this. I would like to
see a headphone shootout - wireless,
wired, over the head earphones,
behind the head, etc.

Please run articles on:
' Displays affecting the eyes, that

is, which is the most eye-friendly
display, and which display (LCD, TFT,
CRT, plasma) an eye-conscious person
should go for.

' Home Internet plans; which is the
best—cable, DSL, or wireless? 

Ken Thompson

Dear Ken,
We're planning on doing a feature on
broadband shortly—as well as a headphone
shootout, though that might be a few
months away.

Featuring games on the A-List wouldn't be
correct, since gaming experiences are
subjective. However, expanding the A-List in
general, and putting in more software, are good
ideas, and we might very well implement these.
Thanks for the suggestions.

— Associate Editor

Letter 

of the

Month



People And Events That Grabbed Headlines—For Better Or For Worse

Guillermo Fariñas
Hernández, a 41-year-old
Cuban psychologist,

wants to surf the Web without
restrictions or censors. That’s
easy for you and me, but the
government in Cuba controls
Internet access, and it is only
possible to visit local sites.
Hernández wants the
government to respect his right
to information, so he went on
his first hunger strike on 31
January. He gave it up on 9

February, but resumed it later
and has thus far done 20 of
these fasts.

Pictures of Hernandez on
the Internet show him in an
emaciated condition, and there
are even a couple of before-and-
after pictures. There are several
blogs that keep you updated on
what’s happening, and a few
that ask you to petition for him.
Spare a thought for someone
who can’t go Googling
whenever, wherever!
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We promise this
will be the
last piece in

this space about the
connection between
The Faithful and the
iPod. But here’s the
latest: Pope Benedict
XVI unwinds by
listening to music on
his iPod: he was gifted an iPod
Nano by staff at Vatican Radio.
Officials have, of course,
loaded it with religious music,
but there’s also pieces by
Beethoven, Mozart and
Chopin. Religious
compositions such as the
Missa Solemnis, we presume.

The Pope has been spotted
around the Vatican using his

iPod with its
distinctive white
earphones. A
spokesman for the
tabloid The Sun said:
“He is very pleased
with the iPod. The
Holy Father likes to
unwind listening to it
and is of the opinion

that this sort of technology is
the future.”

Here’s an open letter to
the Pope: Holy Father, we’d
like to remind you the
Walkman has been around for
decades—you could have
unwound just as easily using
one of those! Please do tell us
what this thing is about the
iPod and The Faithful!  

For any quiries regarding the Digit Patron programme, e-mail us at digitpatron@jasubhai.com

Liberty Or Death!

“Clear your throat, lose those
jitters, and get set to Skype
Penelope Cruz! For the first

time ever, you can bid to spend 10
minutes of Skype time with Penelope
Cruz. Get your questions ready, it is
certain to be a memorable experience.

“100% of the proceeds will benefit The
Art of Elysium, a Los Angeles-based
organization that encourages artists to
dedicate their time and talent to under-
served, at risk and hospitalised children...

“About Penelope Cruz: Penelope Cruz
has proven herself to be one of the most
versatile, young actresses by playing a
variety of compelling characters...”

That’s the gist of an eBay auction we
caught on 15th March. It ended that day,

but worry not—you probably will
still be able to Skype Ms Cruz (and
other celebrities), because we
found that a similar auction had
ended 3 March. Google “Skype
(celebrity name)”, and you just
might have luck on your side.

One small hitch, though:
you’ll never be able to find
whether it’s for real, because you
probably don’t have voice
recognition software
installed. But here’s an
idea— involve
your sister and
create your own
“Skype
Aishwarya” auction!

In the US, it’s your right to
face your accuser in court.
Of course, but things get all

topsy-turvy when that accuser
is a piece of code.

Proving that American
lawyers can uphold just about
any case, they are now getting
drunk drivers off charges by
demanding to see the source
code of the software used in
alcohol breath tests. And they
have a valid precedent: Timothy
Muldowny had been driving
drunk, and his
lawyers asked
to see the
source code
to the
Intoxilyzer

alcohol breath analysis
machine—which was the
police’s main evidence against
him. The company, of course,
did not want to hand over the
code—and Muldowny’s case was
chucked! Ever since then, DUI
suspects in various parts of the
US have had their cases thrown
out or reduced to lesser
offences.

Lawmakers are now
considering bringing in new
laws that will mean source code
will not have to be produced for

DUI defendants, but it’s
going to be an uphill

task—will open
source come to

the rescue?

Show Me The Source
The iPope!

Skyping Penelope Cruz
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